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THANK YOU FOR SELECTING 
A QUALITY PRODUCT BY 
LINCOLN ELEC  TRIC. 

PLEASE EXAMINE CARTON AND EQUIPMENT FOR
DAMAGE IMMEDIATELY

When this equipment is shipped, title passes to the purchaser
upon receipt by the carrier. Consequently, claims for material
damaged in shipment must be made by the purchaser against the
transportation company at the time the shipment is received.

SAFETY DEPENDS ON YOU

Lincoln arc welding and cutting equipment is designed and built
with safety in mind. However, your overall safety can be increased
by proper installation ... and thoughtful operation on your part. 
DO NOT INSTALL, OPERATE OR REPAIR THIS EQUIPMENT 
WITHOUT READING THIS MANUAL AND THE SAFETY
PRECAUTIONS CONTAINED THROUGHOUT. And, most importantly,
think before you act and be careful.

This statement appears where the information must be followed
exactly to avoid serious personal injury or loss of life.

This statement appears where the information must be followed
to avoid minor personal injury or damage to this equipment.

KEEP YOUR HEAD OUT OF THE FUMES.

DON’T get too close to the arc.
Use corrective lenses if necessary
to stay a reasonable distance
away from the arc.

READ and obey the Safety Data
Sheet (SDS) and the warning label
that appears on all containers of
welding materials.

USE ENOUGH VENTILATION or
exhaust at the arc, or both, to
keep the fumes and gases from 
your breathing zone and the general area.

IN A LARGE ROOM OR OUTDOORS, natural ventilation may be
adequate if you keep your head out of the fumes (See below).

USE NATURAL DRAFTS or fans to keep the fumes away 
from your face.

If you de velop unusual symptoms, see your supervisor. 
Perhaps the welding atmosphere and ventilation system 
should be checked.

WEAR CORRECT EYE, EAR & 
BODY PROTECTION

PROTECT your eyes and face with welding helmet
properly fitted and with proper grade of filter plate
(See ANSI Z49.1).

PROTECT your body from welding spatter and arc
flash with protective clothing including woolen
clothing, flame-proof apron and gloves, leather
leggings, and high boots.

PROTECT others from splatter, flash, and glare
with protective screens or barriers.

IN SOME AREAS, protection from noise may be appropriate.

BE SURE protective equipment is in good condition.

Also, wear safety glasses in work area
AT ALL TIMES.

SPECIAL SITUATIONS

DO NOT WELD OR CUT containers or materials which previously
had been in contact with hazardous substances unless they are
properly cleaned. This is extremely dangerous.

DO NOT WELD OR CUT painted or plated parts unless special
precautions with ventilation have been taken. They can release
highly toxic fumes or gases.

Additional precautionary measures

PROTECT compressed gas cylinders from excessive heat,
mechanical shocks, and arcs; fasten cylinders so they cannot fall.

BE SURE cylinders are never grounded or part of an 
electrical circuit.

REMOVE all potential fire hazards from welding area.

ALWAYS HAVE FIRE FIGHTING EQUIPMENT READY FOR
IMMEDIATE USE AND KNOW HOW TO USE IT.

WARNING

CAUTION
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SECTION A:
WARNINGS

  CALIFORNIA PROPOSITION 65 WARNINGS

WARNING: Breathing diesel engine exhaust
exposes you to chemicals known to the State
of California to cause cancer and birth defects,

or other reproductive harm.
• Always start and operate the engine in a

well-ventilated area.
• If in an exposed area, vent the exhaust to the outside.
• Do not modify or tamper with the exhaust system.
• Do not idle the engine except as necessary.
For more information go to 
www.P65 warnings.ca.gov/diesel

WARNING: This product, when used for welding or
cutting, produces fumes or gases which contain
chemicals known to the State of California to cause
birth defects and, in some cases, cancer. (California
Health & Safety Code § 25249.5 et seq.)

WARNING: Cancer and Reproductive Harm
www.P65warnings.ca.gov

ARC WELDING CAN BE HAZARDOUS. PROTECT
YOURSELF AND OTHERS FROM POSSIBLE SERIOUS
INJURY OR DEATH. KEEP CHILDREN AWAY. 
PACEMAKER WEARERS SHOULD CONSULT WITH
THEIR DOCTOR BEFORE OPERATING.

Read and understand the following safety highlights. For
additional safety information, it is strongly recommended 
that you purchase a copy of “Safety in Welding & Cutting - 
ANSI Standard Z49.1” from the American Welding Society, 
P.O. Box 351040, Miami, Florida 33135 or CSA Standard 
W117.2. A Free copy of “Arc Welding Safety” booklet E205 
is available from the Lincoln Electric Company, 22801
St. Clair Avenue, Cleveland, Ohio 44117-1199.

BE SURE THAT ALL INSTALLATION, OPERATION,
MAINTENANCE AND REPAIR PROCEDURES ARE
PERFORMED ONLY BY QUALIFIED INDIVIDUALS.

FOR ENGINE POWERED
EQUIPMENT.

1.a. Turn the engine off before troubleshooting
and maintenance work unless the
maintenance work requires it to be running.

1.b. Operate engines in open, well-ventilated areas or vent the engine
exhaust fumes outdoors.

arc or when the engine is running. Stop the
engine and allow it to cool before refueling to
prevent spilled fuel from vaporizing on contact

tank. If fuel is spilled, wipe it up and do not start engine until
fumes have been eliminated.

1.d. Keep all equipment safety guards, covers
and devices in position and in good repair.
Keep hands, hair, clothing and tools away 
from V-belts, gears, fans and all other 
moving parts when starting, operating or
repairing equipment.

1.e. In some cases it may be necessary to remove safety guards to
perform required maintenance. Remove guards only when
necessary and replace them when the maintenance requiring
their removal is complete. Always use the greatest care when
working near moving parts.

1.f. Do not put your hands near the engine fan. Do not attempt to
override the governor or idler by pushing on the throttle control
rods while the engine is running.

1.g. To prevent accidentally starting gasoline engines while turning
the engine or welding generator during maintenance work,
disconnect the spark plug wires, distributor cap or  magneto wire
as appropriate.

1.h. To avoid scalding, do not remove the radiator
pressure cap when the engine is hot.

ELECTRIC AND
MAGNETIC FIELDS MAY
BE DANGEROUS

causes localized Electric and Magnetic Fields (EMF). 

and welding machines

welders having a pacemaker should consult their physician
before welding.

which are now not known.

2.d. All welders should use the following procedures in order to

2.d.1. Route the electrode and work cables together - Secure
them with tape when possible.

2.d.2. Never coil the electrode lead around your body.

2.d.3. Do not place your body between the electrode and work
cables. If the electrode cable is on your right side, the
work cable should also be on your right side.

2.d.4. Connect the work cable to the workpiece as close as pos-
sible to the area being welded.

2.d.5. Do not work next to welding power source.

SAFETY
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1.c. Do not add the fuel near an open �ame welding

with hot engine parts and igniting. Do not spill fuel when �lling

2.a. Electric current �owing through any conductor

Welding current creates EMF �elds around welding cables

2.b. EMF �elds may interfere with some pacemakers, and

2.c. Exposure to EMF �elds in welding may have other health effects

minimize exposure to EMF �elds from the welding circuit:

1.i. Using a generator indoors CAN KILL YOU IN
MINUTES.

1.j. Generator exhaust contains carbon monoxide. This is a poison
you cannot see or smell.

1.k.  NEVER use inside a home or garage,
EVEN IF doors and windows are open.

1.l.   Only use OUTSIDE and far away from
windows, doors and vents.

1.m. Avoid other generator hazards. READ
MANUAL BEFORE USE.



ELECTRIC SHOCK 
CAN KILL.

3.a. The electrode and work (or ground) circuits are
electrically “hot” when the welder is on. Do
not touch these “hot” parts with your bare skin or wet clothing.
Wear dry, hole-free gloves to insulate hands.

3.b. Insulate yourself from work and ground using dry insulation.
Make certain the insulation is large enough to cover your full area
of physical contact with work and ground.

In addition to the normal safety precautions, if

welding must be performed under electrically

hazardous conditions (in damp locations or while

wearing wet clothing; on metal structures such as

floors, gratings or scaffolds; when in cramped

positions such as sitting, kneeling or lying, if there

is a high risk of unavoidable or accidental contact

with the workpiece or ground) use the following

equipment:

• Semiautomatic DC Constant Voltage (Wire) Welder.

• DC Manual (Stick) Welder.

• AC Welder with Reduced Voltage Control.

3.c. In semiautomatic or automatic wire welding, the electrode,
electrode reel, welding head, nozzle or semiautomatic welding
gun are also electrically “hot”.

3.d. Always be sure the work cable makes a good electrical
connection with the metal being welded. The connection should
be as close as possible to the area being welded.

3.e. Ground the work or metal to be welded to a good electrical (earth)
ground.

3.f. Maintain the electrode holder, work clamp, welding cable and
welding machine in good, safe operating condition. Replace
damaged insulation.

3.g. Never dip the electrode in water for cooling.

3.h. Never simultaneously touch electrically “hot” parts of electrode
holders connected to two welders because voltage between the
two can be the total of the open circuit voltage of both
welders.

3.i. When working above floor level, use a safety belt to protect
yourself from a fall should you get a shock.

3.j. Also see It   ems 6.c. and 8.

ARC RAYS CAN BURN.

4.a. Use a shield with the proper filter and cover plates to protect your
eyes from sparks and the rays of the arc when welding or
observing open arc welding. Headshield and filter lens should
conform to ANSI Z87. I standards. 

4.b. Use suitable clothing made from durable flame-resistant material
to protect your skin and that of your helpers from the arc rays.

4.c. Protect other nearby personnel with suitable, non-flammable
screening and/or warn them not to watch the arc nor expose
themselves to the arc rays or to hot spatter or metal.

FUMES AND GASES
CAN BE DANGEROUS.

5.a. Welding may produce fumes and gases
hazardous to health. Avoid breathing these
fumes and gases. When welding, keep your head out of the fume.
Use enough ventilation and/or exhaust at the arc to keep fumes
and gases away from the breathing zone. When welding

hardfacing (see instructions on container or SDS)

or on lead or cadmium plated steel and other

metals or coatings which produce highly toxic

fumes, keep exposure as low as possible and

within applicable OSHA PEL and ACGIH TLV limits

using local exhaust or mechanical ventilation

unless exposure assessments indicate otherwise.

In confined spaces or in some circumstances,

outdoors, a respirator may also be required.

Additional precautions are also required when

welding 

on galvanized steel.

5. b. The operation of welding fume control equipment is affected by
various factors including proper use and positioning of the
equipment, maintenance of the equipment and the specific
welding procedure and application involved.  Worker exposure
level should be checked upon installation and periodically
thereafter to be certain it is within applicable OSHA PEL and
ACGIH TLV limits.

5.c. Do not weld in locations near chlorinated hydrocarbon vapors
coming from degreasing, cleaning or spraying operations. The
heat and rays of the arc can react with solvent vapors to form
phosgene, a highly toxic gas, and other irritating products.

 5.d. Shielding gases used for arc welding can displace air and cause
injury or death. Always use enough ventilation, especially in
confined areas, to insure breathing air is safe.

5.e. Read and understand the manufacturer’s instructions for this
equipment and the consumables to be used, including the
Safety Data Sheet (SDS) and follow your employer’s safety
practices. SDS forms are available from your welding
distributor or from the manufacturer.

5.f. Also see item 1.b.

SAFETY
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WELDING AND CUTTING
SPARKS CAN CAUSE
FIRE OR EXPLOSION.

6.a. Remove fire hazards from the welding area. If
this is not possible, cover them to prevent the welding sparks
from starting a fire. Remember that welding sparks and hot
materials from welding can easily go through small cracks and
openings to adjacent areas. Avoid welding near hydraulic lines.
Have a fire extinguisher readily available.

6.b. Where compressed gases are to be used at the job site, special
precautions should be used to prevent hazardous situations.
Refer to “Safety in Welding and Cutting” (ANSI Standard Z49.1)
and the operating information for the equipment being used.  

  6.c. When not welding, make certain no part of the electrode circuit is
touching the work or ground. Accidental contact can cause
overheating and create a fire hazard.

6.d. Do not heat, cut or weld tanks, drums or containers until the
proper steps have been taken to insure that such procedures 
will not cause flammable or toxic vapors from substances inside.
They can cause an explosion even though they have been
“cleaned”. For information, purchase “Recommended Safe
Practices for the Preparation for Welding and Cutting of
Containers and Piping That Have Held Hazardous Substances”,
AWS F4.1 from the American Welding Society 
(see address above).

6.e. Vent hollow castings or containers before heating, cutting or
welding. They may explode.

6.f. Sparks and spatter are thrown from the welding arc. Wear oil free
protective garments such as leather gloves, heavy shirt, cuffless
trousers, high shoes and a cap over your hair. Wear ear plugs
when welding out of position or in confined places. Always wear
safety glasses with side shields when in a welding area.

6.g. Connect the work cable to the work as close to the welding area
as practical. Work cables connected to the building framework or
other locations away from the welding area increase the
possibility of the welding current passing through lifting chains,
crane cables or other alternate circuits. This can create fire
hazards or overheat lifting chains or cables until they fail.

6.h. Also see item 1.c.

6.I. Read and follow NFPA 51B “Standard for Fire Prevention During
Welding, Cutting and Other Hot Work”, available from NFPA, 1
Batterymarch Park, PO box 9101, Quincy, MA 022690-9101.

6.j. Do not use a welding power source for pipe thawing.

CYLINDER MAY EXPLODE IF
DAMAGED.

7.a. Use only compressed gas cylinders containing
the correct shielding gas for the process used
and properly operating regulators designed for
the gas and pressure used. All hoses, fittings,
etc. should be suitable for the application and
maintained in good condition.

7.b. Always keep cylinders in an upright position securely chained to
an undercarriage or fixed support.

7.c. Cylinders should be located:

• Away from areas where they may be struck or subjected
to physical damage.

• A safe distance from arc welding or cutting operations
and any other source of heat, sparks, or flame.

7.d. Never allow the electrode, electrode holder or any other
electrically “hot” parts to touch a cylinder.

7.e. Keep your head and face away from the cylinder valve outlet
when opening the cylinder valve.

7.f. Valve protection caps should always be in place and hand tight
except when the cylinder is in use or connected for use.

7.g. Read and follow the instructions on compressed gas cylinders,
associated equipment, and CGA publication P-l, “Precautions for
Safe Handling of Compressed Gases in Cylinders,” available from
the Compressed Gas Association,  14501 George Carter Way
Chantilly, VA 20151.

FOR ELECTRICALLY
POWERED EQUIPMENT.

8.a. Turn off input power using the disconnect
switch at the fuse box before working on 
the equipment.

8.b. Install equipment in accordance with the U.S. National Electrical
Code, all local codes and the manufacturer’s recommendations.

8.c. Ground the equipment in accordance with the U.S. National
Electrical Code and the manufacturer’s recommendations.

Refer to

http://www.lincolnelectric.com/safety

for additional safety information.
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Preface 

Typographical Conventions Used 
Before using this guide, it is important to understand the typographical conventions used to identify and 
describe information. 

Cross-References 

Cross-references to chapters, sections, page numbers, headings, etc. are shown in an italic typeface. 

e.g., Refer to Text You Type Using the Keyboard on page 1. 

Text You Type Using the Keyboard 

Text that you type using the keyboard is shown in a Courier typeface. 

e.g., Type John Smith in the Name field. 

Keys You Press and Buttons You Click 

Keys that you press on the keyboard and buttons/icons that you click with the mouse are shown in a 
bold sans-serif typeface. 

e.g., Press Enter. 

e.g., Click OK to continue. 

Menus You Select 

Menus and the selections you make from the menus are shown in a bold sans-serif typeface. 

e.g., Select Start > Control Panel from the main computer menu. 

e.g., Select Tools > Options from the menu. 

Dialog Box, Application Window Titles, and Field Names 

The titles of dialog boxes and application windows are shown in italics.  Field names and selections 
made from drop-down menus, etc. are also shown in italics. 

e.g., The Print Preview window opens. 

e.g., Select All Shifts from the drop-down list. 



Preface Notes, Warnings, and Tips 

2 Weld Sequencer User Manual IM8003 

Notes, Warnings, and Tips 
Notes, stops and tips appear throughout the manual.  They provide additional information that is important 
for you to know about the topic. 

STOP | You should definitely read the information in a stop table.  It 
could help you prevent a situation from which you cannot 
recover. 

 

NOTE | A note is an important piece of information. 

 

TIP | A tip table helps you with some interesting or useful 
information about using the program. 
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Revision History 

Date Change Description 

April 2022 

V1.16 

 Added compatibility with the Power Wave® 300C. 

 Updated the “Display HTML” function to be compatible with modern browsers. 

 When editing Weld Procedure Properties, and not connected to a Power 
Wave®, the Automatic checkboxes will be displayed. 

 Added Alert messages to the sequence report. 

 Added the ability to hide functions in the Review page. 

 Made changes to require an Administrator to perform database updates.  

 Added Summary and Function details to a Sequence Report saved in the 
database. 

 Added the ability to prevent Assembly Listing information being sent to 
CheckPoint™. 

 Fixed an issue where the Display Picture consumed increasing amounts of 
memory. 

 Fixed an issue where the trigger mode could change from 4-Step to 2-Step 
when changing to a Weld Function with a different Weld Procedure. 

  Fixed an issue where the Editor would allow a Weld Procedure to have both a 
Spot Timer and 4-Step trigger mode selected. 

 Fixed an issue where certain Weld Records from Generation 2 Power Wave® 
Welding Power Sources were not saved. 

February 2021 

V1.15 

 Made changes in the editor to improve the look and feel when adding elements 
to the sequence. 

 Improved the cut and paste functionality in the editor for individual and 
grouped items. 

 Added the ability to enable the supported User Limits in each Weld Procedure. 

 Added the ability for each user to personalize and override Weld Procedure 
parameters. 

 The four Database functions have new names. 

o “Work Item Create” is now “Create Record” 
o “Work Item Lookup” is now “Select Record” 
o “Work Item Field Create” is now “Save Field” 
o “Work Item Field Lookup” is now “Verify Field” 

 PLC Function Renamed: 

o “Vizient Positioner” is now “Power Lift HZA” 

 Added the ability to compare a Verify Field (Work Item Field Lookup) entry to a 
predefined string value. 

 Added the ability to compare a Verify Field (Work Item Field Lookup) entry to 
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Date Change Description 

the record’s User Name. 

 Added the capability for a Field Entry function to load a Work Item ID value.  

  Added the Weld Mode and Weld Identifier to the Sequence Reports.  

 Weld Records saved in the database will include the Power Source ID. 

 Weld Reports differentiate Manual Welds performed when the sequence is not 
running compared to when the sequence is running and control switches to 
Manual mode. 

 When Sequence Reports are enabled, the Deposition value will use the decimal 
point character required by Excel regardless of which language is selected the 
in Weld Sequencer Preferences. 

 When Excel Sequence Reports are enabled, clicking the Weld Record links will 
navigate to the correct Weld Number in the weld detail section.  

 When welding in Manual Mode for longer than the defined timeout period, the 
weld will continue until the operator releases the trigger, the Weld Sequencer 
will then exit Manual Mode. 

 When the Manual welding option is disabled, the sequence will not go into 
Manual Mode with four trigger-pulls. 

 Fixed an issue where Manual Mode could be enabled during an Approval 
function by logging out of then back in to the application. 

 Alert Table Deposition values will be metric values when the Weld Sequencer 
Preferences are Metric System Units. 

 Added a Continue feature in the Weld Open and Weld Accumulator functions. 
When the Arc Time, or Deposition, for the weld function is between the 
minimum and maximum limits, the operator can choose to make additional 
welds in this block or continue to the next block in the sequence. 

 The Weld Sequencer will display an error and the sequence will end if one of 
the Weld functions has an exit connector pointing back to itself.  

 In the Editor Create New Sequence wizard, the name of the sound file will be 
displayed after it has been selected using the Browse option. 

 When the sequence is paused for a Review action, the login button is disabled. 

 A Review function will include failed Display Picture blocks where they can be 
marked as passed.  

 Weld Sequencer menu shortcut keys are available for each language.  

 Fixed an issue where a double trigger-pull would advance the sequence to the 
next step when Navigation for the step is disabled.  

 Adjusted the timing of the reset communication when the Power Supply Auto 
Lockout feature is enabled to avoid unintended lockouts. 

 The process for accessing license and application files has been simplified.  

 Added a button to display the status of the installed license. 

 Added a checkbox in the Weld Procedure edit screen to indicate if the Weld 
Procedure is stored in the database or the sequence file.  

 Added a maximum value limit to the PLC Tag Read Timeout value.  
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 Modified the Weld Sequencer application to address a possible issue with 
exhausting Windows User Objects. 

September 2019 

V1.14 

 Translated the application and instruction manual (V1.13 manual, 02/19) into 
Spanish, Portuguese, German, French, Simplified Chinese, and Russian. 

 In the Weld Sequence Editor, the step size will automatically adjust to fit the 
size of the items being pasted. 

 When creating a sequence from a Microsoft Excel spreadsheet, added the 
capability to include an Approval block in each step of the predefined layout.  

 Double-clicking on a file with a .wsf extension will automatically open the 
Editor and load the file. 

 In the Weld Open function the default value for the Maximum Number of 
Welds is changed from 0 to 1. 

 Added the ability to enter Consumable Lot information for Power Supplies 
using Dual Head Wire Feeders. 

 Improved response time after a Power Supply failed to connect.  

 Changed the Cycle Timer to pause when the user is not logged in to the 
Sequencer. 

 Increased the communication timeout threshold between the Power Supply 
and the host computer. 

 The Power Supply Auto Lockout menu item will always be visible. 

 The Review Function column widths have been adjusted to allow longer 
description messages to be visible. 

 Made the font in the Alert Table adjustable by using the Function Information 
Font selector in the Preferences screen. 

 The Alert Table will display properly when a language other than English is 
selected. 

 Added a message when the user attempts to log in and the database is offline.   

 Changed the button focus and Enter key behavior to prevent the sequence 
from aborting when the Enter key is pressed during a step with Navigation 
Disabled and the Wait for Continue Action deselected. 

 Power Cycling will not allow a locked Power Source to be used for welding. 

 The PLC Connect menu selection will stay enabled after an unsuccessful 
connection attempt. 

 Changing the Weld Procedure during the sequence will prevent the Power 
Supply settings from reverting to a Factory Reset condition. 
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Chapter 1 
 

General Information 

Introduction 
Weld Sequencer is a technology from Lincoln Electric designed to control every aspect of the assembly 
sequence for complex, multi-step welded assembly work.  Weld Sequencer benefits include: 

 Increased productivity 

 No compromises on weld procedures 

 Detection of missed welds 

 Logging and validation of all steps 

 Real-time QA feedback 

 Quick operator training 

 Improved data integrity 

Using the Weld Sequencer software, work instructions become a controlled sequence of events, including 
the instructions, pictures, audio files, traceability and weld validations involved in completing the assembly.  
The flowchart-type editor allows Weld Engineers to design a weld sequence that controls every aspect of 
the welding operation including (but not limited to) enabling and disabling the power source; requiring user 
login; validating welds performed; and ensuring traceability data is entered as required.   Weld Operators 
have a simple, easy-to-use and intuitive interface on the production floor to run the weld sequence file. 

Typical Setup 
Weld Sequencer is a flexible tool that can meet the needs of many companies.  You can install the software 
based on your company’s needs.  If you plan to both create and run the weld sequence files on the same 
computer, you can install Weld Sequencer as a stand-alone system, where you do not involve a common 
network server. 

If your plan is to have two or more computers on the production floor running weld sequence files created 
by Weld Engineers on their office computers, the computers will need to share that data on a common 
network server and use the Enterprise Configuration for the Weld Sequencer. 

Single Computer Running the Weld Sequencer System 

With a stand-alone installation of the system, you typically have a computer station on the production floor 
near to the Welding Power Source that connects to it.  You install all of the software needed for the system 
on that one computer and run both Weld Sequence Editor and Weld Sequencer from this computer.  You 
will also have a single local instance of Microsoft SQL Server installed. 
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Figure 1.1 Single Computer 

Multiple Computers Running the Weld Sequencer System 

With an Enterprise Configuration of the Weld Sequencer system, you typically have a computer station on 
the production floor for each work cell running the weld sequence files.  You also have Weld Engineers with 
computers they will use to create weld sequence files.  Since all of these computers must share data to 
function effectively, you may also have a common network with a shared folder for data storage. 

You would also install Microsoft SQL Server on one of your networked servers.  You install the Weld 
Sequencer Toolkit on all of the computers and link them to the common SQL Server database. 
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Figure 1.2 Example of a Typical Setup 

System Hardware Requirements 
The computers running the Weld Sequencer system need to meet the following minimum computer 
hardware requirements: 

 Operating System:  Windows 7 or 10 

 Processor (minimum recommended):  Dual core, 2 GHz 

 RAM (minimum recommended):  2 GB 

 Disk Space (minimum):  4 GB 

 Ethernet Network Type:  IEEE 802.3 compliant 

 Network Architecture:  Common subnet for PC and power source 

Compatible Equipment 
You may use the Weld Sequencer system with some second-generation and most third-generation Lincoln 
Electric Power Wave® Welding Power Sources.  This list includes, but is not limited to: 

 Power Wave® 355M 

 Power Wave® 455M 

 Power Wave® 655R 

 Power Wave® i400 
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 Power Wave® C300 

 Power Wave® C300 CE 

 Power Wave® S350 

 Power Wave® S500 

 Power Wave® S700 

 Power Wave® 300C 

NOTE | Stick/TIG user interfaces are not supported. 

The following wire feeders are compatible with the Weld Sequencer system, with more to come in the 
future: 

 Power Feed® 10M Single/Dual/Bench/Boom 
with required Dual Procedure/Memory Panel (K2360-1) 

 Power Feed® 25M 

 Power Feed® 84 

Weld Sequencer supports the following Programmable Logic Controllers (PLCs), with more to come in the 
future: 

 Allen-Bradley Logix5000 Controller Family 
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Chapter 2 

Installing the Weld Sequencer Software 

The installation of the Weld Sequencer software depends on the way your company wants to use the 
system.  If you have a single computer that will both create and run weld sequence files, you only have a 
single installation to consider.  If you have multiple computers, you will need access to a central server for 
data storage and install software on all computers.  Please see page 1.1 for information on the typical setup 
of the Weld Sequencer system. 

In all cases, before you begin the installation process, be sure of the following: 

 All computers meet the requirements on page 1.3. 

 You have all installation files on hand or access to the Internet in order to download them. 

 You have read through these instructions in their entirety.  Be sure you fully understand how to 
install the software for your company’s setup. 

 You have administrative access to the computer(s) on which you will install the system. 

TIP | Be sure to allow yourself about 30 minutes to install the Weld 
Sequencer applications. 

Overview 
Since the installation varies depending on whether you want to use a single computer to run the Weld 
Sequencer system or you will have multiple computers running the software, the following is the order of 
installation for both scenarios. 

Stand-Alone Single-Computer Installation 

1. Install .NET Framework 4.7.2 (or higher) on computer (page 2.2).  Skip if already installed. 

2. Install Microsoft Webview2 on computer (page 2.3).  Skip if already installed. 

3. Install the Weld Sequencer Toolkit on computer (page 2.4). 

4. Install Microsoft SQL Server Express (page 2.6). 

5. Activate software on computer (page 2.7). 

6. Update the Welding Power Source firmware (page 2.9). 

Multiple Computer Installations with a Shared Server 

1. Install .NET Framework 4.7.2 (or higher) on each computer station (page 2.2).  Skip if already installed. 

2.  Install Microsoft Webview2 on computer (page 2.3).  Skip if already installed. 

3. Install the Weld Sequencer Toolkit on each computer station (page 2.4). 

4. Activate software on each computer station (page 2.7). 

5. Update the Welding Power Source firmware for each Welding Power Source (page 2.9). 

6. Configure Microsoft SQL Server and connect client computers to the databases (Appendix A).  If you 
are a new user to an existing Enterprise Configuration of the Weld Sequencer system, contact your 
local database administrator or IT department for assistance connecting to the database. 
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Uninstalling the Weld Sequencer database 

If you need to remove the Weld Sequencer database: 

Procedure Details 

1. Log in to the computer as a user with 
administrative privileges. 

Contact your IT department if you do not have 
administrator privileges. 

2. Run the WeldSequencer_SQLUninstall.bat file 
found in the C:\Program Files (x86)\Lincoln 
Electric\Weld Sequencer Tool Kit\Weld 
Sequencer Set-up Tools directory. 

The database files will be removed without user 
input.   

3. A SQL Server Instance Uninstaller window will 
pop up. Click the Remove button. 

 

4. On the dialog box, make sure the LEWS100 
instance is selected in the dropdown box then 
press Next. 

 

5. Select the Database Engine Services checkbox 
below LEWS100 and press Next. 

A summary box will display the items that are 
selected for removal. 

6. Review the summary of items to be removed 
and click the Remove button. The SQL instance 
removal process will begin. 

The removal process typically takes several 
minutes to complete. 

7. Click Finish when the uninstaller is complete.  

Installing Microsoft .NET Framework 4.7.2 
The Weld Sequencer system requires Microsoft .NET Framework 4.7.2 or higher on each of the computers 
running the application and automatically guides you to the website to download the installer.  To verify 
your version or to verify if you have .NET Framework installed, open your computer Control Panel and open 
Programs and Features.  Microsoft .NET Framework should appear in your list, along with the version. 

NOTE | If you already have .NET Framework 4.7.2 or higher installed 
on the computer, you can skip this step and continue with the 
Microsoft Edge Webview2 Runtime (page 2.3) 

 

NOTE | Please allow about 10 minutes for the .NET Framework 
installation (from download to installation), depending on 
your Internet speed. 

To install .NET Framework 4.7.2: 

Procedure Details 

1. Log in to the computer as a user with 
administrative privileges. 

Contact your IT department if you do not have 
administrator privileges. 
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Procedure Details 

2. Visit the Microsoft .NET Framework 4.7.2 web 
page:  
https://dotnet.microsoft.com/download/dotnet
-framework/thank-you/net472-offline-installer 

 

3. Click the Accept and Download button.  

4. Double-click the downloaded file.  

5. Click Run if prompted with a security warning. The End User License Agreement displays. 

6. Read & accept the license agreement and then 
click Install. 

 

7. Click Finish when the installation is complete.  

8. Repeat on each computer that will run the Weld 
Sequencer system. 

This includes all computers on the production 
floor that will run weld sequence files and any 
computers that will be used to create weld 
sequence files. 

  

Installing Microsoft Edge Webview2 Runtime 
The Weld Sequencer system requires Microsoft Edge Webview2 Runtime on each of the computers running 
the application and automatically guides you to the website to download the installer.  To verify your 
version or to verify if you have Webview2 installed, open your computer Control Panel and open Programs 
and Features.  Microsoft Edge Webview2 Runtime should appear in your list, along with the version. 

NOTE | If you already have the Microsoft Edge Webview2 Runtime 
installed on the computer, you can skip this step and continue 
with the Weld Sequencer Toolkit installation (page 2.4). 

 

NOTE | Please allow about 10 minutes for the Webview2 Runtime 
installation (from download to installation), depending on 
your Internet speed. 

To install Webview2 Runtime: 

Procedure Details 

1. Log in to the computer as a user with 
administrative privileges. 

Contact your IT department if you do not have 
administrator privileges. 

2. Visit the Microsoft Webview2 web page:  
https://developer.microsoft.com/en-
us/microsoft-edge/webview2/#download-
section 

 

https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net472-offline-installer
https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net472-offline-installer
https://developer.microsoft.com/en-us/microsoft-edge/webview2/%23download-section
https://developer.microsoft.com/en-us/microsoft-edge/webview2/%23download-section
https://developer.microsoft.com/en-us/microsoft-edge/webview2/%23download-section
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Procedure Details 

3. Click the x64 Download button.  

4. Read & accept the license agreement and then 
click Accept and Download 

The End User License Agreement displays. 

5. Click Run if prompted with a security warning.  

6. Read & accept the license agreement and then 
click Install. 

 

7. Click Close when the installation is complete.  

8. Repeat on each computer that will run the Weld 
Sequencer system. 

This includes all computers on the production 
floor that will run weld sequence files and any 
computers that will be used to create weld 
sequence files. 

Installing Weld Sequencer Toolkit 
On all computers that will use the Weld Sequencer system (including a single-computer installation), you 
need to make sure you have .NET Framework 4.7.2 (or higher) installed (page 2.2).  Once you have it 
installed, you can install the Weld Sequencer Toolkit. 

NOTE | You cannot install the Weld Sequencer Toolkit on a drive or in 
a directory that is compressed.  See page C.3 for 
troubleshooting details. 

Installing the Weld Sequencer Toolkit 

To install the Weld Sequencer Toolkit: 

Procedure Details 

1. Log in to the computer as a user with 
administrative privileges. 

Contact your IT department if you do not have 
administrator privileges. 

2. Download the Weld Sequencer Tool Kit.  

3. Double-click WeldSequencerToolKit.exe.  

4. On the Welcome screen, click Next. The License Agreement screen displays. 

5. Read & accept the license agreement and then 
click Next. 

The Choose Install Location screen displays. 

6. Leave the default in the Destination Folder field 
and click Install. 

The installation begins. 

NOTE |  If you do not have .NET Framework 4.7.2 
(or higher) installed, the installation launches the 
.NET web site automatically and cancels the install.  
Please see page 2.2 for more information. 
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Procedure Details 

7. Click Finish when the installation is complete.  

8. Restart your computer if prompted. You now need to install or configure Microsoft SQL 
Server (page 2.6). 

Folders Created During Installation 

The installation creates the Weld Sequencer Files directory on the root directory of the computer (typically 
the C:\ directory).  Within the Weld Sequencer Files directory are the following folders: 

 Database:  The Database folder stores the original Microsoft SQL Server database files installed 
with the stand-alone Weld Sequencer system database.  You should not store any other files in 
this folder. 

 Key:  Each computer running the Weld Sequencer must have a unique License Key File.  Once all 
components of the installation are complete, you need to activate the software on each 
computer using the License Key File provided to you by Lincoln Electric for that computer.  Save 
that file in this directory. 

 Logs:  Anytime either application encounters an error, the system creates a log file with 
programming details.  Lincoln Electric support may request this file when attempting  to 
troubleshoot an issue.  Weld Sequencer also saves Sequence Reports in this folder. 

TIP | Weld Sequencer retains log files for 90 days. 

 Sequences:  By default, the system saves any weld sequence files you created with the Weld 
Sequence Editor in this directory.  The Weld Sequencer also looks in this directory, by default, to 
find the weld sequence files available for it to launch and run. 
 
You can change the default location under the Preferences in either application (page 4.5 for the 
Weld Sequence Editor and page 7.7 for Weld Sequencer); however, you must remember that all 
files related to the weld sequence file are stored in the directory specified here (e.g., sequence 
file, audio files, image files).  If you change this directory without moving the related files, you 
will break links to those files in the weld sequence files, and the operator or Weld Engineer will 
have problems opening and/or running the file. 

NOTE | In an Enterprise Configuration where the computers creating 
the weld sequence files are different from the computers 
running the files, the weld sequence files should be moved to 
a central location on your company’s network when 
completed. 

 

NOTE | If the sequence file format was updated.  Older sequence files 
will automatically convert and re-save when they are opened 
for editing or running in the Weld Sequencer.  The original file 
will be renamed with a “.bak” extension. 
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 Settings:  The Weld Sequence Editor and the Weld Sequencer both create settings files for the 
workstation preferences established in that application.  The system saves those settings files in 
this directory. 

We recommend that you do not modify these folders or the files within them unless directed to do so by 
Lincoln Electric support. 

Installing Weld Sequencer Updates 

An updated version of the Weld Sequencer may have additional features that require an update to the 
database schema.  To update the database, a Weld Sequencer Administrator must log into the Weld 
Sequencer Editor and authorize the update. 

Previous Weld Sequencer versions will no longer function after the database schema is updated.   All 
computers running Weld Sequencer and connecting to the same database will need to install and use this 
new Weld Sequencer version.  Do not authorize the database update unless all computers running Weld 
Sequencer will be updated to this new version. 

TIP | The update screen has an option to automatically backup the 
database before the update is performed. 

Installing/Configuring Microsoft SQL Server 
The Weld Sequencer system requires Microsoft SQL Server in order to share data efficiently.  How you 
install Microsoft SQL Server depends whether you will be running multiple Weld Sequencer installations or 
if you have a limited number of (or just one) stand-alone systems. 

Enterprise Configuration 

If you will be using an Enterprise Configuration where a common SQL Server will be utilized for multiple 
installations, you’ll need to create a new SQL Server instance (or use an existing instance), add the Weld 
Sequencer databases to that instance, and connect the client computers. 

STOP | See Appendix A for detailed Enterprise Configuration 
instructions.  Do not attempt an Enterprise Configuration 
unless you are experienced with Microsoft SQL Server or you 
can contact your IT department for assistance. 

 

NOTE | If you are a new user to an existing Weld Sequencer system, 
your IT department may have already created a procedure 
and/or an installation package to help connect you to the 
system. 

Stand-Alone Installation 

In a situation where you want to run a limited number of (or just one) Weld Sequencer installation, the 
stand-alone installation is the best option.  For this installation method, Microsoft SQL Server Express needs 
to be downloaded from the internet using the following instructions.  If you have trouble locating the SQL 
Server Installer file online, your IT department may be able to help you. 
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NOTE | Microsoft SQL Server installation packages must be 
downloaded separately for new installations. 

To install Microsoft SQL Server on a stand-alone computer: 

Procedure Details 

1. Log in to the computer as a 
user with administrative 
privileges. 

Contact your IT department if you do not have administrator 
privileges. 

2. Download the latest 
Microsoft SQL Server Express 
installer (or other installation 
packages if required) from: 
https://www.microsoft.com/
en-us/sql-server/sql-server-
editions-express  

Downloading the file may take several minutes.  If your Internet 
browser asks for a location to save the downloaded file, make sure 
you save it in your Downloads folder.  The file must be in this location 
for the installation process to continue. 

3. Select All Programs > Lincoln 
Electric > Weld Sequencer 
Toolkit > Weld Sequencer 
Setup Tools > Weld 
Sequencer SQL Express 
Install from the Windows 
Start menu. 

NOTE | At times, the installation may pause for a few seconds.  
This is normal and expected. 

Once the installation is complete, a command window displays and 
informs you that the database was created successfully. 

4. Press any key on your 
keyboard to complete the 
installation. 

 

5. Restart your computer to 
finish the installation. 

The SQL Server installation is now complete; proceed to Activating 
the Software (page 2.7). 

Activating the Software 
Once all components of the installation are complete, you need to activate the software on each computer.  
Each computer running the software must have a unique License Key File for the appropriate software (i.e., 
Weld Sequence Editor and Weld Sequencer).  For example, if you have one (1) Weld Engineer creating weld 
sequence files from the desktop computer in his or her office and five (5) computers on your production 
floor running weld sequence files, you need six (6) License Key Files. 

After purchasing a license for the Weld Sequencer software an email is sent containing an Entitlement 
Certificate. Follow the link in the email to activate and manage the entitlement.  

When using a license that has an expiration date (typically 1 year after creation), the Weld Sequencer Editor 
and Weld Sequencer will provide reminders as you get closer to expiration.  Notices will be provided at 
various intervals starting when less than 90 days are remaining. 

NOTE | If the computer will only be running Weld Sequencer Editor, 
be sure to request an “Editor Only” license.  You will receive a 

https://www.microsoft.com/en-us/sql-server/sql-server-editions-express
https://www.microsoft.com/en-us/sql-server/sql-server-editions-express
https://www.microsoft.com/en-us/sql-server/sql-server-editions-express
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License Key File only coded for that application at no cost. 

 

NOTE | If you need to make a connection between a PLC and the Weld 
Sequencer and/or you need to run multiple instances, be sure 
to add this request to the Special Installation Notes section of 
the Request Form.  The key file contains important 
information that enables these features. 

To activate the software: 

Procedure Details 

Request License Key File 

1. Order the Weld Sequencer software 
licenses from Lincoln Electric. 

Available options: 

 90-Day Evaluation License:  If a trial license is needed, 
we can manually generate this for you.  Please reach 
out to your local Lincoln representative to request 
one.    

 Purchased License on PO#:  If a PO is received with a 
Weld Sequencer part number, an email will be sent to 
the contact on file with license activation 
instructions. 

1. Free Editor License:   If an editor only license is 
needed, we can manually generate this for you.  
Please reach out to your local Lincoln representative 
to request one. 

2. Follow the link in the Entitlement 
email message to activate the 
Software License. 

This email will be sent to the contact(s) address(es) provided 
in the order for the software license. 

3. Select the Software License and click 
the Activate button. 

 

4. Enter the Computer 
Name/Identification in the External 
ID box. 

This is a computer name, asset number, or other identifying 
information used to associate this license with a specific 
computer. 

5. Enter the License Serial Number. Launch the Weld Sequencer application on the appropriate 
computer.  Since a License Key File does not exist yet, the 
application displays a message, along with the License Serial 
Number of that computer. 
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Procedure Details 

6. Click the Activate button.  

7. The License File is sent to the Primary 
Contact as an attachment in an email 
message. 

 

Install the License Key File 

8. Once you receive the License File, 
extract the lservrc file from the zip 
file and copy this lservrc file to the 
following directory on that 
computer: 
C:\Weld Sequencer Files\Key 

STOP | Each License Key File is specific to each 
computer.  Be sure to copy the file to the correct computer.  

9. Verify the License Key File has now 
activated the Weld Sequencer 
application(s) on that computer. 

Select All Programs > Lincoln Electric > Weld Sequencer 
Toolkit > Weld Sequence Editor from the computer’s 
Windows menu. 

OR 

Select All Programs > Lincoln Electric > Weld Sequencer 
Toolkit > Weld Sequencer from the computer’s Windows 
menu. 

10. Press the  icon in the Weld 
Sequencer application(s) to see the 
activated license information for that 
computer. 

Information is shown for the license(s) enabled on that 
computer, this includes the dates when the license was 
enabled and when it will expire. 

Updating the Welding Power Source Firmware 
“Firmware” is the memory and programming code within the Welding Power Source that is the control 
program for the machine.  Making sure you have the latest firmware ensures that you have the latest 
features available for the power source, including the most recent version of the CheckPoint™ software.  

To install the latest firmware: 

Procedure Details 

1. Log in to the computer as a user 
with administrative privileges. 

Contact your IT department if you do not have administrator 
privileges. 

2. Open your browser and go to 
www.powerwavesoftware.com. 

The Login page displays. 

http://www.powerwavesoftware.com/
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Procedure Details 

3. Enter your user name and 
password in the Email and 
Password fields and click Sign In. 
 
OR 
 
Click the Register Today link to 
create an account. 

If you are creating a new account, follow the onscreen 
instructions and return to this step when finished. 

Once you log in, the system displays the Power Wave Resource 
Center. 

4. In the Quick Links section, click 
the Power Wave®, Power 
Feed®/MAXsa® Software link. 

The system displays a page containing the Download Power 
Wave® Bundle-FREE button. 

 

5. Click the Download Power Wave® 
Bundle-FREE button to run the 
update. 

NOTE | Depending on your Windows version, you may have 
to click Run or Allow to permit your system to launch the file. 

The system opens the Lincoln Electric System Update Utility 
window where you tell the utility how to find the Welding Power 
Source you want to update. 

6. Choose the Connect through 
Ethernet option and enter the IP 
address of the Welding Power 
Source you want to update. 

TIP | If there is an IP address already displayed, it is the IP 
address of the last Welding Power Source that was connected.  
Be sure you enter the correct address for the current Welding 
Power Source you want to update. 

You can enter the IP address for the Welding Power Source in 
one of two ways: 

 Type the specific IP address into the I know the IP 
address of the welder field. 

 Choosing the I do not know the IP address of the welder 
option.  The update utility scans your network and 
displays a list of Welding Power Source IP addresses on 
the same subnet. 

NOTE | If this Welding Power Source has older firmware, the 
IP address will not show up using this method. 

TIP | If you run into a problem, please refer to the 
Troubleshooting section (Appendix A). 

7. Click the Connect button once you 
have entered the IP address for 
the power source you are 
updating. 

The software scans the Welding Power Source to verify if the 
firmware currently on the machine is up to date. 
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Procedure Details 

 

8. If the firmware is not up to date, 
you must click Continue to update 
the Welding Power Source. 

The system proceeds with the update. 

If the firmware is already up to date, you will receive the 
message Update not required and you can click Exit to close the 
window. 

9. Exit the program once the 
firmware has finished updating. 

 

10. Repeat steps 4 through 9 for each 
power source you need to 
update. 

 

Connecting to the Welding Power Source 
The final step in configuring the Weld Sequencer system is setting the communication from Weld 
Sequencer applications to a specific Welding Power Source.  In each application, you need to log into the 
application in order to configure the connection to the Welding Power Source. 

The Weld Sequencer applications automatically attempt to connect to the last IP address they connected 
to.  This is also true if you have multiple instances of either application on one computer (page 2.14). 

NOTE | Only a user with the Administrator user role associated with 
their account can log in and change the connected Welding 
Power Source in either application.  See page 3.2 for details on 
user roles. 

 

NOTE | The Welding Power Source must have a static IP address to 
use the Weld Sequencer software. 

 

Figure 2.1 Connection Window 
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Connect to the Welding Power Source 

In order for Weld Engineers to load weld procedures in the Weld Sequence Editor and for Weld Operators 
to be able to load weld sequence files or use the Part Lookup table in Weld Sequencer, you need to connect 
the Weld Sequence Editor and the Weld Sequencer to a Welding Power Source.  

NOTE | You must be a user with the Administrator role associated 
with your account.  See page 3.2 for details on user roles. 

If you need to connect multiple Welding Power Sources to a single installation of Weld Sequencer out on 
the production floor (e.g., one computer kiosk controls two Welding Power Sources), you can create an 
application shortcut for each Welding Power Source and then connect each instance of the application to 
the appropriate Welding Power Source.  See page 2.14 for details on creating multiple instances of Weld 
Sequencer. 

To connect to the Welding Power Source for the first time or to change connection: 

Procedure Details 

1. Select All Programs > Lincoln Electric > 
Weld Sequencer Toolkit > Weld Sequence 
Editor from the computer’s Windows 
menu. 
 
OR 
 
Select All Programs > Lincoln Electric > 
Weld Sequencer Toolkit > Weld Sequencer 
from the computer’s Windows menu. 

 

2. Click the Login button in Weld Sequence 
Editor and enter your administrator 
credentials. 
 
OR 
 

Click the Login button  in Weld 
Sequencer and enter your administrator 
credentials. 

 

3. In Weld Sequence Editor, click the PS 
Connect button in the top toolbar. 
 
OR 
 
In Weld Sequencer, select File > Power 
Supply Connect from the main menu. 

The Create Connection window opens (Figure 2.1). 

4. Choose the Connect through Ethernet 
option. 

 

5. Choose I know the IP address of the welder An IP address is a numeric identifier for a device on a 
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Procedure Details 

(if you know the network address) and type 
the IP address in the text field. 
 
Or if you don’t know the IP address: 
 
Choose I do not know the IP address of the 
welder if you need to scan the network to 
find the welder’s address.  See page 2.13 
for more information on finding the IP 
address. 

network, similar to a phone number, and is composed 
of four numbers (each ranging from 0 to 255).  All 
devices that participate on the network must each 
have a unique IP address. 

For example, 10.23.10.90 is a valid IP address. 

NOTE | If there is an IP address already displayed in 
the text field, it is the IP address of the last Welding 
Power Source that was connected.  Be sure you enter 
the correct address Welding Power Source to which 
you want to connect. 

NOTE | The Welding Power Source must have a 
static IP address to use the Weld Sequencer software. 

6. Click the Connect button. The system attempts to connect to the Welding Power 
Source.  If the Weld Sequence Editor or Weld 
Sequencer cannot connect to the Welding Power 
Source, there may be a couple of solutions you can try.  
Please refer to Appendix A for more information. 

NOTE | The connection to the Welding Power 
Source will use UDP. 

7. Click the Logout button.  

Disconnecting from the Welding Power Source 

There may be times when you need to disconnect the Welding Power Source from the Weld Sequencer 
software.  You can do this easily from the main menu:  File > Power Source Disconnect. 

NOTE | You must be a user with the Administrator role associated 
with your account.  See page 3.2 for details on user roles. 

Weld Sequencer disconnects from the Welding Power Source and erases the power source’s IP address 
from the connection memory. 

Finding the IP Address of a Welder 

If you don’t know the IP address of a Welding Power Source or if you are having trouble connecting when 
you enter a specific IP address, you can have Weld Sequencer scan your network for welders.  When you 
choose the I do not know the IP address of the welder option on the Connect window, the system 
automatically begins scanning your network for power sources.  Once it completes the scan, Weld 
Sequencer displays the results in the list, along with the model name and machine name.  

Simply click on each Welding Power Source in the list until you see the green status light on the Welding 
Power Source you want start to blink rapidly.  Click Connect.  See Appendix A for common reasons you may 
experience problems connecting to the power source. 

NOTE | The Welding Power Source must be on the same subnet as the 
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Weld Sequencer computer in order to retrieve the IP address 
when using this option. 

Creating Multiple Instances of Weld Sequencer 

The standard installation process creates a single Weld Sequencer shortcut on the Desktop that uses the 
default instance settings.  If you have multiple Welding Power Sources that you need to connect to the 
same computer and that need to use the same Weld Sequencer software on the production floor, you need 
a Weld Sequencer desktop shortcut for each Welding Power Source.  

Each of the Weld Sequencer shortcuts will launch a different instance of the application, and each instance 
will remember the connection information for its connected Welding Power Source. 

To create and configure an additional Desktop shortcut for each Welding Power Source:  

Procedure Details 

1. Right-click the default Weld Sequencer 
shortcut and select Copy from the pop-up 
menu. 

 

2. Right-click on the Desktop of the computer 
and select Paste from the pop-up menu. 

 

3. Right-click the new shortcut and select 
Rename from the pop-up menu. 

 

4. Enter a unique name for this shortcut and 
click OK. 

For example, Weld Sequencer System 2. 

5. Right-click the new shortcut and select 
Properties from the pop-up menu. 

The Properties window opens. 

 

6. Click on the Target field and place your cursor 
at the end of the existing text in the field. 

 

7. Add the following text: 
-s system2 

or, 
-settings system2 

Be sure to add a space after the existing text and then 
begin typing. 
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Procedure Details 

 

TIP | Instead of system2, you can use any text 

you want (e.g., welder2).  Just be sure that the 
name does not include spaces or special characters. 

8. Click OK to save your changes.  

9. Repeat steps 1 through 8 for each additional 
Welding Power Source. 

STOP | Be sure to provide a unique name in step 7 
for each shortcut (e.g., system2, system3, 
system4). 

Once you have created the additional shortcuts, 
return to page 2.11for details on connecting the 
Welding Power Source. 
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Chapter 3 

Setting Up the System 

Before Weld Operators can begin using Weld Sequencer, you need to create user accounts and connect the 
Weld Sequencer to the Welding Power Source. 

User Accounts 
Once you have Weld Sequencer installed, you need to create user accounts for each Weld Operator, Weld 
Engineer and Quality Manager, as well as any other individual who needs to use the Weld Sequencer 
software. 

Overview 

You can access the user accounts under the User Maintenance button in the Weld Sequence Editor (see 
page 3.2 for more details).  When you create or edit a user account, there are several fields you have 
available.  Table 3.1 explains these fields in more detail. 

 

Figure 3.1 User Maintenance Properties Window 

Table 3.1 Fields on the User Maintenance Properties Window 

Field Description 

User Name Enter the text the person will use as a user name to log in to the Weld Sequence Editor or 
the Weld Sequencer. 

Digital ID The Digital ID allows the system to log users in through RFID or barcode scanners.  The 
information is sent electronically and logs the user in automatically.   This field must be 
blank or it must contain at least four characters to be considered a valid Digital ID. 

TIP | Every Digital ID across your system must be unique (i.e., no duplicates). 
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Field Description 

Password Enter the characters this user should use as a password to log in to the Weld Sequencer 
and/or into User Maintenance and Part Maintenance. 

Height Enter the height of the user.  This is used for automatic ergonomic positioning of a fixture 
when the Power Lift HZA function is used.  See page 6.55 for details. 

Roles Place a check mark next to the appropriate role for this user.  See page 3.2 for details. 

User Roles 

You define user permissions in Weld Sequencer by assigning a User Role (Figure 3.1 on page 3.1) to the user 
account.  These permissions allow (or don’t allow) users to access certain areas of the software.  Currently, 
the following actions are restricted by the user’s role: 

 Connecting Weld Sequence Editor and Weld Sequencer to a Welding Power Source or PLC. 

 Locking a Welding Power Source by enabling the Auto Lockout feature. 

 Creating and maintaining user accounts. 

 Creating and maintaining the Part Lookup table. 

NOTE | Weld Sequencer stores the user name as the Operator ID in 
the Welding Power Source. 

 

Table 3.2 Permissions Available with Each Role 

Permission Administrator Operator Inspector Engineer 

Connecting the Welding Power Source     

Enabling Power Source Auto Lockout      

Connecting  the PLC     

User Maintenance     

Part Lookup Table Maintenance     

Loading and Running Weld Sequences     

Database Schema Updates     

Creating User Accounts 

You must create a user account for any person who needs to log in to the Weld Sequencer.  This includes 
(but is not limited to) Weld Operators, Weld Engineers and Quality Managers.  You also need to create a 
user account for any person who needs to be able to add other user accounts to the system (e.g., a 
foreman who needs to add Weld Operators to the system). 

When Weld Sequencer was first installed, a default administrative account was created for you.  When you 
log in, use admin for the user name and password for the password. 
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STOP | After you log in for the first time, you should change this to a 
secure password.  Alternatively, you can create a new 
administrator account and delete the pre-installed one. 

 

Figure 3.2 Creating a User Account 

To create a new user account: 

Procedure Details 

1. Launch the Weld Sequence Editor.  

2. Click the Login button. The Weld Sequence Editor prompts you for a user name 
and password. 

3. Enter your user credentials and click OK. NOTE | You must be an Administrator user to access 
User Maintenance. 

4. Click User Maintenance in the top 
toolbar. 

The User Maintenance Properties window opens (Figure 
3.1 on page 3.1). 

5. Click the Create tab. See Figure 3.2. 

6. Enter the details of the user’s account. See Table 3.1 on page 3.1 for details on these fields. 

7. Place a check mark next to the 
appropriate role for this user. 

See Table 3.2 on page 3.2 for user privileges. 

8. Click the Create User button. The system adds the new user account to the Users tab. 

Editing and Deleting User Accounts 

Once you have user accounts created in the system, there may be times when you need to edit the details 
of those accounts or remove the account entirely.  Perhaps you need to change the password on an 
account for that user.  You can do so easily. 
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To update a user account simply highlight the account on the Users tab, make your changes and click the 
Update User button.  You can click the Delete User button to remove a user account from Weld Sequencer.  
See Figure 3.1 on page 3.1.  

NOTE | You cannot delete the “admin” user account. 

RFID and Barcode Scanners 
If your company uses RFID or barcode scanners to enter data into Weld Sequencer (e.g., logging in or 
entering part numbers), you need to make sure that you configure the scanner properly.  For use with Weld 
Sequencer, you only need to make sure you enable the Line Feed/Carriage Return setting for entering data.  

Enabling the Line Feed/Carriage Return setting means that when someone scans an RFID or barcode, the 
scanner also sends along data that acts like they pressed the Enter key on the keyboard or clicked OK in 
Weld Sequencer.  Refer to the manufacturer’s documentation for your scanner for instructions on 
configuring this setting. 

 



 

IM8003 Weld Sequencer User Manual 4.1 

Chapter 4 

Weld Sequence Editor 

Overview 
The Weld Sequence Editor is where the Weld Engineer creates the weld sequence file.  The weld sequence 
for the engineer is in the form of a flowchart.  The flowchart shows the building blocks and details of the 
welding operation.  Weld Sequence Editor is similar to many popular flowchart software packages, with 
drag-and-drop functions and connectors, and is flexible enough to meet the needs of most assembly 
operations. 

TIP | Contact Lincoln Electric Weld Sequencer support for any 
questions about using Weld Sequencer with your assemblies:  
softwaresupport@lincolnelectric.com. 

The Weld Sequencer Editor application stores each weld sequence that you create as a file on a computer.  
You can store unfinished files locally on the Weld Engineer’s computer; however, we recommend that you 
share the finished weld sequence file on a central server computer.  This allows the computers on the 
production floor to access any weld sequence files they need to load. 

TIP | Weld Sequencer automatically saves your open file every five 
minutes (with the file extension .wsfautosave). 

Weld sequence files are not interchangeable between a Power Wave® 300C and other supported Power 
Wave® models that use a Power Feed® 10M or Power Feed® 84 wire feeder.  You must create your weld 
sequence file specifically for the Power Wave® system you intent to use when running the sequence. 

In comparison to a system that uses a Power Feed® 10M or Power Feed® 84 wire feeder, a Power Wave® 
300C uses different formats for Weld Procedures and User Interface controls.  By connecting to a Power 
Wave® system before creating your weld sequence file, the Weld Sequence Editor will automatically detect 
the system type and display the correct data entry options for your targeted Power Wave®. 

mailto:softwaresupport@lincolnelectric.com
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Figure 4.1 Weld Sequence Editor 

Top Toolbar 
The top toolbar is divided into sections with related actions grouped together.   From here, you can create a 
new weld sequence file, open an existing one to edit, establish properties for the current weld sequence 
file, maintain user accounts and change your grid options. 

 

Figure 4.2 Top Toolbar 

File Actions 

From the Browse section of the top toolbar, you can perform a number of actions on the weld sequence 
file. 

Creating a New Weld Sequence File 

STOP | When creating a new Weld sequence file, the supported 
system type (Power Wave 300C or Power Feed 10M / 84) must 
be determined.  Connect to your intended Power Source 
system type, with the Weld sequence file open, to complete 
the configuration of the Weld Sequence file. 

To create a new weld sequence file, click the New button.  You can then pick from several templates 
that help create the new sequence file quickly.  The templates contain different functions for each 
Step and the ability to enter the number of Steps you want to create.  Some templates also collect 
additional information for default messages, sound files, or other properties which are copied into the 
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functions of all the Steps.  Each template provides a short description of the functions and connectors 
it will insert on each Step; refer to the section on Sequence Functions for the capabilities of each 
function. 

 

Figure 4.3 New Weld Sequence Templates 

Opening an Existing Weld Sequence File 

If you want to edit an existing weld sequence file, click the Open button. 

Saving a Weld Sequence File 

You can also save the file you currently have open with either the Save or Save As button.  The Save 
button saves the current file under the same name.  Clicking the Save As button allows you save a new 
copy of the file with a different name or in a new location. 

When you save a weld sequence file, the software performs a Weld Sequence Review (Figure 4.4).  
This Weld Sequence Review lists common problems that you should fix before attempting to run the 
sequence file (e.g., missing PLC Tags; empty descriptions or titles; missing connectors to and from 
functions; unused Weld Procedures or Weld Validations; or incomplete or incorrect validation rules).  

 

Figure 4.4 Automatic Weld Sequence Review 
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Weld Sequencer divides the issues into two categories:  Warnings  and Errors .  Before you run 
the sequence, be sure to correct any issues flagged as Errors or serious welding issues could occur.  

You can click OK to save the file despite issues being present, or you can click Cancel to go back and 
make the corrections before you save the file. 

Printing a Weld Sequence File 

If you would like to check your weld sequence so you can update the file or you want to create a hard 
copy of the steps in the sequence, you can click the Print button on the top toolbar to send the file to 
your printer. 

Close the Weld Sequence File 

If you would like to cancel your changes to the weld sequence file without saving, press the Close 
button. 

 

Edit 

While working with the functions in your sequence, you can use the Edit options in the top toolbar to cut or 
copy functions from one step and paste them into another step.  You can also delete functions if necessary.  

TIP | To Paste, click your cursor in the location where you want to 
paste the function(s) and press the Ctrl + V key combination 
on your keyboard.  This provides a precise location for the 
pasted functions and eliminates any guesswork that could 
produce an error. 

 

TIP | To select a group of functions, click and drag the cursor 
around the functions to create a selection area. 

Connections 

The Connections section of the top toolbar provides you with the ability to log in and connect to a Welding 
Power Source.  It also allows you to log in if you need to access the User Maintenance (see page 3.1) and 
Part Maintenance (see page 4.8).  For more details on connecting to a power source, please see page 2.11. 

Maintenance 

In order to activate the options in the Maintenance section, you need to log in as a user with the 
Administrator role associated with their user account.  Once you log in, you can add, edit or delete users 
under User Maintenance (page 3.1) and add, edit or delete entries from your Part Lookup table using Part 
Maintenance (page 4.8). 

Properties 

The Properties section of the top toolbar applies to the open weld sequence file.  These options allow you 
to establish various settings specifically for the weld sequence file you are editing. 
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 Global Properties (page 5.1):  Global Properties are settings you establish for the entire weld 
sequence and include options such as the type of wire feeder, quick trigger options and options 
for locking the User Interface. 

 Weld Procedures (page 5.8):  Weld Procedures is a library of weld procedures that you can call 
for the welding functions in this weld sequence.  This allows you to set the parameters for each 
type of weld. 

 Weld Validations (page 5.22):  Weld Validations in the top toolbar allows you to create a library 
of conditions for passing a weld that you can use within this sequence.  If the weld does not 
meet these conditions, the weld fails validation and you can tell Weld Sequencer what to do.  

Tools 

The Report Analysis Wizard allows you to load all Sequence Reports made using the open weld sequence 
file and add valuable data to the sequence.  Sequence Reports contain all raw data captured while welding 
with the weld sequence file and provides you with complete views of how a part was created.  See page 
5.28 for more details on the Report Analysis Wizard. 

Layout 

The grid in the Weld Sequence Editor helps you align your functions and groups of functions in an orderly 
manner.  The grid looks just like graph paper and can help you organize your weld sequence in a way that 
makes it easier for you to navigate and edit.  Simply click the Show Grid button in the top toolbar to display 
the alignment grid in the background.  Click the Snap to Grid button to force the functions you add or move 
to “snap” to the nearest gridline.  This helps you keep your functions aligned automatically.  

Settings – Preferences 

Weld Sequence Editor has a few workstation preferences you can set; Table 4.1 explains these fields in 
more detail.  The Weld Sequencer also has a separate set of workspace preferences you can set for the 
Weld Operators (page 7.7). 

 

Figure 4.5 Weld Sequence Editor Preferences 

Table 4.1 Preferences Available in Weld Sequence Editor 

Field Description 

Location of 
Configuration 
Files 

This field displays the directory where the Weld Sequence Editor can find the files 
necessary to run the application, from program files to the default location for saving 
weld sequence files. 
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Field Description 

Location of 
Sequence Files 

The Location of Sequence Files is where the Weld Sequence Editor stores all the weld 
sequence files you create, along with any accompanying files like images and sounds.  
By default, the location is the C:\Weld Sequencer Files\Sequences directory on this 
workstation.  You can use the Select button to change the location; however, 
remember that you could have image and/or sound files linked to various functions of 
the sequence.  If you move the weld sequence file without moving these external 
files, you will break the links and the weld sequence file will no longer function 
properly. 

TIP | A great practice to get into: store your weld sequence file and the 
image/sound files together in a specific folder for a given part.  If you move or copy 
the folder, the associated image/sound files will stay together and prevent broken 
links. 

Location of 
Sequence Report 
Files 

This location is where Weld Sequencer finds the Sequence Reports generated by 
Welding Power Source on the production floor that use the weld sequences.  This is 
especially helpful if all reports are saved to a common location (e.g., a network drive). 

Stand-Alone 
Installation 

This option allows you to choose a default Stand-Alone Installation where the 
required database is installed on the same computer.  Refer to Installing/Configuring 
Microsoft SQL Server on page 2.6 for more information on the installation options.  
Uncheck this option and enter the Database Connection string (below) if you are 
using the Enterprise Configuration. 

NOTE | You must log in as an administrator user in order to modify this setting. 

Database 
Connection 

This is the Database Connection string for Enterprise Configurations.  See Appendix A 
for detailed Enterprise Configuration instructions.  You must restart the Weld 
Sequence Editor to utilize changes to the connection string. 

NOTE | You must log in as an administrator user in order to modify this setting. 

System Units You can choose to display the units within the Weld Sequence Editor as Imperial or 
Metric units. 

Language Click on the dropdown arrow to select from the available languages.  You must restart 
the Weld Sequence Editor if a different language is selected. 

Zoom Options 

Depending on the complexity of your weld sequence, it could turn into a large workflow document where 
much of your weld sequence is hidden from your view.  The zoom bar allows you to navigate your 
document easily.  Use the Zoom Bar at the top of the window to zoom out to see your whole document, 
click on a function near where you want to be, and then slide the zoom bar back to 100% to begin editing in 
a normal zoom. 
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Work Area 
The main open area in the Weld Sequence Editor window (Figure 4.6) is where you build your weld 
sequence.  You can drag-and-drop functions into this Work Area, rearrange them, group them, add 
properties, and more.  You can use the scroll bar to navigate the weld sequence. 

 

Figure 4.6 Work Area 

Status Bar 
At the bottom of the window, Weld Sequence Editor displays several bits of information for you. 

 

Figure 4.7 Status Bar in Weld Sequence Editor 

 Welding Power Source Connection:  If you have connected to a Welding Power Source, the 
system displays the IP address of that power source on the left.  

 Database Connection:  Next to the Welding Power Source connection, the system displays the 
Weld Sequencer database that you are currently connected to.  This is especially helpful for an 
Enterprise Configuration. 

 PLC Connection (Weld Sequencer only):  Next to the Database Connection information, Weld 
Sequencer displays whether you are currently connected to a programmable logic controller 
(PLC) device. 

 Version Number:  At the far right is the software version number.  This is helpful if you need to 
provide the support team with your current version. 
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Sequence Functions 
On the left of the Weld Sequence Editor window, you have access to the tools you need to create your weld 
sequence—the Sequence Functions.  These functions are the building blocks of the welding operation.  You 
add functions to the weld sequence that controls every aspect of the Welding Power Source and the welds 
the operator creates.  These functions help you define a consistent and repeatable process for the Weld 
Operator.  Chapter 6 explains each of these functions in detail and how to use them in your sequence. 

 

Figure 4.8 Sequence Functions 

Part Lookup Table 
If you want to load weld sequence files based on part numbers, the Part Lookup table is a simple 
association between your part number and the weld sequence file that is used to weld it.  Weld Operators 
access this table from the Weld Sequencer under File > Part Lookup in the main menu (page 7.2).  When 
the Weld Operator enters the part number, Weld Sequencer loads the weld sequence file you associated 
with the part number and launches it. 

NOTE | If you want any Weld Sequencer on any computer to look up a 
part number and then launch the correct weld sequence file, 
you need to save the weld sequence files (and all supporting 
image or sound files) in a central network folder that all 
computers can access. 

 

TIP | There is a workstation preference that prompts for a part 
number as soon as the user logs in to the Weld Sequencer 
Engine.  See page 7.7 for more details. 
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Figure 4.9 Part Maintenance Properties 

To add to your Part Lookup table: 

Procedure Details 

1. Launch the Weld Sequence Editor.  

2. Click the Login button. The Weld Sequence Editor prompts you for a user name 
and password. 

3. Enter your user credentials and click 
Login. 

The username is shown above the Functions List. 

NOTE | You must log in as an administrator user in 
order to add, edit or delete part number entries. 

4. Click Part Maintenance in the top 
toolbar. 

The Part Maintenance Properties window opens (Figure 
4.9). 

5. Click the Create tab.  

6. Enter the part number in the Part 
Number field. 

Remember, this is the number that the Weld Operator will 
type when prompted in the Weld Sequencer. 

7. Click the Browse button next to the 
Sequence File field and select the file 
you want to associate with this part 
number entry. 

 

8. Click the Create Part button.  

Editing a Part Number Entry 

If you need to associate a part number with a different weld sequence file, you can highlight the part 
number, click the Browse button and associate a new file.  Click the Update Part button to save your 
change (Figure 4.9). 

Deleting a Part Number Entry 

If you need to remove a part number entry from the Part Lookup table, simply highlight the part and click 
the Delete Part button (Figure 4.9). 
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STOP | Once you click the Delete Part button, the entry is removed.  
If you delete the entry by mistake, you will need to add 
it again. 
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Chapter 5 

Sequence-Level Properties 

The overall properties of the weld sequence and the weld sequence file also allow you to ensure a 
consistent semi-automatic welding program. 

Global Properties 
The Global Properties are settings you establish for the entire weld sequence file.  These properties help 
you set up the Welding Power Source to meet the needs of the welds within the sequence.  When the Weld 
Operator launches the weld sequence file and begins the weld sequence, Weld Sequencer can prevent 
outside control of the Welding Power Source.  All control occurs from the weld sequence file.  See Table 5.1  
for details on each parameter on this window.  

The Global Properties screens display the parameters specific to the connected Power Wave® type. If the 
Power Wave® type is undetected, User Interface Controls and features that may not be supported are not 
shown. 

NOTE | Any settings under Global Properties will overwrite the 
current settings of the Welding Power Source. 

       

Figure 5.1 Global Properties for Weld Sequence and Power Feed 10M or Power Feed 84 
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Figure 5.2 Global Properties for Weld Sequence and Power Wave® 300C  

  

Figure 5.3 Global Properties for Weld Sequence and Undetected Power Wave® Type  

Table 5.1 Global Properties Available for a Weld Sequence File 

Field Description 

General Properties 

Description The Description field is the title of the entire weld sequence file.  This text appears in the 
list of files that the Weld Operator can load.  See page 7.1 for details on loading weld 
sequence files in the Weld Sequencer. 
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Field Description 

Part Name The text that you enter in the Part Name field is the text that displays in the Assembly 
Name column in CheckPoint™.  This helps you identify one part of the assembly from 
another one for reporting purposes.  All weld sequences that use this part name will be 
grouped together in CheckPoint™. 

Weld Sequencer also uses the Part Name when locating the appropriate Sequence 
Report files for analysis with the Report Analysis Wizard (page 5.28). 

NOTE | Typically, the Part Name is the same text you have for the part number; 
however, they are different fields and different data in the system. 

Expected 
Welds 

This field automatically calculates the total number of welds you expect the Weld 
Operator to have performed by the end of the weld sequence.  If this number of welds is 
not reached or is exceeded, Weld Sequencer identifies the sequence as containing 
errors. 

NOTE | When the sequence contains Weld Open or Weld Accumulator functions, the 
Expected Welds field displays the number in the Minimum Number of Welds field of 
the function. 

Wire Feeder 
Type 

If you have a weld sequence that requires a Dual Head wire feeder, select Dual Head 
Feeder from the Wire Feeder Type drop-down.  This adds an additional set of procedure 
options to the Weld functions so you can specify which torch you want to use for the 
weld.  See page 5.8 for details on establishing weld procedures per feed head and page 
6.33 for selecting procedures for the feed head per weld.  This also adds a second Wire 
Package configuration for properly tracking the wire used on each feed head.  

Quick Trigger 
Enabled 

Place a check mark in the Quick Trigger Enabled checkbox to allow the Weld Operator to 
navigate the weld sequence (i.e., Previous, Next and Enter) using the trigger on the 
welding torch instead of the keyboard. 

 Two quick trigger pulls simulate pressing the Enter key, as well as clicking the 

Next button .  Two quick trigger pulls also simulate clicking the Continue 

button in the case of the Review function or activating the Start button when 
waiting to start a sequence.  If you activate the Continue button for a Display 
Picture, Display HTML or Display Video function, two quick trigger pulls also 
simulate clicking this Continue button. 

 Three quick trigger pulls simulate clicking the Previous button . 

 Four quick trigger pulls simulate clicking the Manual  and Automatic 

 toggle button. 

Sequence 
Report 
Enabled 

The Weld Sequencer can automatically export a file listing the details of the finished weld 
sequence and all of the welds created each time a Weld Operator completes it, including 
welds made in Manual mode.  Weld records contain information such as weld duration, 
start delay, wire density, deposition and WeldScore®. 

Simply place a check mark in the Sequence Report Enabled checkbox and select the 
format from drop-down: 
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Field Description 

 Tab-Delimited File:  Weld Sequencer creates a simple text file that separates 
each piece of data for the weld record with a tab character.  

 Microsoft Excel:  Weld Sequencer creates a Microsoft® Excel spreadsheet file 
that contains a row for each weld record and column for each piece of weld 
record data. 

Weld Sequencer stores this file under C:\Weld Sequencer Files\Logs\ SequenceReports.  
The software also automatically creates XML files for each Sequence Report that you can 
find under C:\Weld Sequencer Files\Logs\SequenceReports\XML.  You will need these 
XML files to use the Report Analysis tool. 

NOTE | You need to generate Sequence Reports if you want to use the Report 
Analysis tool.  See page 5.28 for details on the Report Analysis tool. 

Navigation 
Enabled 

The Weld Sequencer has Previous  and Next buttons  that allow the Weld 
Operator to navigate through the weld sequence, even if the sequence step is not 
complete.  The Navigation Enabled checkbox allows you to control whether or not the 
operator is allowed to navigate the sequence with these buttons. 

To prevent the user from advancing or going back before the end of the sequence step, 
remove the check mark from this checkbox. 

NOTE | This option also includes the File > Goto Step feature in the menu of Weld 
Sequencer. 

NOTE | You can disable Navigation on specific Steps.  In the Editor, double-click on 
the left side Step name label to configure this feature.  When disabled, the Weld 
Sequencer will not allow the user to Navigate away from the Step.  This is very useful 
for Steps that contain PLC Functions, and Navigation needs to be disabled, but 
Navigation is desired for the remainder of the sequence.  The background of the left 
side Step name will change to grey when this option is used. 

Require 
Approval for 
Goto Step 

Place a check mark in this option to specify that a user associated with the selected user 
role must log in to allow the Weld Operator to use the File > Goto Step feature during an 
active sequence. 

Manual 
Enabled 

If you want to prevent the Weld Operator from going into Manual mode during the weld 
sequence, simply remove the check mark from the Manual Enabled checkbox.  When a 

Weld Operator runs the sequence, they will not be able to use the Manual button  
in the Weld Sequencer.  They will be restricted to the functions in the sequence. 

Require 
Approval for 
Manual 

Place a check mark in this option to specify that a user associated with the selected user 
role must log in to allow the Weld Operator to use Manual mode during an active 
sequence. 

When the Weld Operator (or other user) clicks the Manual button  in the Weld 

Sequencer, Weld Sequencer requires someone with the specified user role to log in to 
release the Welding Power Source into manual mode. 
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Field Description 

Manual Mode 
Timeout 

Use this option to set a timeout value for Manual Mode.  Setting this timeout value (in 

seconds) will limit use of Manual Mode to this period of time when the sequence is 
running.  After the timeout expires, the Weld Sequencer will return to Automatic Mode.  
A timeout value of zero will disable this feature.  This Global Property allows 
customization of the timeout within every sequence file. 

Weld Record 
Logging 
Enabled 

Place a check mark in this option to activate Weld Record Logging in a weld sequence 
file.  For every weld completed by the Welding Power Source, Weld Sequencer creates a 
new database entry.  This is not a replacement for Production Monitoring or 
CheckPoint™ data.  Weld Sequencer saves the same Weld Record information in the 
Weld Sequencer database.  See page 5.8 for more details about Weld Record Logging. 

STOP | Using this option increases the size of the database.  Each weld record is 
approximately 1600 bytes. 

NOTE | Weld Record Logging is most useful for those advanced users who need to 
use raw data and have some SQL Server experience. 

Require 
Approval for 
Abort 

Place a check mark in this option to specify the user role allowed to abort a sequence or 
close the Weld Sequence while a sequence is active. 

When the Weld Sequence encounters an abort situation or the Weld Operator (or other 
user) attempts to close the weld sequence before it is complete, Weld Sequencer 
requires someone with the specified user role to log in to approve the action.  

3rd Generation Power Wave® Power Source Options 

Workpoint in 
Amps 

Place a check mark in this option to base the output level on Amps instead of wire feed 
speed for this weld sequence.  If you are connected to a welding power source and this 
property differs from the power source’s configuration, Weld Sequence Editor displays a 
message. 

Trim in Volts Place a check mark in this option to set the output level based on voltage instead of a 
unitless control (trim) for this weld sequence.  If you are connected to a welding power 
source and this property differs from the power source’s configuration, Weld Sequence 
Editor displays a message. 

This feature is only available on a Power Wave® with a Power Feed 10M or Power Feed 
84. The Trim in Volts option is not available when connected to a Power Wave® 300C or 
when the Power Wave® type is undetected. 

Wire Package 

Wire Diameter 
and Metal 
Density 

In the Wire Diameter field, enter the diameter of wire used for the welds in this weld 
sequence.  From the Metal Density drop-down, select the density of the metal from 
which the wire is composed.  If none of the available options apply to the wire loaded 
into the wire feeder, select User Defined Density from the drop-down and enter the 
density value in the text field that appears.  If a Dual Head Feeder is used, configuration 
options for each feed head will be shown. 

When the Weld Operator loads this weld sequence file, Weld Sequencer changes the 
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Field Description 

Wire Package information on the Welding Power Source to match the information you 
entered here. 

Power Feed 10M and Power Feed 84 User Interface Controls 

Automatic 
and Manual 

The Automatic and Manual columns let you control the User Interface lockout when the 
weld sequence is in Automatic mode and when the Weld Operator puts the sequence 
into Manual mode.  Simply select the appropriate lockout preferences in each column. 

Master 
Lockout 

The Master Lockout checkbox allows you to lock all user interface controls for this weld 
sequence, preventing the operator from making any changes. 

The Master Lockout checkbox should not be checked if the Save User Preferences feature 
is being used. 

Master Lockout takes precedence over the Encoder Lockout, Memory Save Lockout, 
Memory Button Disable, Mode Select Panel Lockout and Preference Lock options. 

Encoder 
Lockout 

The Encoder Lockout drop-down allows you to lock one or both of the upper knobs 
(encoders) on the Welding Power Source for this weld sequence, preventing the 
operator from changing wire feed speed, amps, volts or trim.  The function of each upper 
knob depends on the selected weld mode.  When a constant current weld mode is 
selected (e.g., Stick, TIG, Gouge), the upper right knob will always function as an on/off 
switch. 

In order to adjust and Save User Preferences, the Encoders should be unlocked to allow 
the operator to adjust the allowed parameters. 

Select the appropriate lockout option, setting the options for both Automatic and 
Manual operation of the weld sequence. 

Memory Save 
Lockout 

The Memory Save Lockout allows you to control whether the operator can overwrite the 
memories on the Welding Power Source with new data. 

 Unlocked:  When you select Unlocked, the operator can save memories and 
reconfigure limits set on the machine.  

 Fully Locked:  Fully Locked prevents the memories from being changed and 
prohibits reconfiguration of limits on the machine. Do not choose this setting 
when enabling the Save User Preferences feature. 

 Allow Saving Within Limits:   

Memory 
Button Disable 

If you want to enable/disable a specific memory button on the User Interface, you can 
select the memory button from the Memory Button Disabled drop-down (or 
enable/disable ALL memories).   

When a memory is disabled, you cannot restore Weld Procedures from or save Weld 
Procedures to that memory. 

If using the Save User Preferences feature, Memories 1 and 2 (at a minimum) have to be 
enabled. 

NOTE | In multi-head systems, this parameter disables the same memory buttons on 
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Field Description 

both feed heads. 

Mode Select 
Panel Lock 

The Mode Select Panel Lock allows you to select between several Mode Select Panel 
lockout preferences.  This helps you control the selections the Weld Operator may make 
on the Welding Power Source. 

 All MSP Options Unlocked:  All adjustable parameters on the Mode Select Panel 
are unlocked. 

 All MSP Options Locked:  All knobs and buttons on the Mode Select Panel are 
locked. 

 Start & End Options Locked:  The Start and End parameters on the Mode Select 
Panel are locked; all others are unlocked. 

 Weld Mode Option Locked:  The Weld Operator cannot change the Weld Mode 
from the Mode Select Panel; all other Mode Select Panel settings are unlocked.  

 Wave Control Options Locked:  The Wave Control parameters on the Mode Select 
Panel are locked; all others are unlocked. 

 Start, End & Wave Options Locked:  The Start, End and Wave Control parameters 
on the Mode Select Panel are locked; all others are unlocked. 

 Start, End & Mode Options Locked:  The Start, End and Weld Mode Select 
parameters on the Mode Select Panel are locked; all others are unlocked.  

Preference 
Lock 

With the Preference Lock checkbox, you can control whether the Weld Operator can 
modify the setup parameters on the Welding Power Source with or without a passcode.  

 Unchecked:  The operator does not need to enter the passcode to change any 
setup menu parameter, even if the passcode is non-zero. 

 Checked:  The operator must enter the passcode (if the passcode is non-zero) in 
order to change any setup menu parameters. 

Passcode Creating a passcode allows you to prevent unauthorized changes to the equipment for 
this weld sequence.  The default passcode is zero, which allows full access.  A non-zero 
passcode will prevent unauthorized: 

 changes to memory limits 

 saving to memory (if Memory Save Lockout is disabled) 

 changes to setup parameters (if the Preference Lock checkbox is unchecked) 

Valid passcode entries are from 0 to 9998. 

Power Wave® 300C User Interface Controls 

Weld 
Feedback 
Persist 

Enable the Power Wave® User Interface to display values from the last weld after 
completion. 

Weld 
Feedback 
Time 

The amount of time the values from the last weld are displayed on the User Interface.  

Homescreen You can control whether the Power Wave® User Interface displays a Simplified or 
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Field Description 

Layout Advanced layout. 

Restrict 
Start/End 
Settings 

Restrict use of the Start and End parameters on the Power Wave® User Interface. 

Restrict Wave 
Controls 

Restrict use of the Wave Control parameters on the Power Wave® User Interface. 

Restrict 
Remote Range 

Restrict the ability to make adjustments using a Remote Pot. 

Restrict 
Trigger 
Interlock 

Restrict the ability to switch between 2-Step and 4-Step. 

Memory Only 
Mode 

Choose whether the operator is limited to settings saved in memory when welding in 
manual mode. 

Memory 
Modification 

Choose whether the operator can save changes to memory. 

Weld Record Logging 

A weld record is a string of data from the Welding Power Source.  This data contains the details of an 
individual weld, from the arc start time to the WeldScore™ of the weld.  The welding power source gathers 
this data and then transmits it to the Lincoln Electric software connected to the power source.  

The Weld Record Logging feature in Weld Sequencer receives the same weld record data that the Welding 
Power Source sends to CheckPoint™ and stores it in the Weld Sequencer database.  In addition, the 
database records includes sequence-specific welding information such as the sequence file name, number 
of welds and whether the weld validation passed or failed. 

Each time the sequence runs the Weld Record Logging feature stores summary information from the 
sequence, information on every Function in the sequence and the weld Record.  

Since Weld Sequencer saves the weld record to the Weld Sequencer database, you can search the database 
for related welds on a variety of parameters.  For example, John at Advanced Manufacturing searches the 
database for all welds made using a specific weld sequence file and reviews each of the weld records.  He 
can also search the database for those weld records related to a specific part serial number. 

Table 5.2 explains the database tables in more detail. 

STOP | Remember:  Using this option increases the size of the 
database.  Each weld record is approximately 1600 bytes. 

 

TIP | Weld Record Logging is also good if you want to keep data 
locally (perhaps there is no Internet connection) 
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Table 5.2 Data Available in the Database Tables 

Column Description 

Data Available in the Weld Records Table 

WeldRecordId This column displays the unique database identifier for this weld record in 
Weld Sequencer database.  This is different from the WeldId column, which 
is the identifier used by the Welding Power Source. 

PC_CreatedOnUTC This is the time from the computer running the Weld Sequencer and the 
weld sequence file, which could be different from the computer running the 
Weld Sequencer database. 

SequenceFile This is simply the file name for the weld sequence file used when creating 
this weld record.  All functions and weld validations used for this weld record 
are included in the file listed here. 

PartName This column displays the assembly name associated with this weld.  You can 
find this information in the Part Name field of the weld sequence under 
Global Properties (page 5.1). 

FunctionType This column displays the type of sequence function that determined the 
parameters of this weld:  Welding, Weld Accumulator or Weld Open. 

FunctionName This column displays the description of the function from the Name field of 
the Properties window.  For example, Figure 6.11 on page 6.8. 

ValidationPassed This column indicates if the validations that were set on the Weld 
Validations tab of the welding function passed. 

PowerSourceStartOfWeld This is the start time for this specific weld on the Welding Power Source. 

IsPowerSourceTimeUTC This column displays whether the time stamp of the power source at the 
beginning of the weld is in UTC format. 

ArcTime The time displayed in this column is the length of time it took to create the 
individual weld. 

WeldProfile This is the Weld Profile used for creating this individual weld.  In the weld 
sequence, you can find this in the Weld Profile field of the welding function’s 
properties. 

CausedLatchedFault This column indicates if this weld went outside the limits set by the Weld 
Profile for the weld, which faulted the power source and caused it to stop 
welding immediately.  This is also known as a “Fault System” event.  The 
Weld Operator would have been able to make adjustments and begin 
welding again. 

CausedFault This column indicates if a fault occurred as a result of this weld.  
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Column Description 

CausedLatchedAlarm This column indicates if a weld went outside the limits set by the Weld 
Profile and caused the power source to enter into a faulted state (also 
known as a “Alarm Latch” event).  In order for the power source to continue 
welding, the Weld Operator would have had to clear the fault. 

CausedAlarm This column indicates if an alarm was issued for an event that occurred while 
making this weld. 

ArcTimeExceededHigh This column indicates if the duration of the weld went above the high end of 
the time limit that was set in the Weld Profile used to make the weld.  

ArcTimeExceededLow This column indicates if the duration of the weld went below the low end of 
the time limit that was set in the Weld Profile used to make the weld.  

IsShortWeld This column indicates if the duration of the weld less than the Start plus End 
delay times set in the Weld Profile used to make the weld. 

ArcTimeOutOfLimits This column indicates if the arc time for the weld went outside the high or 
low Weld duration limit set in the Weld Profile used to make the weld. 

WeldScoreExceededLow This column indicates if the WeldScore® of the weld went below the 
WeldScore® limit that was set in the Weld Profile used to make the weld.  

WireSpeedExceededHigh This column displays whether the wire feed speed went above the wire feed 
speed limit set in the Weld Profile that was used to make the weld. 

WireSpeedExceededLow This column displays whether the wire feed speed went below the wire feed 
speed limit set in the Weld Profile that was used to make this weld.  

VoltageExceededHigh This column displays whether the arc voltage went above the high end of the 
arc voltage limit set in the Weld Profile that was used to make this weld.  

VoltageExceededLow This column displays whether the arc voltage went below the low end of the 
arc voltage limit set in the Weld Profile that was used to make this weld.  

CurrentExceededHigh This column displays whether the current went above the high end of the arc 
current limit set in the Weld Profile that was used to make this weld.  

CurrentExceededLow This column displays whether the current went below the low end of the arc 
current limit set in the Weld Profile that was used to make this weld.  

CurrentAverage Hundreds of times per second, the Welding Power Source takes a 
measurement of the arc current while the welder is active for this weld 
(minus the Start and End delays).  When the weld is complete, the power 
source averages those measurements together.  The CurrentAverage column 
displays that average arc current value for this weld. 

CurrentMax The CurrentMax column displays the highest arc current measurement taken 
by the Welding Power Source throughout the duration of this weld (minus 
the Start and End delays). 
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Column Description 

CurrentMin The CurrentMin column displays the lowest arc current measurement taken 
by the Welding Power Source throughout the duration of this weld (minus 
the Start and End delays). 

CurrentPercentHigh This value is the percentage of measurements taken during the weld (minus 
the Start and End delays) that were above the high end of the arc current 
limit set in the Weld Profile that was used to make this weld. 

CurrentPercentLow This value is the percentage of measurements taken during the weld (minus 
the Start and End delays) that were below the low end of the arc current 
limit set in the Weld Profile that was used to make this weld. 

CurrentHighLimit This column displays the high end of the arc current limit that was set in the 
Weld Profile used to make the weld. 

CurrentLowLimit This column displays the low end of the arc current limit that was set in the 
Weld Profile used to make the weld. 

VoltageAverage Hundreds of times per second, the Welding Power Source takes a 
measurement of the arc voltage while the welder is active for this weld 
(minus the Start and End delays).  When the weld is complete, the power 
source averages those measurements together.  The VoltageAverage column 
displays that average arc voltage value for this weld. 

VoltageMax The VoltageMax field displays the highest arc voltage measurement taken by 
the Welding Power Source throughout the duration of this weld (minus the 
Start and End delays). 

VoltageMin The VoltageMin field displays the lowest arc voltage measurement taken by 
the Welding Power Source throughout the duration of this weld (minus the 
Start and End delays). 

VoltagePercentHigh This value is the percentage of measurements taken during the weld (minus 
the Start and End delays) that were above the high end of the arc voltage 
limit set in the Weld Profile that was used to make this weld. 

VoltagePercentLow This value is the percentage of measurements taken during the weld (minus 
the Start and End delays) that were below the low end of the arc voltage 
limit set in the Weld Profile that was used to make this weld. 

VoltageHighLimit This column displays the high end of the arc voltage limit that was set in the 
Weld Profile used to make the weld. 

VoltageLowLimit This column displays the low end of the arc voltage limit that was set in the 
Weld Profile used to make the weld. 
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Column Description 

WireSpeedAverage Hundreds of times per second, the Welding Power Source takes a 
measurement of the speed at which the wire is put into the weld (minus the 
Start and End delays).  When the weld is complete, the power source 
averages those measurements together.  The WireSpeedAverage column 
displays that average wire feed speed value for this weld. 

WireSpeedMax The WireSpeedMax column is the highest wire feed speed measurement 
taken by the Welding Power Source throughout the duration of this weld 
(minus the Start and End delays). 

WireSpeedMin The WireSpeedMin field displays the lowest wire feed speed measurement 
taken by the Welding Power Source throughout the duration of this weld 
(minus the Start and End delays). 

WireSpeedPercentHigh This value is the percentage of measurements taken during the weld (minus 
the Start and End delays) that were above the wire feed speed limit set in 
the Weld Profile that was used to make this weld. 

WireSpeedPercentLow This value is the percentage of measurements taken during the weld (minus 
the Start and End delays) that were below the wire feed speed limit set in 
the Weld Profile that was used to make this weld. 

WireSpeedHighLimit The WireSpeedHighLimit column simply displays the high end of the wire 
feed speed limit that was set in the Weld Profile used for the weld.  

WireSpeedLowLimit The WireSpeedLowLimit column simply displays the low end of the wire feed 
speed limit that was set in the Weld Profile used for the weld. 

WeldScoreAverage The WeldScoreAverage column displays the average score for this weld.  
Every quarter of a second, the Welding Power Source compares the 
performance of the weld against the trained weld for the Weld Profile being 
used.  When the weld is complete, the power source averages those 
measurements together for an average WeldScore® value.  For more details 
on WeldScore®, please refer to the Power Wave® Manager User Manual 
(IM8002). 

WeldScoreMax The WeldScoreMax column is the highest WeldScore® measurement 
calculated by the Welding Power Source throughout the duration of this 
weld (minus the Start and End delays). 

WeldScoreMin The WeldScoreMin column displays the lowest WeldScore® measurement 
taken by the Welding Power Source throughout the duration of this weld 
(minus the Start and End delays). 

WeldScorePercentLow This value is the percentage of measurements taken during the weld (minus 
the Start and End delays) that were below the WeldScore® limit set in the 
Weld Profile that was used to make this weld. 
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Column Description 

WeldScoreLowLimit This column displays the WeldScore® limit that was set in the Weld Profile 
used to make this weld. 

ArcTimeMaxLimit This column displays the high end of the time limit that was set in the Weld 
Profile used to make the weld. 

ArcTimeMinLimit This column displays the low end of the time limit that was set in the Weld 
Profile used to make the weld. 

StartDelay This is the amount of delay that was used for the beginning of this weld.  The 
Start delay is an option set in the Weld Profile and is the amount of time (in 
seconds) that the power source will wait, directly after the start of a weld, 
until the limits entered for the Weld Profile begin to be applied.  This option 
is necessary because the start of a weld is often unpredictable and may fall 
out of limits easily.  For more in-depth details on Start Delay, please refer to 
the Power Wave® Manager User Manual (IM8002). 

EndDelay This is the amount of delay used at the end of this weld.  The End delay is an 
option set in the Weld Profile and is the amount of time (in seconds) directly 
before the end of a weld that the power source stops applying the limits 
entered for the Weld Profile.  This option is necessary because, at the end of 
a weld, the set points for the Welding Power Source are often different than 
the rest of the weld (e.g., if the Power Wave® is in a burn-back state).  For 
more in-depth details on End Delay, please refer to the Power Wave® 
Manager User Manual (IM8002). 

SerialNumber The Serial Number column is the part serial number associated with this weld 
and entered with either a Field Entry function or a PLC Field Entry function. 

OperatorId This is the username of the person who was logged into Weld Sequencer 
during the creation of this weld. 

ConsumableLot The Consumable Lot is the consumable lot code that was entered with either 
a Field Entry function or a PLC Field Entry function. 

WeldId This column displays the identifier used by the Welding Power Source for this 
weld record.  This is different from the WeldRecordId column, which is the 
database identifier for this weld record in the Weld Sequencer database.  

ConsumableDensity The ConsumableDensity column displays the density of the metal used for 
this individual weld.  The system uses the wire density in its calculation of 
how much material was deposited for this weld. 

WireDiameter The WireDiameter column displays the diameter of the wire used for this 
individual weld.  The system uses the wire diameter in its calculation of how 
much material was deposited for this weld. 
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Column Description 

TrueEnergy This column displays the True Energy™ calculated for this weld using the 
following equation: 

𝑇𝑟𝑢𝑒 𝐸𝑛𝑒𝑟𝑔𝑦 [ 𝐽] =  
1

𝑛
 ∑(𝑣𝑖 ∗ 𝑖𝑖 ∗ 𝑡𝑖 )

𝑛

𝑖=1

 

If the Welding Power Source that made the weld had older firmware and did 
not support the True Energy™ calculation, this column displays a 0. 

Deposition The Deposition shows how much material was deposited during the weld, 
normalized to pounds per hour. 

PowerSourceName This column displays the name of the Welding Power Source that was set by 
the user. Please refer to the Power Wave® Manager User Manual (IM8002) 
for information on setting this name. 

NOTE | The power source name can be changed by the user. This value can 
be blank or may be the same for multiple power sources. 

PowerSourceDeviceID This column shows a unique identifier for the Welding Power Source that 
made the weld. This value was assigned to the power source during its 
manufacture and cannot be changed. 

WeldMode This column shows the Weld Mode selected when this weld was made. 

Data Available in the Weld Record Summary Table 

WeldRecordSummaryId This field displays the unique database identifier for this weld summary in 
the Weld Sequencer database. 

Welder The name of the Power Wave® that was used during the weld sequence. 

PartName The text that was entered in the Part Name field in General Properties. 

CycleTime The total elapsed time to run the weld sequence. 

Arctime The total time for all welds made during the weld sequence. 

CompletedWelds The number of welds made during the weld sequence. 

ExpectedWelds The number of welds expected for the entire weld sequence. 

FeedHead1_WireDiamerter The WireDiameter field is the diameter of the wire used for this 
weld sequence. The system uses the wire diameter in its calculation of how 
much material was deposited for this weld sequence. 

FeedHead1_WireDensity The WireDensity field is the density of the metal used for this 
weld sequence. The system uses the wire density in its calculation of how 
much material was deposited for this weld sequence. 

FeedHead2_WireDiamerter The WireDiameter field is the diameter of the wire used for this 
weld sequence. The system uses the wire diameter in its calculation of how 
much material was deposited for this weld sequence. 



Global Properties Chapter 5. Sequence-Level Properties 

IM8003 Weld Sequencer User Manual 5.15 

Column Description 

FeedHead2_WireDensity The WireDensity field is the density of the metal used for this 

weld sequence. The system uses the wire density in its calculation of how 
much material was deposited for this weld sequence. 

TotalDeposition The deposition field shows how much material was deposited during the 
weld sequence, normalized to pounds per hour. 

OperatorId This is the username of the person who was logged into Weld Sequencer 

during the weld sequence. 

PartSerialNumber The Serial Number is the part serial number associated with this weld 

and entered with either a Field Entry function or a PLC Field Entry function. 

ConsumableLot The Consumable Lot is the consumable lot code that was entered with either 

a Field Entry function or a PLC Field Entry function. 

CycleStartTime This is the start time from the computer running the Weld Sequencer and 
the weld sequence file, which could be different from the computer running 
the WeldSequencer database. 

CycleEndTime This is the end time from the computer running the Weld Sequencer and the 
weld sequence file, which could be different from the computer running the 
WeldSequencer database. 

Data Available in the Weld Record Functions Table 

WeldRecordFunctionsId This field displays the unique database identifier for this weld function list in 
Weld Sequencer database.   

WeldRecordSummaryId This field displays the unique database identifier for this weld summary in 
Weld Sequencer database 

WeldRecordId This column displays the unique database identifier for this weld record in 
Weld Sequencer database.  This is different from the WeldId column, which 
is the identifier used by the Welding Power Source. 

StepNumber This is the number of the step that contains this function. This number is in 
the lower area of the vertical bar in the Weld Sequencer Editor.  

FunctionType Identifies the type of function. 

FunctionName This is the name assigned to the function. 

WeldId This field displays the identifier used by the Welding Power Source for this 
weld.  This is different from the WeldRecordId column, which is the database 
identifier for this weld record in the Weld Sequencer database.  

Status This indicates whether the function initially passed or failed validation. 

FinalStatus This indicates whether the function passed or failed validation at the 
completion of the weld sequence. The Review function may be used to 
change the status after visual inspection. 
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Column Description 

ExecutionTime This is the amount of time used for the function to complete. 

ExpectedTime This is the estimated time entered into the function. 

ManualTime This is the amount of time where control was switched to Manual Mode.  

Miscellaneous This is a text field used to store messages. For an Alert function, the 
validation results will be stored. 

FunctionId This field is a system generated identifier provided for each function.  

Opening Tab-Delimited Sequence Reports 

Tab-delimited Sequence Report files are special text files where each piece of data in each of the weld 
records is separated by a tab character.  Once you have the Sequence Report file, you can use it a variety of 
ways.  One of the common ways to open the file is to open it in Microsoft® Excel.  

NOTE | Depending how you open this file, the formatting may look 
strange. 

To import a Sequence Report into Microsoft® Excel: 

Procedure Details 

1. Open Microsoft® Excel.  

2. Select File > Open from the main menu.  

3. Navigate to C:\Weld Sequencer 
Files\Logs\ SequenceReports. 

 

4. Select your report file and click Open. The Text Import Wizard in Microsoft® Excel should open. 

 

5. Verify you have Delimited chosen under 
Original data type and click Next. 
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Procedure Details 

6. On Step 2 of the Text Import Wizard, 
verify there is a check mark next to Tab 
in the Delimiters section. 

Weld Sequencer exports Sequence Reports as tab-
delimited files (as of 9/29/14).  If you have a different 
delimiter, choose the appropriate option. 

 

7. Click Next.  

8. On Step 3 of the Text Import Wizard, 
click Finish. 

Microsoft® Excel opens the file with data separated into 
columns based on the delimiter. 

Weld Procedures Library 
The Weld Procedures in the top toolbar is a library of procedures that you can call from the welding 
functions in this weld sequence.  This allows you to set the parameters for each type of weld (i.e., what will 
be used for Procedure A and Procedure B on each weld).  When you change a parameter in the library, any 
function using that type of weld automatically begins using the new parameter. 

When the Weld Operator launches Weld Sequencer, the application saves the weld procedures currently 
found on the connected Welding Power Source.  Once the operator closes the application, Weld Sequencer 
reloads those weld procedures back to the Welding Power Source.  This allows the power source to retain 
its original procedures and prevents customized procedures from a sequence file to remain active in the 
Welding Power Source. 

NOTE | There is an exception, however.  If parameter P.16 (Push-Pull 
Gun Knob Behavior) is set to either “Gun Pot Enabled” or “Gun 
Pot Proc A” on the wire feeder, this setting overrides the 
defined wire feed speed from the weld procedure.  Please 
refer to the appropriate Operator Manual for your Welding 
Power Source or wire feeder for more information on using 
this parameter. 
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Figure 5.4 Weld Procedures Library 

For existing weld procedures in a sequence, you can click the appropriate Update from Feed Head button 
(Figure 5.4) to replace all of the parameters with those from the connected power source. 

Older Weld Sequence files may have weld procedures that do not have parameter limits.  When this 

condition exists, a warning icon  displays next to the Weld Mode field.  You can click the Refresh button 
to load the parameter limits from the connected power source.  

NOTE | If a weld procedure uses a Weld Mode that does not exist in 

the connected power source, a warning icon  appears next 

to the Weld Mode field.  Hover your mouse over the icon to 
display an explanation. 

You can also set the defaults for Procedure A and Procedure B to help you quickly build your weld 
sequence.  If you have a sequence where the majority of the welds use the same procedure, you can use 
the Default Procedure A and Default Procedure B drop-downs at the top of the window to automatically 
pre-populate the Weld Procedures tab on every welding function you add. 

STOP | You must connect to the Welding Power Source in order to 
load the weld parameters into the weld sequence file. 

 

STOP | Weld Sequencer automatically connects to the last Welding 
Power Source connected.  Before editing the weld parameters, 
be sure you are connected to the correct Welding Power 
Source. 

 

NOTE | For details on the specific parameters available, please refer 
to the appropriate Operator Manual for your Welding Power 
Source or wire feeder. 

 

TIP | If you have a Dual Head feeder for this weld sequence, you 
will have two sets of default drop-downs—one set for each 
feed head. 
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Adding a Weld Procedure to the Library 

In order to add a Weld Procedure for a type of weld, you need to connect to the appropriate Welding 
Power Source to be used with the weld sequence file and load the available parameters into the file.  You 
can then create the set of procedures you need for the welding functions in your sequence.  (See page 5.20 
for information on saving Weld Procedures to the database instead of saving in the sequence file.) 

NOTE | If the Workpoint and Trim units differ from those established 
in the Global Properties for this weld sequence, Weld 
Sequence Editor displays a warning message. 

 

Figure 5.5 Adding a Weld Procedure 

To add a procedure to the Weld Procedures library: 

Procedure Details 

1. Launch the Weld Sequence Editor and load 
your weld sequence file. 

 

2. Log in to Weld Sequence Editor.  

3. Click the PS Connect button and connect to 
the Welding Power Source. 

See page 2.11 for more in-depth information. 

4. Click the Weld Procedures button in the top 
toolbar. 

 

5. Select <New> from the Weld Procedure 
drop-down if not already selected. 

See Figure 5.5. 

6. Enter a name for the type of weld in the 
Weld Procedure Name field. 

 

7. Click the Load from Feed Head #1, 
Procedure A or Load from Feed Head #1, 
Procedure B button to load this weld 
procedure from the appropriate procedure 
group on the wire feeder. 

Weld Sequence Editor reads the available parameters 
from this procedure group. 

TIP | If you have a Dual Head feeder, there are two 
buttons for each feed head. 
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Procedure Details 

8. Click OK. Weld Sequence Editor adds a new entry to the Weld 
Procedure drop-down. 

 

TIP | You can add multiple weld procedures in one 
sitting; however, be sure you click OK when finished 
to save your changes. 

Adding a Weld Procedure to the Database 

You also have the option of saving a Weld Procedure to a common database so that multiple weld 
sequence files can use the same weld procedure.  This allows you to create the weld procedure once, assign 
the weld procedure to functions in multiple files, and then only update the procedure once.  When you 
update the weld procedure from within any of the sequence files, every weld sequence that uses that 
procedure will always use the latest parameters. 

STOP | Use caution when making changes to or deleting Weld 
Procedures saved in the database.  Any weld sequence file 
that uses the procedure will be impacted. 

Saving a Weld Procedure to the common database is simple: 

1. Create your weld procedure (page 5.19) and be sure to save it. 

2. Edit the Weld Procedure Name field and enclose the name in square brackets (Figure 5.6). 

3. Save the Weld Procedure. 

The brackets tell Weld Sequence Editor to save the weld procedure to the database so you can pull it from 
the database for other weld sequence files.  When you select the weld procedure on a function (page 6.33), 
the drop-down contains all weld procedures created for the individual sequence file and all weld 
procedures saved in the database (enclosed in square brackets). 
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Figure 5.6 Weld Procedure Saved in the Database 

NOTE | Each computer using Weld Sequencer out on the shop floor 
must have access to the database when using this feature. 

User Limits 

The Save User Preferences feature allows a Weld Operator to adjust and save their preferred settings for 
each Weld Procedure. The Weld Engineer enables this feature by checking the Enable User Limits checkbox 
and choosing the range for each parameter in the Weld Procedure. 

 

NOTE | The Weld Procedure must be stored in the database when 
using User Preferences and User Limits. 

 

Editing a Weld Procedure in the Library 

When you need to edit welding parameters in a procedure, you do not need to connect to the Welding 
Power Source to make your changes.  You can make your changes, and once the Weld Operator loads the 
weld sequence file, Weld Sequencer updates the Welding Power Source before welding begins.  Once you 
make your changes to the procedure in the Weld Sequence Editor, any function using that type of weld 
reflects the change. 

TIP | If a Weld Procedure uses a weld mode that does not exist on 

the connected power source, a warning icon  appears next 
to the Weld Mode field.  Hover your mouse over the icon for 
an explanation of the error. 

If you want to update the weld procedure to match the procedure on the connected Welding Power 
Source, simply click the Refresh button.  The Weld Sequence Editor clears the current parameters and 
replaces them with the values from the Welding Power Source. 

Procedure Details 

1. Launch the Weld Sequence Editor and load  
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Procedure Details 

your weld sequence file. 

2. Click the Weld Procedures button in the top 
toolbar. 

 

3. From the Weld Procedure drop-down, select 
the type of weld you want to edit. 

 

4. Make the changes you need to make.  

5. Click OK. Weld Sequencer updates the parameters and all the 
functions using this weld procedure automatically 
begin to use the new parameters. 

Deleting a Weld Procedure from the Library 

When you need to remove a weld procedure from a weld sequence, you do not need to connect to the 
Welding Power Source to make your changes.  Once you make your changes to the procedure in the Weld 
Sequence Editor, any function using that type of weld reflects the change. 

Procedure Details 

1. Launch the Weld Sequence Editor and load 
your weld sequence file. 

 

2. Click the Weld Procedures button in the top 
toolbar. 

 

3. From the Weld Procedure drop-down, select 
the procedure you want to remove. 

 

4. Click the Delete icon  next to the Weld 

Procedure Name field. 

 

5. Click OK to commit your changes. Weld Sequence Editor removes the weld procedure 
from the weld sequence file. 

Copying Weld Procedures 

When you need to copy a Weld Procedure while building a weld sequence, follow these steps. 

Procedure Details 

1. Launch the Weld Sequence Editor and load 
your weld sequence file. 

 

2. Click the Weld Procedures button in the top 
toolbar. 

 

3. From the Weld Procedure drop-down, select 
the procedure you want to copy. 

 

4. Click the Copy icon  next to the Weld A copy of the Weld Procedure is created and “-
Copy” is added to the Weld Procedure Name field.  
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Procedure Details 

Procedure Name field. You can rename this to anything you want. 

5. Click OK to commit your changes.  

Weld Validations Library 
You create all of the validations needed in this weld sequence under Weld Validations in the top toolbar.  
Once you create your “library” of welding requirements, you can select them on the Weld Validation tab of 
each welding function. 

 

Figure 5.7 Weld Validations 

Adding Weld Validations to the Library 

You can validate a weld based directly on the properties of the weld record or based on the limits from the 
Weld Profile used for the weld.  These validations instruct the sequence what to do next based on average 
values from the weld record or properties of Weld Profile events.  

 The validation using the weld record compares the values directly from the weld record (e.g., 
deposition, duration, short weld alert) and does not involve the limits from the Weld Profile. 

 Validating based on Weld Profile limits compares the average values in the weld record to the 
limits set in the Weld Profile, which you can set on the Properties tab of the welding function. 

To create validation rules, select <New> from the Select Weld Validation drop-down; enter a name for the 
validation in the Weld Validation Rule field; and select the appropriate property from the Property Name 
drop-down.  Use the Operation and Value fields to set the condition for passing the weld.  Table 5.3 
explains each of the options in the Property Name drop-down in detail.  Be sure to click OK to commit your 
changes. 

 

Figure 5.8 Adding a Validation 

The Condition Operator drop-down allows you to add more than one validation for the weld.  Select AND 
from the drop-down to tell the weld sequence that the weld must meet both conditions.  

TIP | Be sure that you have None selected in the Condition Operator 
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drop-down on the last condition of the rule.  Otherwise, the 
sequence errors out for the Weld Operator. 

For example, John at Advanced Manufacturing has several tack welds in his weld sequence.  He wants each 
of those welds to meet certain qualities before the Weld Operator can continue and to ensure the welds 
are consistent.  Therefore, he created a “Tack” validation rule where the duration must be greater than one 
second but less than two seconds:  Duration >= 1 AND Duration <= 2.  These are John’s “good” conditions. 

Table 5.3 Validation Properties Available in the Property Name Drop-down 

Property Name Description 

(WR = Weld Record property; WP = Weld Profile property) 

Current Alert (WP)  This option allows you to validate the weld based on whether the arc current 
went above the maximum OR below the minimum limit set in the Weld Profile that 
was used to make this weld. 

Current Average (WR)  Hundreds of times per second, the Welding Power Source takes a measurement 
of the arc current while the welder is active for this weld (minus the Start and End 
delays).  When the weld is complete, the power source averages those measurements 
together.  The Current Average property allows you to set the validation of the weld 
based on the average arc current value for this weld. 

Current Exceeded 
High Limit 

(WP)  This option allows you to validate the weld based on whether the current went 
above the high end of the arc current limit set in the Weld Profile that was used to 
make this weld. 

Current Exceeded 
Low Limit 

(WP)  This option allows you to validate the weld based on whether the current went 
below the low end of the arc current limit set in the Weld Profile that was used to 
make this weld. 

Current Maximum (WR)  The Current Maximum option allows you to validate a weld based the highest 
arc current measurement taken by the Welding Power Source throughout the 
duration of the weld (minus the Start and End delays). 

Current Minimum (WR)  The Current Minimum option allows you to validate a weld based on the lowest 
arc current measurement taken by the Welding Power Source throughout the 
duration of the weld (minus the Start and End delays). 

Deposition (WR)  The Deposition option allows you validate a weld based on the total amount of 
material deposited during the welds (in lbs.) in the function.  This is extremely useful 
with the Weld Accumulator function (page 6.29). 

Duration (WR)  The Weld Duration displays the length of time (in seconds) from the time listed 
in the Start of Weld field to the time the Welding Power Source stopped welding. 

Short Weld Alert (WP)  You can validate a weld based on whether it is a short weld (i.e., Welds with a 
duration less than the sum of the Start Delay time plus the End Delay time) as defined 
in the Weld Profile. 

Time Exceeded 
High Limit 

(WP)  This option allows you to validate the weld based on whether the duration 
went above the time limit set in the Weld Profile that was used to make this weld. 
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Property Name Description 

Time Exceeded 
Low Limit 

(WP)  This option allows you to validate the weld based on whether the duration was 
below the time limit set in the Weld Profile that was used to make this weld. 

True Energy (WR)  True Energy™ is a Lincoln Electric technology that uses the digital control 
system embedded in each Power Wave® power source to measure and calculate the 
instantaneous amount of energy put into a weld.  The True Energy option allows you 
to set the validation of the weld based on the average True Energy™ put into this 
weld. 

Voltage Alert (WP)  This option allows you to validate the weld based on whether the arc voltage 
went above the maximum OR below the minimum limit set in the Weld Profile that 
was used to make this weld. 

Voltage Average (WR)  Hundreds of times per second, the Welding Power Source takes a measurement 
of the arc voltage while the welder is active for this weld (minus the Start and End 
delays).  When the weld is complete, the power source averages those measurements 
together.  The Voltage Average option allows you to set the validation of the weld 
based on the average arc voltage value for this weld. 

Voltage Exceeded 
High Limit 

(WP)  This option allows you to validate the weld based on whether the arc voltage 
went above the high end of the arc voltage limit set in the Weld Profile that was used 
to make this weld. 

Voltage Exceeded 
Low Limit 

(WP)  This option allows you to validate the weld based on whether the arc voltage 
went below the low end of the arc voltage limit set in the Weld Profile that was used 
to make this weld. 

Voltage 
Maximum 

(WR)  The Voltage Maximum field allows you to validate a weld based on the highest 
arc voltage measurement taken by the Welding Power Source throughout the 
duration of this weld (minus the Start and End delays). 

Voltage Minimum (WR)  The Voltage Minimum option allows you to validate a weld based on the lowest 
arc voltage measurement taken by the Welding Power Source throughout the 
duration of this weld (minus the Start and End delays). 

WeldScore 
Average 

(WR)  Every quarter of a second, the Welding Power Source compares the 
performance of the weld against the trained weld for the Weld Profile being used.  
When the weld is complete, the power source averages those measurements 
together for an average WeldScore® value.   

The WeldScore Average option allows you to validate the welding function based on 
the average WeldScore® for the weld. 

WeldScore Low 
Alert 

(WP)  In each Welding Power Source, you can have the power source issue an alert if 
the WeldScore® goes below a certain score.  You can validate the weld on whether or 
not an alert was issued. 

For example, if a WeldScore Low alert was issued for the weld(s) performed in the 
weld function, you can forward the sequence to an Alert function or an Approval 
function to address the potential quality issue.  If no alert was issued, the weld 
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Property Name Description 

sequence can go on to the next function in the sequence. 

WeldScore 
Maximum 

(WR)  The WeldScore Maximum option allows you to validate the weld(s) based on 
whether the maximum WeldScore® on the weld performed is above, below or equal 
to the number you specify here. 

WeldScore 
Minimum 

(WR)  The WeldScore Minimum option allows you to validate the weld(s) based on 
whether the minimum WeldScore® on the weld performed is above, below or equal 
to the number you specify here. 

Wire Feed Speed 
Alert 

(WP)  This option allows you to validate the weld based on whether the wire feed 
speed went above the maximum OR below the minimum limit set in the Weld Profile 
that was used to make this weld. 

Wire Feed Speed 
Average 

(WR)  Hundreds of times per second, the Welding Power Source takes a measurement 
of the speed at which the wire is put into the weld (minus the Start and End delays).  
When the weld is complete, the power source averages those measurements 
together.  The Wire Feed Speed Average option allows you to validate the weld based 
on the average wire feed speed value for the weld. 

Wire Feed Speed 
Exceeded High 
Limit 

(WP)  This option allows you to validate the weld based on whether the wire feed 
speed went above the wire feed speed limit set in the Weld Profile that was used to 
make this weld. 

Wire Feed Speed 
Exceeded Low 
Limit 

(WP)  This option allows you to validate the weld based on whether the wire feed 
speed went below the wire feed speed limit set in the Weld Profile that was used to 
make this weld. 

Wire Feed Speed 
Maximum 

(WR)  The Wire Feed Speed Maximum option allows you to validate a weld based on 
the highest wire feed speed measurement taken by the Welding Power Source 
throughout the duration of the weld (minus the Start and End delays).  

Wire Feed Speed 
Minimum 

(WR)  The Wire Feed Speed Minimum option allows you to validate a weld based on 
the lowest wire feed speed measurement taken by the Welding Power Source 
throughout the duration of the weld (minus the Start and End delays).  

Adding a Weld Validation to the Database 

You can save a Weld Validation to a common database so that multiple weld sequence files can use the 
same Weld Validation.  This allows you to create the Weld Validation once, assign the Weld Validation to 
functions in multiple files, and then only update the Validation once.  When you update the Weld 
Validation from within any of the sequence files, every weld sequence that uses that Validation will always 
use the latest parameters. 

STOP | Use caution when making changes to or deleting Weld 
Validations saved in the database.  Any weld sequence file 
that uses the Validation will be affected. 

Saving a Weld Validation to the common database: 
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1. Create your Weld Validation (page 5.19) and be sure to save it. 

2. Edit the Weld Validation Name field and click the Store in database checkbox to enclose the name in 
square brackets (Figure 5.9). 

3. Save the Weld Validation. 

The brackets tell Weld Sequence Editor to save the weld Validation to the database so you can pull it from 
the database for other weld sequence files.  When you select the weld Validation on a function (page 6.33), 
the drop-down contains all Weld Validations created for the individual sequence file and all Weld 
Validations saved in the database (enclosed in square brackets) 

  

Figure 5.9 Weld Validation Saved in the Database 

NOTE | Each computer using Weld Sequencer out on the shop floor 
must have access to the database when using this feature. 

Editing a Weld Validation in the Library 

To edit a validation rule, simply click the Weld Validations button in the top toolbar, select the appropriate 
entry from the drop-down and make your changes.  Be sure to click the OK button to commit your changes. 

TIP | If you want to edit multiple entries in one sitting, simply select 
each entry and edit.  Then you can click OK once to commit all 
of the changes you made and close the window. 

 

NOTE | Weld Validations added to the library from the Sequence 
Report Analysis tool use the naming convention 
“FunctionName X.Y” where FunctionName equals the function 
name; X equals the step number (found in the lower left 
corner of the vertical title bar); and Y equals the consecutive 
function for the step (starting at 0). 

Deleting a Weld Validation from the Library 

To remove a validation rule from the sequence, click the Weld Validations button in the top toolbar; select 

the entry you want to remove; and click the Delete icon  next to the Weld Validation Rule field.  Be sure 
to click the OK button to commit your changes. 

STOP | If you delete a validation rule that is currently in use by a weld 
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in the sequence, Weld Sequencer Editor automatically 
removes the selection from the welding function(s). 

Copying Weld Validations 

When you need to copy a Weld Validation while building a weld sequence, follow these steps. 

Procedure Details 

1. Launch the Weld Sequence Editor and 
load your weld sequence file. 

 

2. Click the Weld Validations button in the 
top toolbar. 

 

3. From the Weld Validation drop-down, 
select the validation you want to copy. 

 

4. Click the Copy icon  next to the Weld 

Validation Rule field. 

A copy of the Weld Validation is created and “-Copy” is 
added to the Weld Validation Rule field.  You can rename 
this to anything you want. 

5. Click OK to commit your changes.  

Report Analysis Tool 
On page B.1, we explained the Two-Step Process for creating a weld sequence file.  First, you build the 
skeleton of the sequence with all of the sequence functions you want to use and connect the functions to 
each other.  Second, you add all the weld validations you want to use.  It’s this second part that is time-
consuming.  The Report Analysis tool, however, can do it for you automatically.  

NOTE | The weld record data saved in the report(s) use the active 
Weld Profile to omit starting and ending data.  You must 
correctly configure the Weld Profile Start and End delays 
BEFORE collecting and analyzing the Report data. 
 
When using average data for quick welds (approximately less 
than 5 seconds), the Start and End delays can have a 
significant impact on the analysis process and will not reflect 
an accurate reading for the steady state welding conditions.  
(For in-depth details on Weld Profiles, please refer to the 
Power Wave® Manager User Manual (IM8002).) 

 

NOTE | You must have already generated a series of Sequence 
Reports to use the Report Analysis tool. 

After loading the XML Sequence Report files, the Report Analysis Wizard provides an automated analysis of 
the report files to create weld validations.  A Sequence Report contains all raw data captured while welding 
with the weld sequence file and gives you a complete view of how a part was created. 
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When you create tab-delimited text files or Microsoft® Excel files for your Sequence Reports, Weld 
Sequencer also automatically creates an XML file for each report.  You need these XML files to use with 
Report Analysis.  The Report Analysis tool should find the XML files automatically for you, but you can 
generally find them in the following location if necessary: 
C:\Weld Sequencer Files\Logs\SequenceReports\XML. 

 

Figure 5.10 Create Microsoft® Excel Files 

In order to use the Report Analysis Tool, you must have the weld sequence file you want to edit open in the 
Weld Sequence Editor.  The intention of this tool is to modify your skeleton sequence.  The Sequence 
Reports that you want to analyze must match this open file. 

NOTE | You must have a weld sequence file open in Weld Sequence 
Editor to enable the Report Analysis button in the top toolbar. 

 

Procedure Details 

Load Sequence Reports 

1. Open Weld Sequence 
Editor. 

 

2. Open the weld sequence 
file you want to edit. 

 

3. Click the Report Analysis 
button in the top toolbar. 

The Sequence Report Analyzer window opens. 
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Procedure Details 

 

4. Click either the Load XML 
Report Folder or Load 
XML Report Files button. 

The Load XML Report Folder button allows you to load an entire folder 
of XML Sequence Reports. 

The Load XML Report Files button allows you to load specific individual 
XML file(s) from within a folder. 

TIP | Weld Sequencer automatically sorts through the XML files and 
knows which files go with your open weld sequence file, as well as 
those report files that are empty of completed steps, executed 
functions or automatic welds.  You will confirm the reports you want to 
use in a later step. 

5. Repeat step 4 until 
satisfied that you have 
loaded all your XML 
report files. 

You may have multiple Sequence Reports saved from several welding 
stations running the same weld sequence file. 

NOTE | The list of XML files continues to build as you add more and 
more reports. 

6. Click Next. The Select Assembly Part Names for Analysis window displays. 

 

Select Assembly Part Names for Analysis 

7. Review the set(s) of 
Sequence Reports 
automatically selected by 
the Report Analysis tool. 

The system compares the Part Name (under Global Properties) of the 
currently open weld sequence file to the Part Name in each Sequence 
Report. 

The Report Analysis tool automatically places a check mark next to the 
group(s) of files it determines are a match. 

8. Place a check mark next This can happen if the Part Name of the Sequence Report does not 
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Procedure Details 

to any additional set(s) of 
reports you want to 
include. 

match the open weld sequence file, but the Sequence Report still 
represents valid examples for analysis. 

9. Click Next. The Adjust Analysis Parameters window displays. 

 

Adjust Analysis Parameters 

10. In the Data Analysis 
section, set the Minimum 
Consistency percentage. 

The Minimum Consistency percentage represents the percentage of 
repeated Sequence Report parameter values where the data is 
consistent. 

For example, if you have this value set at 70%, then at least 70% of the 
parameter values contained in the Sequence Reports must be the same 
value to be automatically included for analysis. 

11. In the Function Estimated 
Time section, set the 
parameters for the 
Estimated Time in the 
dataset. 

The Report Analysis tool uses these parameters to limit the dataset to 
the data you consider valuable when calculating the final Estimated Time 
for each function.   

 

Table 5.4 on page 5.35 explains the parameters in detail. 

The Report Analysis tool reviews and creates the Estimated Time for the 
following functions: 

 Display HTML (only if there is a check mark next to Wait for 
Continue Action) 

 Display Picture (only if there is a check mark next to Wait for 
Continue Action) 

 Field Entry 

 Review 

 Weld 

 Weld Accumulator 

 Weld Open 

 PLC Field Entry 

 PLC Tag Read 

 PLC Tag Write 
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Procedure Details 

12. In the Function Weld 
Parameters section, set 
the parameters for the 
welding data in the 
dataset. 

The Report Analysis tool uses these values to limit the dataset to the 
data you consider valuable when calculating the final welding 
parameters for each function.   
 

Table 5.4 on page 5.35 explains the parameters in detail. 

The Report Analysis tool reviews and creates the following parameter 
values from the following functions: 

 Weld Accumulator:  Minimum Number of Welds and Accumulate 
Minimum/Maximum values 

 Weld Open:  Minimum Number of Welds and Maximum Number 
of Welds 

13. In the Weld Validations 
for Arc Time and 
Deposition section, set 
the parameters for the 
arc time and deposition in 
the dataset. 

The Report Analysis tool uses these parameters to limit the dataset to 
the data you consider valuable when calculating the final values for each 
function.   
 

Table 5.4 on page 5.35 explains the parameters in detail. 

14. In the Weld Validations 
for Other Parameters 
section, set the 
parameters for the 
remaining data in the 
dataset. 

The Report Analysis tool uses these values to limit the dataset to the 
data you consider valuable when calculating the remaining welding 
parameters for each function.   
 

Table 5.4 on page 5.35 explains the parameters in detail. 

The Report Analysis tool also reviews and creates the following 
parameter values from the welding functions: 

 Arc Voltage 

 Arc Amperage 

 Wire Feed Speed 

 Deposition 

 True Energy™ 

 WeldScore® 

15. Click Next. The Report Analysis Tool calculates your parameters using the contents 
of all report files you selected. 

Select Reports for Analysis 

16. Verify the reports you 
want to use for the final 
analysis. 

The Report Analysis Tool automatically groups together similar reports 
and selects the reports that fall above your Minimum Consistency 
Percentage for the following: 

 Highest Completed Step:  This is the highest step number 
completed in the weld sequence files and the percentage of 
reports that reached that number. 

 Executed Functions:  This is the number of functions that were 
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performed in the weld sequence files and the percentage of 
reports that reached that number. 

 Automatic Welds:  This is the number of welds performed in 
Automatic mode in the weld sequence files and the percentage 
of reports that reached that number. 

17. Place a check mark next 
to any additional set(s) of 
reports you want to 
include. 

The Sequence Reports may not match your Minimum Consistency 
requirements, but you know they represent valid examples for analysis.  

18. Click Next. The Report Analysis tool performs statistical analysis of the all the 
reports you included. 

First, the tool removes any data points that fall outside the standard 
deviation limits, specified by the Automatic Outlier Removal field for the 
parameters.  Next, the tool uses your SD/Mean Limit parameters on the 
remaining data to determine if they are consistent.  Finally, the Report 
Analysis tool uses the Prediction Range calculate the minimum and 
maximum recommended values. 

Select Calculated Data to Include in the Weld Sequence File 

19. On the Function Data tab, 
place a check mark next 
to each Parameter you 
want to add to the 
indicated function. 

The Report Analysis tool automatically places a check mark next to each 
item that meets your SD/Mean Limit percentage.  Table 5.5 on page 5.36 
explains each column in this section in more detail. 

You can use the Uncheck All and Check All buttons to select parameters 
in bulk. 

20. On the Weld Validation 
Data tab, place a check 
mark next to each Weld 
Validation you want to 
add to the indicated 
function. 

The Report Analysis tool automatically places a check mark next to each 
item that meets your SD/Mean Limit percentage.  Table 5.5 on page 5.36 
explains each column in this section in more detail.  

You can use the Uncheck & Hide buttons and the Show buttons to select 
validations in bulk. 

21. Click Apply Changes to 
make the selected 
changes to the open weld 
sequence file. 

The Report Analyzer Tool updates the appropriate function parameter 
values, creates new weld validations and selects the new weld 
validations in the welding functions. 

NOTE | Weld Validations created by the Sequence Report Analysis 
tool use the naming convention “FunctionName X.Y” where 
FunctionName equals the function name, X equals the step number 
(found in the lower left corner of the vertical title bar), and Y equals the 
consecutive function for the step (starting at 0). 

Summary of Changes 

22. Review the list of changes 
that were made to your 
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Procedure Details 

weld sequence file. 

23. Click OK.  

Analysis Parameters 

The analysis parameters in the Report Analysis tool allow you to control which data from within the 
Sequence Report files to use for calculating a recommended function parameter values and recommended 
weld validations.  You can remove invalid data and narrow down to just good solid weld data.  

TIP | This window remembers your choices and displays them the 
next time you use the Report Analysis tool. 

 

Figure 5.11 Analysis Parameters 

TIP | Different sets of analysis parameters are provided for 
Estimated Time, Function Weld Parameters, Weld Validations 
for Arc Time and Deposition, and Weld Validations for Other 
Parameters so you can set individual preferences for each 
type of parameter. 

 

TIP | Click the Reset Parameters button to revert to the original 
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default settings. 

 
 

Table 5.4 Parameters Available for the Report Analysis Tool 

Field Description 

Minimum 
Consistency 

The Minimum Consistency percentage represents the percentage of repeated Sequence 
Report parameter values where the data is consistent. 

Automatic 
Outlier 
Removal 

The Report Analysis tool loads all the data from the selected Sequence Reports and 
calculates statistics from the entire dataset.  The tool then removes any data points that 
fall outside the standard deviation limits, specified by the upper and lower Automatic 
Outlier Removal limits.  The Samples column (Table 5.5 on page 5.36) in the final results 
indicates how many data points were used in the final statistics in the form of X of Y.  If X is 
less than Y, some of the data points (the outliers) were removed based on these Automatic 
Outlier Removal limits. 

SD/Mean 
Limit 

The SD/Mean Limit field is the maximum limit for considering the data useful or consistent.  
If the analysis produces an SD/Mean (or Coefficient of Variation) value that is less than this 
limit, the Report Analysis tool automatically selects the data in the final step of the 
analysis. 

Prediction 
Range 

Enter the limit range you want the Report Analysis tool to implement when it calculates its 
recommendations.  It does so in terms of standard deviation (SD or Sigma).   The Report 
Analysis tool uses this Prediction Range value to provide a reliable “buffer” on either end 
of the average value.  See Table 5.5 on page 5.36 for more details on how the Report 
Analysis tool uses the Prediction Range to calculate the Low Limit and High Limit. 

Select Calculated Data to Include in the Weld Sequence File 

Once the Report Analysis tool combs the Sequence Report files, it compiles the data into a usable format 
and displays the results on the screen.  From this information, you make a determination whether the 
system should make changes to your open weld sequence file.  Table 5.5 explains the columns available in 
more detail. 
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Figure 5.2 Data to Include in the Weld Sequence File 

Table 5.5 Columns for Calculated Data 

Field Description 

Include Place a check mark in this option to add this data or validation to the open weld sequence 
file.  The Report Analysis tool automatically selects those rows that best match the 
parameters you have established based on the SD/Mean Limit (Coefficient of Variation); 
however, you can choose not to include those and include others.  

Step This is the step number displayed in the weld sequence.  You can find that number in the 
step’s title bar. 

 

Step Name This is the name of the step displayed in the weld sequence.  You can find that name in the 
step’s title bar. 

 

Function 
Type 

This column displays the type of sequence function from which this data was collected 
(e.g., a Display Picture function, a Review function or a Welding Function). 

Function 
Name 

This column displays the description of the function from the Name field of the Properties 
window. 
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Field Description 

Parameter In the Select function data to be included section, the Parameter column displays the data 
represented by the row (e.g., Estimated Time or Minimum Number of Welds). 

The Parameter column only appears on the Function Data tab. 

Weld 
Validation 

In the Select weld validations to be included section, the Weld Validation column indicates 
the calculated Weld Validation parameter represented by this column.  This is the Property 
that the Report Analysis tool will use in the weld validation if selected. 

The Weld Validation column only appears on the Weld Validation Data tab. 

Predicted 
Low Limit 

Based on the Average and SD columns calculated from the Sequence Reports (and taking 
into account the Prediction Range you set earlier), the Predicted Low Limit column displays 
the recommended value from the Report Analysis.  The Predicted Low Limit uses the 
following equation: 

𝐴𝑣𝑒𝑟𝑎𝑔𝑒 +  [(𝐿𝑜𝑤 𝑉𝑎𝑙𝑢𝑒 𝑓𝑜𝑟 𝑃𝑟𝑒𝑑𝑖𝑐𝑡𝑖𝑜𝑛 𝑅𝑎𝑛𝑔𝑒) ∗ 𝑆𝐷] 

STOP | This is the change that will be made to your weld sequence for this item when 
you click Apply Changes. 

TIP | The Predicted Low Limit column does not apply to some parameters like the 
Estimated Time parameter. 

Predicted 
High Limit 

Based on the Average and SD columns calculated from the Sequence Reports (and taking 
into account the Prediction Range you set earlier), the Predicted High Limit column 
displays the recommended value from the Report Analysis.  The Predicted High Limit uses 
the following equation: 

𝐴𝑣𝑒𝑟𝑎𝑔𝑒 + [(𝐻𝑖𝑔ℎ 𝑉𝑎𝑙𝑢𝑒 𝑓𝑜𝑟 𝑃𝑟𝑒𝑑𝑖𝑐𝑡𝑖𝑜𝑛 𝑅𝑎𝑛𝑔𝑒) ∗ 𝑆𝐷] 

STOP | This is the change that will be made to your weld sequence for this item when 
you click Apply Changes. 

TIP | The Predicted High Limit column does not apply to the WeldScore® parameter. 

Samples The Samples column displays the number of data points that were used to determine the 
Predicted Low Limit and Predicted High Limit values.  If an outlier was discovered during 
the analysis, this column indicates that.  For example, the Samples column could display 3 
of 4.  This means that one of the data points was removed due to the inconsistency of the 
data, based on the analysis parameters you set. 

Average The Average column displays the average value across the data points used. 

SD The SD column represents the standard deviation of the data for this property across the 
data points used for this analysis. 

Comments The Report Analysis tool adds any additional information in this column. 
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Chapter 6 

Sequence Functions 

On the left of the Weld Sequence Editor window, you have access to the tools you need to create your weld 
sequence—the Sequence Functions.  Sequence Functions are the building blocks of the welding operation.  
You add functions to the weld sequence that controls every aspect of the Welding Power Source and the 
welds the operator creates.  These functions help you define a consistent and repeatable process for the 
Weld Operator.  Each step that you create is actually a group of functions in the Weld Sequence Editor. 

TIP | As the Weld Sequencer application matures, more functions 
will become available. 

 

Figure 6.1 Sequence Functions 

Planning Your Weld Sequence 
Before you begin creating your weld sequence file, it is a good idea to think through the sequence first and 
make sure you have any work instructions you may need and/or a clear idea of the welding requirements 
and parameters you need for the welds the operator needs to perform. 

TIP | Sketching out the flowchart using the function names and 
their parameters before you begin could make it quick and 
easy to build the weld sequence file in the software. 
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Steps in a Weld Sequence 
Every time the Weld Operator clicks Next (or completes the welds in the step) in the Weld Sequencer, they 
move forward to a new step.  Each step could contain multiple instructions and series of functions, 
depending on the needs of the welds.  You create each step of the weld sequence in the Weld Sequence 
Editor (Figure 5.6). 

 

Figure 6.2 New Blank Weld Sequence File 

When you create a new weld sequence file (i.e., click New in the top toolbar), Weld Sequencer 
automatically adds at least three steps for you: 

 Start:  The Start step contains the Start function (page 6.1) and is where you can indicate if you 
want to perform a restore on the Welding Power Source. 

 Steps:  These are the steps in your weld sequence.  You can edit the steps (including renaming 
them) and you can insert additional steps above or below as needed for your sequence. 

 End:  The End step contains the End function (page 6.1) and is where you can choose to display a 
summary of the performance on the weld sequence after the Weld Operator completes it. 

Inserting/Deleting a Step 

Creating a step in Weld Sequence Editor is simple.  Right-click the left title area of any step already 
displayed in your Work Area and select one of the Insert options from the pop-up menu (Figure 6.3). 
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Figure 6.3 Inserting a Step 

You can insert a step above or below the current one.  Once you insert the step, you can drag-and-drop any 
function(s) you want to add to the step. 

Step Properties 

Weld Sequencer allows you to rename each step in the editor so you can easily tell your steps apart.  This is 
especially useful in the larger weld sequences that contain a large number of steps.  You can also disable 
navigation specifically for this step.  This is extremely useful when navigation generally needed but it must 
be disabled for a critical step that cannot be skipped.  Steps involving PLC communications typically use this 
option to temporarily disable navigation.  Refer to the Global Properties section on page 5.1 for more 
navigation options. 

 

Figure 6.4 Step Properties 

To access the properties for any step, simply double-click the left title area of the step.  The Properties 
window opens (Figure 6.4), Table 6.1 explains these fields in more detail. 

Table 6.1 Fields on the Step Properties Window  

Field Description 

Name Enter text in this field that helps you to distinguish this step from all the others in your 
weld sequence.  For example, you can create a step called “Setup” and another called 
“Tack Welds”.  Your “Review” step could contain an Approval function and the Review 
function. 

Navigation 
Disabled 

This option will disable Navigation on this Step.  When disabled, the Weld Sequencer will 
not allow the user to Navigate away from the Step.  This is very useful for Steps that 
contain PLC Functions, and Navigation needs to be disabled, but Navigation is desired for 
the remainder of the sequence steps.  The background of the left side Step name will 
change to grey and highlight when this option is used. 
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Field Description 

Estimated 
Time 

Weld Sequencer totals up all the estimated times you enter for each of the functions 
within the step and displays that total here.  If you need to change the estimated time, you 
should adjust the time on the appropriate function(s).  Weld Sequencer uses the total time 
for each step when it displays the Cycle Status and Step Status progress bars (Figure 7.2 on 
page 7.4). 

TIP | The Step Status  bar in Weld Sequencer turns yellow when the Weld 
Operator reaches 85% of the time you enter here.  See Table 7.1 on page 7.4 
for details on the Weld Sequencer display. 

Adding Functions to the Weld Sequence 
Adding functions to your weld sequence is simple.  Find the function you want to add from the list on the 
left.  Drag-and-drop that function into the appropriate step.  Double-click the function to open the 
Properties window and configure the function as needed.  Each function has different properties, and you 
can find information on each function starting on page 6.6. 

STOP | You MUST have a “First Function” identified in each step.  If 
you have a function at the beginning of the step without a 
blue border, right-click the function and select Make First 
Function from the pop-up menu. 

 

Figure 6.5 Adding a Function to the Sequence 

When you drag-and-drop the first function into a step, Weld Sequencer automatically turns the border of 
the function to blue and tags that function as the starting point in that step so the previous step knows 
which function to run first.  If you need to identify a different function, simply right-click the function and 
select Make First Function from the pop-up menu. 

TIP | Be sure your function is fully within the orange boundary.  
This ensures Weld Sequencer can detect the function as part 
of the correct step. 



Connecting and Validating Functions Chapter 6. Sequence Functions 

IM8003 Weld Sequencer User Manual 6.5 

Connecting and Validating Functions 
In order for Weld Sequencer to move in a path from the Start function to the End function and all the 
functions in between, you need to connect each function to the next one, always moving forward.  When 
possible, you need to also add conditions for possible outcomes to the function (e.g., what should Weld 
Sequencer do when welds do not pass validation or the user credentials for an Approval function are 
incorrect). 

          

Figure 6.6 Basic Connector and Conditional Connector 

Connecting Functions 

To connect a function to another function, simply hover you mouse over one of the handles until the cursor 
changes to a crosshair, click and drag a line to the function you want to occur next and release it.  Once you 
release the connector, it turns into an arrow that indicates the direction in which the weld sequence will 
run from function to function.  The connector essentially becomes “glued” to each function and remains 
glued until you delete the connector or function(s). 

 

Figure 6.7 Connecting Functions 

Conditional Connectors 

There are some functions that provide you with the option to validate the outcome of the function based 
on conditions you can set (e.g., Weld functions and the Approval function).  Weld Sequencer automatically 
detects the decision-making capabilities for the function.  If you have the option to validate the function, 
the connector changes to green (Figure 6.8).  Double-click the connector to configure the validation settings 
for that function. 

TIP | Hover your mouse over a conditional connector between two 
functions, to display the current validation rules. 
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Figure 6.8 Green Validation Connector 

For more information on the validation for specific functions, refer to the following sections:  

 Approval function (page 6.22) 

 Welding functions (page 6.33) 

 Database functions (page 6.39) 

 PLC functions (page 6.49) 

Start and End Functions 
Every weld sequence file launched by a Weld Operator must have a Start function and an End function.  
When you click the New button in the top toolbar, Weld Sequence Editor adds them to the sequence 
automatically to help you out (Figure 5.6 on page 6.2). 

Start 

The Start function gives the Weld Sequencer a defined beginning and dictates if you want to 
perform a restore on the Welding Power Source that runs the weld sequence file before the rest 
of the sequence gets under way. 

 

Figure 6.9 Start Function in the Editor 

Table 6.2 Properties Available for the Start Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the 
Weld Sequence Editor.  This helps you easily identify the function within the step. 

Restore Out-of-
Limit and Wire 
Package Settings 

Place a check mark next to this option to change the Welding Power Source to match 
the Wire Package settings from Global Properties on the weld sequence file.  Once 

the Weld Operator loads the weld sequence file and clicks the Start button , the 
Wire Package settings on the Welding Power Source change to match these settings. 
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End 

Every weld sequence must have an end.  The End function indicates to the Welding Power Source 
that there are no more functions to come in this weld sequence.  It displays a summary to the 

Weld Operator (Figure 6.10); the Cycle Timer  stops; and the Weld Operator can quickly launch 

into the loaded weld sequence again for the next assembly.  Table 6.3 explains the properties available on 
the End function.  (See page 7.3 for more details on the right information panel in Figure 6.10.) 

 

Figure 6.10 End Function 

Table 6.3 Properties Available for the End Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Seconds To 
Pause 

For use with the Auto Restart preference in the Weld Sequencer workstation preferences 
(page 7.7), the Seconds To Pause field allows you to set a delay time before the sequence 
automatically begins again.  The Cycle Time stops when the sequence stops, but you can 
have the sequence pause for any length of time (in seconds) before the Auto Restart 
activates.  The system does not include the pause time in the Cycle Time. 

TIP | If you have a check mark in the Show Display option in conjunction with a value in 
the Seconds To Pause field, the sequence displays the performance summary 
information during this pause time. 

Show Display Place a check mark in this checkbox to display the performance summary for the sequence 
(Figure 6.10) to the Weld Operator in the Weld Sequencer.  If you do not want or need to 
display this information to the operator, remove the check mark.  
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Field Description 

Logout Place a check mark in the Logout checkbox if you would like Weld Sequencer to 
automatically log the user out of the application at the end of the weld sequence. 

Alert 
The Alert function allows you to communicate with the Weld Operator.  This is a simple message 
that displays on the screen along with a Continue button and prevents the Weld Operator from 
proceeding until they acknowledge the message.  The system also displays additional information 

based on validations that caused the Alert to display.  There are many uses for the Alert function, including 
providing important information or instruction.  Table 6.4 explains the properties available for the Alert 
function. 

 

Figure 6.11 Alert Function 

For example, after each welding function on a tricky assembly, John at Advanced Manufacturing added an 
Alert function to the weld sequence that displays an alert in Weld Sequencer if the weld exceeds the 
duration limits set on the weld.  The Alert informs the Weld Operator that they must obtain a quality 
inspection before they can continue welding, as well as which validations failed.  In Figure 6.11, the Weld 
Operator performed one weld.  The validation on the weld was that it needed to be greater than or equal 
to 1.2 seconds, and the weld had to be less than or equal to 1.8 seconds. 

The Alert displayed because the weld performed by the operator failed validation.  The weld failed because 
the duration was 2.4 seconds (longer than 1.8 seconds).  Weld Sequencer highlights the failures in red.  The 
weld passed the first validation because it was longer than 1.2 seconds. 



Consumable Weight Chapter 6. Sequence Functions 

IM8003 Weld Sequencer User Manual 6.9 

TIP | If there had been four welds the operator needed to perform, 
and the duration on each of the welds was too short, there 
would be four sets of notifications. 

Once the Weld Operator clicks Continue on the alert in Weld Sequencer, John has the sequence display the 
Approval function (page 6.22), requiring a Quality Manager to sign in to unlock the sequence and allow the 
operator to continue. 

Table 6.4 Properties Available for the Alert Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Message 
Box 

The text in the Title field and the Description field comprise the alert message that appears 
on the screen for the Weld Operator. 

 Title:  The text in the Title field appears first in the alert message for the Weld 
Operator.  See Figure 6.11. 

 Description:  The text in the Description field appears after the text from the Title 
field.  This is the specific information you want to communicate to the Weld 
Operator. 

Sound File The Sound File field allows you to play a sound when the weld sequence reaches this alert.  
This helps you get the attention of the Weld Operator so they look at the computer screen.   
Click the Browse button and navigate to the sound file you want to use. 

STOP | Be sure that the computer running the Weld Sequencer has access to the 
location of this sound file.  If it does not, the sound file will not play for the Weld 
Operator.  Also, be sure that the computer has speakers that are loud enough for the 
Weld Operator to hear over the noise in the production area. 

TIP | You can drag-and-drop a sound file from outside the Weld Sequence Editor 
application, right onto the Alert function.  Be sure that you have already added the 
function to the sequence and that you have saved the weld sequence file before you drag-
and-drop. 

Consumable Weight 
Before a welding job begins, you want to make sure that there is currently enough consumable 
loaded for the wire feeder to complete the job.  This will help prevent the Weld Operator from 
stopping in the middle of the weld sequence to load the wire feeder. 



Chapter 6. Sequence Functions Consumable Weight 

6.10 Weld Sequencer User Manual IM8003 

 

Figure 6.12 Consumable Weight Function 

When you add the Consumable Weight function to the weld sequence, Weld Sequencer displays a message 
to the Weld Operator listing the consumable weight required for the job and the weight currently loaded 
(Figure 6.12).  The message gives the Weld Operator the option to replenish the consumable now or to click 
continue without replacing. 

NOTE | If the user clicks the Previous  or Next  buttons instead 
of the Continue button, Weld Sequencer flags the sequence 
with an error. 

Table 6.5 Properties Available for the Consumable Weight Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Required 
Weight 

Enter the amount of consumable needed to complete the weld sequence in its entirety.  
The system checks this requirement with the amount currently loaded for the Welding 
Power Source. 

If the amount required is more than what is available on the power source, this function 
provides the Weld Operator with the ability to continue with the amount currently loaded 
or to replace the consumable (Figure 6.12). 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 
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Decision 
The Decision function allows you to forward the weld sequence based on one of the available 
properties on the connector from the function, in addition to any available conditions you used 
when exiting the previous function.  Table 6.6 explains the options available on the conditional 

connector from the Decision function. 

For example, John at Advanced Manufacturing wants a quality manager to approve the welding if the Weld 
Operator makes any welds in Manual mode.  If there aren’t any manual welds, he wants to allow the 
welder to continue seamlessly. 

In Figure 6.14, John added two functions after his welding function:  Decision and Approval.  He connected 
the Welding function to the Decision function.  Then he connected the Decision function to the Approval 
function.  On this connector, he set the property to Manual Weld Count > 0.  If there are any welds made in 
manual mode, the weld sequence will display the Approval function.  He also added a connector from the 
Decision function to the next step in the case where there are no manual welds:  Manual Weld Count = 0. 

 

Figure 6.13 Example Use of Decision Function 

NOTE | Remember:  You must set an exit connector for each condition 
(e.g., one for a True result and one for a False result). 

 

Figure 6.14 Decision Function Connector 

Table 6.6 Properties Available for the Decision Function Conditional Connector 

Property Description 

Automatic 
Weld Count 

The Automatic Weld Count property allows you to run specific functions based on the 
number of welds performed in Automatic mode.  See Automatic mode on page 7.6. 
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Property Description 

Manual Weld 
Count 

The Manual Weld Count property allows you to run specific functions based on the 
number of welds performed in Manual mode.  Read more about Manual mode on page 
7.6. 

Sequence 
Errors 

If you want to perform a specific function when sequence errors occur, you can use the 
Decision function to direct the weld sequence. 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 

Display HTML 
If you need to show the Weld Operator a web page, whether internal or external, the Display HTML 
function allows you to display that page during the weld sequence.  The only difference between 
the Display Picture function (page 6.13) and the Display HTML function is that instead of specifying 

an image path, you specify a URL path. 

STOP | When you use the Display HTML function, the computer 
running Weld Sequencer must have access to that file’s 
location on the network or on the Internet.  It cannot display 
the file if it cannot access it. 
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Figure 6.15 Display HTML 

In the URL field, simply type the URL address of the HTML you want to display.  Be sure to have all 
characters in the address correct, including “https” versus “http” if applicable.  If in doubt about the correct 
format for the file’s location, contact your local IT department.  

Here are a few examples: 

https://www.osha.org/law-regs.html 

http://www.oursite.com/example.html 

Display Picture 
One of the most useful features of Weld Sequencer is the ability to show a Weld Operator an 
example of each weld you want them to make (Figure 6.16).  This can help them place the welds on 
the assembly consistently and in the proper order.  You can insert the Display Picture function 

before each welding function and show the progression of welds with each new picture.   You could also use 
the Display Picture function in a variety of other ways.  You can display any standard image format, as well 
as play audio files with the image.  Table 6.7 explains the properties for the Display Picture function. 

TIP | In the Weld Sequence Editor, right-click the Display Picture 

function in your sequence (e.g., Figure 6.13 on page 6.11) and 
select Show Image from the pop-up menu to see a preview of 
the image file attached to the function. 
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Figure 6.16 Display Picture Function 

For example, John at Advanced Manufacturing inserted a Display Picture function before the “Tack Welds” 
Weld function to show a picture of where to place the two tack welds (Figure 6.16).  On all pictures in the 
sequence, he circled the welds on the current step and added text on the expected length of the weld, as 
well as the Weld Mode being used. 

STOP | When you use the Display Picture function, the computer 
running Weld Sequencer must have access to that file’s 
location on the network.  It cannot display the file if it cannot 
access it.  This is a great reason to have a common server 
folder for your Weld Sequencer files. 

Table 6.7 Properties Available for the Display Picture Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the 
Weld Sequence Editor.  This helps you easily identify the function within the step. 

Image Path Click the Browse button to navigate to the image file you want to display when Weld 
Sequencer reaches this function in the sequence.  Remember, the computer running the 
weld sequence file on the production floor must have access to this image file over your 
network.  You can use the following types of files:  *.png, *.jpg or *.gif. 

TIP | You can drag-and-drop an image file from outside the Weld Sequence Editor 
application, right onto the Display Picture function.  Be sure that you have already 
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Field Description 

added the function to the sequence. 

Sound File If you would like to play a sound file when the sequence displays the picture to the Weld 
Operator, click the Browse button and navigate to the sound file.  You can use this sound 
file to get the attention of the Weld Operator so they look at the computer screen, or to 
offer a brief explanation of the welds to be performed. 

STOP | Be sure that the computer running the Weld Sequencer has access to the 
location of this sound file.  If it does not, the sound file will not play for the Weld 
Operator.  Also, be sure that the computer has speakers that are loud enough for the 
Weld Operator to hear over the noise in the production area. 

TIP | You can drag-and-drop a sound file from outside the Weld Sequence Editor 
application, right onto the Display Picture function.  Be sure that you have already 
added the function to the sequence. 

Hide in Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 

Wait for 
Continue 
Action 

If you need to make sure that a Weld Operator looks at the picture you have displayed 
(e.g., a setup picture or a safety reminder to wear their safety glasses), you might want 
to give them time to acknowledge they have seen the image, to put on their safety 
glasses, or to set up the part. 

When you place a check mark next to Wait for Continue Action, Weld Sequencer keeps 
the display active until the operator clicks the Continue button (or uses two quick trigger 
pulls), rather than allowing Weld Sequencer to advance automatically.  

STOP | If the user clicks the Previous  or Next  buttons instead of the Continue 
button, Weld Sequencer flags the sequence with an error. 

TIP | There is no Continue button unless you use the Wait for Continue Action button.  
Weld Sequencer adds the Continue button to the display for the Weld Operator with 
this option. 

Seconds To 
Pause or 
Estimated 
Time 

The Seconds To Pause field allows you to set a delay time before executing the next 
function in the sequence.  This field is useful if you need to show a progression of images 
before the welding function begins. 

If you place a check mark in the Wait for Continue Action checkbox, this field changes to 
Estimated Time, which is how long you think it should take for someone to review and 
acknowledge the displayed image.  Weld Sequencer uses this time in the Cycle Status so 
be sure to provide ample time for a person to review and understand the picture and 
then to acknowledge the picture. 

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld 

Operator reaches 85% of the estimated time you enter here.  This alerts the operator 
that time is running out.  See Table 7.1 on page 7.4 for details on the Weld Sequencer 
display. 
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Display Video 
There are some welding operations that are easier to explain by demonstrating the process, rather 
than displaying a series of pictures.  The Display Video function is similar to a Display Picture 
function except you can launch a video instead of displaying a static image during the weld 

sequence. 

STOP | When you use the Display Video function, the computer 
running Weld Sequencer must have access to that file’s 
location on the network or on the Internet.  It cannot run the 
file if it cannot access it. 

 

Figure 6.17 Display Video Function 

Table 6.8 Properties Available for the Display Video Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Video Path Click the Browse button to navigate to the video file you want to play when Weld Sequencer 
reaches this function in the sequence.  Remember, the computer running the weld 
sequence file on the production floor must have access to this video file over your network.  
You use the following types of files:  *.avi, *.asf, *.wma, *.wmv, and *.wm. 

Hide in 
Review 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown in 
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Field Description 

Function the Review Function list. 

Wait for 
Continue 
Action 

If you want to provide the Weld Operator enough time to view the video and even replay it 
when necessary, you can use the Wait for Continue Action option.  When you place a check 
mark next to Wait for Continue Action, Weld Sequencer loops the video until the operator 
clicks the Continue button (or uses the trigger options to advance), rather than allowing 
Weld Sequencer to advance automatically. 

STOP | If the user clicks the Previous  or Next  buttons instead of the Continue 
button, Weld Sequencer flags the sequence with an error. 

NOTE | Remember to enter an Estimated Time if you choose this option. 

TIP | There is no Continue button unless you use the Wait for Continue Action button.  
Weld Sequencer adds the Continue button to the display for the Weld Operator with this 
option. 

Estimated 
Time 

Weld Sequencer enables the Estimated Time fields when you place a check mark in the Wait 
for Continue Action option. 

The Estimated Time field is how long you think it should take for someone to view this video 
and click the Continue button.  Weld Sequencer uses this time in the Cycle Status (Table 7.1 
on page 7.4) so be sure to provide ample time for a person to watch the entire video (replay 
it if necessary) and click the Continue button. 

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld Operator 
reaches 85% of the time you enter here.  This alerts the operator that time is running out.  
See Table 7.1 on page 7.4 for details on the Weld Sequencer display. 

Field Entry 
To help increase the traceability of your parts and welds, you can insert the Field Entry function 
into your weld sequence anywhere you need to capture one of two IDs:  Consumable Lot and Part 
Serial Number.  When you use the Field Entry function, Weld Sequencer displays an input screen to 

the Weld Operator (Figure 6.18), and you can configure the text on the input screen to meet your needs. 
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Figure 6.18 Field Entry Function 

The Weld Operator must enter the requested information (Figure 6.18) and press Enter, or the software 
flags the sequence with an error.  Weld Sequencer adds the entered information to the Welding Power 
Source for increased traceability. 

NOTE | Weld Sequencer clears the part serial number at the end of 

the sequencer to ensure the software does not use an old or 
“left over” serial number for new sequences (new parts). 

 

TIP | You can use the Field Appender function (page 6.20) to attach 
an additional identifier to the end of the ID number to 
increase the granularity of the part’s traceability. 

Table 6.9 Properties Available for the Field Entry Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 
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Field Description 

Title The text that you enter in the Title field displays in the Weld Sequencer first on the screen 
when the Weld Operator reaches this function (e.g., “Serial Number” in Figure 6.18). 

NOTE | When you use the Clear Value option, this field is disabled since there is no 
display to the Weld Operator in Weld Sequencer. 

Description The text you enter in the Description field displays in the Weld Sequencer after the text 
from the Title field (e.g., “Enter the Upper Base Boom Serial Number:” text in Figure 6.18). 

NOTE | When you use the Clear Value option, this field is disabled since there is no 
display to the Weld Operator in Weld Sequencer. 

Type Weld Sequencer needs to know which number you are asking the Weld Operator to enter 
in order to save the number properly.  From the Type drop-down, select which ID number 
this function represents:  Consumable Lot Code or the Part Serial Number.  You will see 
this number in reports in CheckPoint™. 

Wire Feeder If you have a weld sequence that requires a Dual Head wire feeder, select which wire 
feeder this function represents. 

Load From You use the Load From field in conjunction with the Create Record or the Select Record 
functions (page 6.39).  The Load From field allows you to pull data from the Work Item 
table in the Weld Sequencer database that was created with the Database functions.  The 
Field Entry function then sends that data to the Welding Power Source as the type you 
specify in the Type field.  Simply select the column in the Load From drop-down from 
which you would like to pull data. 

For example, John at Advanced Manufacturing has a weld sequence file for a vehicle that 
consists of several sub-assemblies with their own serial numbers.  John wants the operator 
to scan in the vehicle serial number and each of the serial numbers for the sub-assemblies 
to build that record in the Weld Sequencer database.  He has used a Create Record 
function in the sequence to create this record.  (See page 6.39 for more details on using 
Database functions.) 

Now, rather than using the Field Entry function to request the Weld Operator to enter the 
vehicle’s serial number a second time to send the data to CheckPoint™, John just wants to 
pull the number already entered and pass it to CheckPoint™. 

So, since the vehicle’s record is currently active, John selects Field 1 from the Load From 
drop-down since Field 1 contains the vehicle serial number he wants to use as the serial 
number for the welds. 

NOTE | When you use the Load From option, Weld Sequencer does NOT display an 
entry field to the Weld Operator. 

Clear Value The Clear Value checkbox allows you to create a function that clears the existing 
Consumable Lot Code or Part Serial Number currently entered on the Welding Power 
Source.  This is especially helpful to add at the end of a weld sequence so future weld 
records from this Welding Power Source do not contain any “leftover” values.  

NOTE | When you use the Clear Value checkbox, the Weld Operator does not see a 
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Field Description 

display in the Weld Sequencer.  The activity occurs behind the scenes. 

Place a check mark in the Clear Value checkbox and select the field you want to clear from 
the Type drop-down.  When the Weld Operator runs this weld sequence file and reaches 
this function, the sequence removes the selected data. 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 

Estimated 
Time 

The Estimated Time field is how long you think it should take for someone to find the 
appropriate ID and enter it into Weld Sequencer.  Weld Sequencer uses this time in the 
Cycle Status (Table 7.1 on page 7.4) so be sure to provide ample time for a person to 
locate the consumable lot code or part serial number and come back to the computer to 
enter the data. 

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld Operator 
reaches 85% of the time you enter here.  This alerts the operator that time is running 
out.  See Table 7.1 on page 7.4 for details on the Weld Sequencer display. 

Field Appender 
You can use the Field Appender function to add an identifier to the consumable lot code or part 
serial number to help you identify individual welds.  Many companies have a single part serial 
number for all pieces of a part for example.  The Field Appender allows you to label the specific 

welds for increased traceability.  The appended text becomes part of the Consumable Lot and Part SN fields 
in CheckPoint™. 

TIP | You can use this function in conjunction with the Field Entry 
function as well (page 6.16) and add identifiers to the data 
entered by the Weld Operator. 

 

Figure 6.19 Field Appender Properties 

NOTE | The Field Appender remains in effect until you use another 
Field Appender function to change it or the sequence ends, 
whichever comes first. 

For example, in Figure 6.20, John at Advanced Manufacturing has created a weld sequence file for an 
engine cradle that includes 14 different welds.  There is one part serial number for the engine cradle; 
however, John wants to be able to identify every one of those welds individually.  
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John has already added the Field Entry function at the beginning of the sequence to prompt the Weld 
Operator for the part serial number in Weld Sequencer.  Before the Weld function of each weld in Weld 
Sequence Editor, he includes the Field Appender function and tells the system to add specific text to the 
end of the part serial number that was entered by the Weld Operator: 

 Before the Weld function for the first weld, John adds the Field Appender function and types a 
hyphen “-“ and a “1” in the Text property:  -1 

 He adds a Field Appender function before the Weld function for the second weld and types a 
hyphen “-“ and a “2” in the Text property:  -2 

 And so on for all 14 welds, changing the numbers accordingly. 

 

Figure 6.20 Example of Using Field Appender Function 

Table 6.10 Properties Available for the Field Appender Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Type Weld Sequencer needs to know to which number you want to append the text you enter in 
the Text field.  From the Type drop-down, select the data you want to append. 

Wire 
Feeder 

If you have a weld sequence that requires a Dual Head wire feeder, select which wire feeder 
this function represents. 

Text Enter the letters, numbers or special characters (either a hyphen or an underscore) that you 
want the system to tack on to the end of the ID number selected in the Type field. 

For example, John at Advanced Manufacturing wants to add a dash ( - ) and a 1 after the part 
serial number for the first weld in the sequence.  Before the first Weld function, he inserts the 
Field Appender function and types the following in the Text field:  -1 
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Field Description 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown in 
the Review Function list. 

Goto Step Function 
For large sequences with a large number of steps and the need to jump to a distant step, the Goto 
Step function allows you to go directly to that later step without a long connector.  You can identify 
the target step using the unique step name. 

 

Figure 6.21 Goto Step Function 

Table 6.11 Properties Available for the Goto Step Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Step 
Name 

Enter the name of the step to which you want the sequence to jump.  This step name should 
be unique across the weld sequence.  If the step name you use is not unique, Weld Sequencer 
jumps to the first instance of that step name.  For example, if you have multiple steps with 
the default step name “New Step”, Weld Sequencer uses the first step with that name.  

NOTE | Be sure to use the step name.  The Goto Step function does not recognize the step 
number. 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown in 
the Review Function list. 

If approval is required for the Goto Step option, select the level of approval from the Global Properties 
window. Refer to Chapter 5 Global Properties. 

Approval 
With the Approval function, you can specify the type of User Role that is required to login at this 
point in your weld sequence before the weld sequence can go any farther.  Weld Sequencer 
disables all navigation buttons (i.e., Previous, Next, Goto Step, etc.) until a user logs in.  You can 

use the function to incorporate a quality check or manager approval into your weld sequence.  
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Figure 6.22 Approval Function 

For example, once the Weld Operator completes all the welds in the sequence, John at Advanced 
Manufacturing wants their Quality Control Manager to log in to Weld Sequencer and review any welds that 
did not pass validation during the sequence.  In Weld Sequence Editor, John adds the Approval function 
before the Review function (Figure 6.22).  In Weld Sequencer, this forces the Quality Control manager to 
login and complete the review step (page 6.24) before the Weld Operator can continue. 

When you connect the Approval function with another function, you need to specify if Weld Sequencer 
should take this path if the user logging in has the correct user role or if the user logging in does not have 
the correct user role.  You do this using the properties on the connector.  Simply double-click the connector 
and set the validation. 

 

Figure 6.23 Validation on Approval Function 

For example, in Figure 6.23, John at Advanced Manufacturing wants a Quality Manager to log in to review 
and approve the welds made by the Weld Operator.  If the user who logs into this function in Weld 
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Sequencer does not have the Administrator role, John still wants Weld Sequencer to display the Review 
function, but he doesn’t want that user to change any of the statuses. 

On the connector to the first Review function in Weld Sequence Editor (the one for the Quality Manager 
where there is a check mark next to Allow Editing), he selected Correct User Role = True.  On the connector 
to the second Review function (with no check mark next to Allow Editing), he selected Correct User Role = 
False.  (See page 6.24 for details on the Review function and the Allow Editing checkbox.) 

Table 6.12 Properties Available for the Approval Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Description The text you enter in the Description field appears in the Weld Sequencer with the user 
name and password fields for the login.  You can use this text to help guide your Weld 
Operator with what to do next. 

For example, once all the welds in the sequence are complete, John at Advanced 
Manufacturing wants their Quality Control Manager to log in to Weld Sequencer and 
review any welds that didn’t pass validation during the sequence.  In Weld Sequence 
Editor, John enters the following text in the Description field for the function:  Contact a 
Quality Control Manager to log in and review. 

Role Select the user role for the type of user you want to login.  Only a user with the selected 
user role on their user account can log in at this step of the weld sequence.  See page 3.1 
for more details on user roles and accounts. 

TIP | When an approver user logs in to the Approval function, Weld Sequencer records 
that username in the Sequence Reports. 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 

Estimated 
Time 

The Estimated Time field is how long you think it should take for someone to log in with 
their username and password.  Weld Sequencer uses this time in the Cycle Status (Table 
7.1 on page 7.4) so be sure to provide ample time for the appropriate personnel to be 
located and then log in, if different from the Weld Operator.  

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld Operator 
reaches 85% of the time you enter here.  This alerts the operator that time is running 
out.  See Table 7.1 on page 7.4 for details on the Weld Sequencer display. 

Review 
The Review function is a Quality Control measure.  It displays a list of all the steps in the weld 
sequence up until the point of the Review function and whether they passed or failed validation.  
Typically, you add this to the end of the weld sequence.  You also have the option to set up a 

conditional exit out of the Review function based on whether or not there were any errors during the 
sequence. 
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NOTE | If the user clicks the Previous  or Next  buttons instead 
of the Continue button, Weld Sequencer flags the sequence with an 
error. 

Review Function 

Once a Weld Operator completes the weld sequence, you can display the Review function so either the 
Weld Operator or a manager can review the validation on all steps in a sequence.  They can review any 
welds that failed and either approve them or deal with them appropriately.   To change the status of a step, 
the user simply selects Pass or Fail from the drop-down.  Some functions are hidden from the Review list as 
they relate to running the sequence and not actual welding (e.g., the Display Picture function, the Alert 
function, or the option to hide the function has been selected).  Table 6.13 explains the properties available 
for the Review function. 

 

Figure 6.24 Review Function 

TIP | See page 5.3 for details on how to set up the torch trigger to 
work as the Continue button on the Review function. 
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TIP | For more stringent quality control measures, you can 
implement this function along with the Approval function 
to force a manager to log in and review the welds 
produced using this weld sequence before the Weld Operator 
can continue. 

Table 6.13 Properties Available for the Review Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Allow 
Editing 

The Allow Editing checkbox allows you to choose whether or not you want to allow the 
current user to change the Status drop-down on the steps.  This is especially helpful if you 
simply want to display a read-only review step. 

If you decide to use the Review function in conjunction with the Approval function, you can 
choose to display the read-only version for a user without the appropriate user role and an 
editable version for the correct user (Figure 6.23 on page 6.23). 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown in 
the Review Function list. 

Estimated 
Time 

The Estimated Time field is how long you think it should take for someone to complete the 
review process on this weld sequence.  Weld Sequencer uses this time in the Cycle Status 
(Table 7.1 on page 7.4) so be sure to provide ample time for a person to read through each 
failed step and verify the quality of the assembly. 

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld Operator 

reaches 85% of the time you enter here.  This alerts the operator that time is running out.  
See Table 7.1 on page 7.4 for details on the Weld Sequencer display. 

Review Function Exit Conditions 

When you connect the Review function to the next function in the sequence, the connector turns green.  
This indicates that you made a decision based on whether or not there were any errors during the 
sequence. 
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Figure 6.25 Connector Options on the Review Function 

When you double-click the green connector, you can make the following conditions using the drop-downs 
on the Conditional Connection Properties window (Figure 5.6): 

 Sequence Errors = True means that if there are sequence errors (steps that display the word 
“Fail” on the Review display), this is the route the sequence should take. 

 Sequence Errors = False means that if there are no sequence errors (all steps display the word 
“Pass” on the Review display), this is the route the sequence should take. 

For example, John at Advanced Manufacturing added a Review function for the Weld Operator at the end 
of the sequence.  He added the Sequence Error conditions to the green connectors so that: 

 If there were sequence errors (i.e., Sequence Errors = True), the sequence would display an 
Approval function that requires a Quality Manager to come over, discuss the problems with the 
Weld Operator and then log in to allow the Weld Operator to continue.  

 If there were no sequence errors (i.e., Sequence Errors = False), the sequence simply skips the 
Approval function and allows the Weld Operator to continue to finish the sequence.  

 

Figure 6.26 Example Use of Review Exit Conditions 

Welding Functions 
The heart of a weld sequence is, of course, the welding.  With the welding functions, you dictate how many 
welds to perform, which Weld Profile to use, how to validate the welds and which weld procedures to use.  
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There are several functions available for welding that you can insert into your sequence, depending on the 
needs of your weld operation: 

 Weld (page 6.28):  The standard Weld function is a standard specification for the welds in a 
specific step of the weld sequence.  There are a strict number of welds the Weld Operator must 
perform, with no variance allowed in the number of welds performed. 

 Weld Accumulator (page 6.29):  The Weld Accumulator function provides flexibility in the 
number of welds that can be made in order to complete the operation (e.g., to accommodate 
various experience levels of Weld Operators). 

 Weld Open (page 6.31):  The Weld Open function accommodates variable parts and non-
standard welds (such as welding over a gap in a part) in the weld sequence where it is difficult to 
predict the number of welds needed to perform the weld.  You do, however, need to define the 
minimum and maximum number of welds. 

TIP | If a weld sequence has the User Limits feature enabled, the 
weld operator can adjust the settings on the power source 
before making a weld.  After adjusting the settings, please 
wait 10 seconds before completing the weld to allow the weld 
operator’s settings to be saved. 

Weld Function 

When you have a specific number of welds that must be performed, where the Weld Operator 
cannot make any more or any fewer welds, you can use the Weld function to dictate the precise 
number of welds the Weld Operator must perform.  The system tracks welds by counting the arc 

starts and stops.  If the Weld Operator does not perform the specified number of welds, the sequence is 
flagged with an error.  See page 6.34 for details on validating welds within the function and page 6.33 for 
details on specifying procedures for the feed head(s). 

 

Figure 6.27 Weld Function Properties 

To add welds to your weld sequence, drag-and-drop the Weld function to your weld sequence, enter the 
number of welds and other properties (Table 6.14); select the weld procedures (page 6.33); and select the 
validation properties (page 6.34). 

Table 6.14 Properties Available for the Weld Function 

Field Description 
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Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Number of 
Welds 

Enter the number of welds you need to perform with this function.  This is the number of 
arc starts that Weld Sequencer must sense before continuing to the next function.  See page 
6.33 for details on adding validation to your Weld function. 

NOTE | Remember, if you use multiple welds with the same Weld function, all settings 
and the Weld Profile are used for all welds.  For example, if you need two welds with 
different characteristics, you need to add two separate Weld functions to your sequence. 

Weld 
Profile 

Enter the number for the Weld Profile you want the Welding Power Source to use for all of 
the welds in this function.  This Weld Profile determines the welding limits for the welds.  
For in-depth details on Weld Profiles, please refer to the Power Wave® Manager User 
Manual (IM8002). 

STOP | Be sure that the Weld Profile on the Welding Power Source contains the settings 
you want to use for this weld.  For example, each Welding Power Source has a Weld 
Profile 4; however, the profile limits set on each machine’s Profile 4 could be different. 

TIP | You can use the Weld Profiles field to ignore short welds.  See page B.7 for more 
information. 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown in 
the Review Function list. 

Estimated 
Time 

The Estimated Time field is how long you think it should take for someone to complete all 
the welds you have listed in this function.  Weld Sequencer uses this time in the Cycle Status 
(Table 7.1 on page 7.4) so be sure to provide ample time for a person to make the weld(s), 
reposition the part if needed and carry out other behaviors that go into making the weld(s).  

STOP | The Estimated Time is NOT ONLY arc-on time.  It also includes non-welding time 
involved in completing the welds. 

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld Operator 

reaches 85% of the time you enter here.  This alerts the operator that time is running out.  
See Table 7.1 on page 7.4 for details on the Weld Sequencer display. 

Weld Accumulator Function 

If you have a weld operation that requires a little flexibility in the number of welds (or arc starts) 
that can be made in order to complete the operation, the Weld Accumulator function provides that 
flexibility.  For example, those weld operations that an experienced welder can complete with a 

single weld, but a new welder may take two or three welds (e.g., welding around a circle), you can insert 
the Weld Accumulator function into your weld sequence. 
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Figure 6.28 Weld Accumulator Function 

With the flexibility of the Weld Accumulator function, you end the function based on the Minimum Number 
of Welds, Minimum Deposition and Maximum Deposition fields.  These are the total amounts for the entire 
function.  You VALIDATE those welds by the choice(s) you make on the Weld Validation tab and on the 
connectors you add to the next function in the sequence. 

For example, Ron at Advanced Manufacturing has been welding for 20 years.  He’s a very competent and 
experienced welder.  David, on the other hand, has only been welding for a few months and isn’t quite as 
skilled. 

The weld operation they each need to accomplish is a circular weld with a minimum of two welds and a 
minimum deposition of 0.15 lbs. (but a maximum of 0.20 lbs.).  At Ron’s skill level, he can perform this weld 
operation in two welds, meeting the weld quantity and deposition requirements.  David, however, needs 
the flexibility to complete that weld operation in more welds. 

Since the wire deposition on David’s second weld is still below the minimum set in the weld sequence, he is 
allowed to continue without flagging the step with an error and finish the weld operation with a third weld 
that brings the total deposition above the minimum (and of course, below the maximum). 

Table 6.15 Properties Available for the Weld Accumulator Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Minimum 
Number 
of Welds 

Enter the minimum number of total welds that it takes to complete this welding operation.  
Weld Sequencer uses this field, along with the Minimum Deposition and Maximum 
Deposition fields, to determine when to exit the function.  If a Weld Operator attempts to 
advance to the next step without making at least this many welds, Weld Sequencer 
displays a red border and flags the step with an error.  In the Review function, this step 
would show as failed. 

Accumulate 
From 

You can choose to determine weld accumulation by Deposition or by Arc Time.  The 
Minimum and Maximum fields allow you to specify the acceptable upper and lower limits 
for: 

 Deposition:  The total amount of material it takes to complete this welding 
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Field Description 

operation.  Or, 

 Arc Time:  The total amount of arc time it takes to complete this welding 
operation. 

This helps to determine when the function ends, in conjunction with the Minimum 
Number of Welds field. 

For example, in Figure 6.28, if David at Advanced Manufacturing completed three welds 
(which was above the defined Minimum Number of Welds) and the total amount of 
material he deposited for the welds was above the amount defined in the Minimum 
Deposition field, the function would be completed and the next function would start to 
execute. 

Weld Profile Enter the number for the Weld Profile you want the Welding Power Source to use for all of 
the welds in this function.  This Weld Profile determines the welding limits for the welds.  
For in-depth details on Weld Profiles, please refer to the Power Wave® Manager User 
Manual (IM8002). 

STOP | Be sure that the Weld Profile listed on the Welding Power Source contains the 
settings you want to use for this weld.  For example, each Welding Power Source has a 
Weld Profile 1; however, the profile limits set on each machine’s Profile 1 could be 
different. 

Enable 
Continue 
Action 

Enabling this option controls the completion of the function by displaying a Continue 
button instead of exiting the function after the Minimum Number of Welds and the 
Minimum Accumulation have been met. Additional welds can be made until the Maximum 
Accumulation is reached or the operator Continues to the next function. 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 

Estimated 
Time 

The Estimated Time field is how long you think it should take for someone to complete all 
the welds you have listed in this function.  Weld Sequencer uses this time in the Cycle 
Status (Table 7.1 on page 7.4) so be sure to provide ample time for a person to make the 
weld(s), reposition the part if needed and carry out other behaviors that go into making 
the weld(s). 

STOP | The Estimated Time is NOT ONLY arc-on time.  It also includes non-welding 
time involved in completing the welds. 

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld Operator 

reaches 85% of the time you enter here.  This alerts the operator that time is running 
out.  See Table 7.1 on page 7.4 for details on the Weld Sequencer display. 

Weld Open Function 

When you need to include a welding function that accommodates variable parts and non-standard 
welds (such as welding over a gap in a part), you can use the Weld Open function.  The Weld Open 
function allows the Weld Operator to make necessary adjustments to complete the weld(s).  Those 

welds must be within the minimum and maximum range that was set for the welding operation.  Table 6.16 
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explains the properties for the Weld Open function in more detail.  See page 6.33 for details on validating 
welds within the function and page 6.33 for details on specifying procedures for the feed head(s). 

 

Figure 6.29 Weld Open Properties 

Once a Weld Operator completes the welding operation, and as long as the number of welds made falls 
within the minimum and maximum range, the operator will be able to advance to the next step without 
flagging the sequence with an error.  However, if the welds do go outside the limits set by the Weld 
Engineer, Weld Sequencer will flag the step with an error (turning the border red) when the Weld Operator 
attempts to advance to the next step. 

For example, Ron at Advanced Manufacturing needs to weld over a gap in his assembly.  John, the Weld 
Engineer, added a Weld Open function to the weld sequence in Weld Sequence Editor to allow the Weld 
Operator some freedom to weld as needed to cover the gap appropriately, with a limit of two to six welds. 

Table 6.16 Properties Available for the Weld Open Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Minimum 
Number 
of Welds 

Enter the minimum number of welds that it takes to complete this welding operation.  If a 
Weld Operator attempts to advance to the next step without making at least this many 
welds, Weld Sequencer displays a red border and flags the sequence as having errors.  In 
the Review function, this step would show as failed. 

Maximum 
Number 
of Welds 

Enter the maximum number of welds that it takes to complete this welding operation.  
Once the Weld Operator makes the maximum number of welds, Weld Sequencer 
automatically advances to the next function. 

Weld Profile Enter the number for the Weld Profile you want the Welding Power Source to use for all of 
the welds in this function.  This Weld Profile determines the welding limits for the welds.  
For in-depth details on Weld Profiles, please refer to the Power Wave® Manager User 
Manual (IM8002). 

STOP | Be sure that the Weld Profile on the Welding Power Source contains the 
settings you want to use for this weld.  For example, each Welding Power Source has a 
Weld Profile 1; however, the profile limits set on each machine’s Profile 1 could be 
different. 
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Field Description 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 

Estimated 
Time 

The Estimated Time field is how long you think it should take for someone to complete this 
Weld Open function.  Weld Sequencer uses this time in the Cycle Status (Table 7.1 on page 
7.4) so be sure to provide ample time for a person to make the weld(s), reposition the part 
if needed and carry out other behaviors that go into making the weld(s). 

STOP | The Estimated Time is NOT ONLY arc-on time.  It also includes non-welding 
time involved in completing the welds. 

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld Operator 
reaches 85% of the time you enter here.  This alerts the operator that time is running 
out.  See Table 7.1 on page 7.4 for details on the Weld Sequencer display. 

Weld Procedures Tab 

With any of the welding functions, you use the Weld Procedures tab to specify which procedures the 
Welding Power Source should use for the welds in this function.  Once you enter the number of welds you 
want to make on the Properties tab of the function, Weld Sequencer activates the drop-downs on the Weld 
Procedures tab, and you can select the appropriate weld procedure for the weld and indicate which feed 
head should be enabled for this weld.  You can select a Procedure A and a Procedure B for each feed head.  
See page 5.17 for details on adding weld procedures to the weld procedure library so it appears in this 
drop-down. 

     

Figure 6.30 Weld Procedures for Single and Dual Head Feeders 

TIP | To enable this sequence for a Dual Head feeder system, select 
the appropriate Wire Feeder Type under Global Properties 
(page 5.1).  Enabling a Dual Head feeder displays another set 
of Procedure drop-downs so you can enable the correct feed 
head(s) for the weld. 
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Weld Validation Tab 

Validations allow you to set conditions for passing a weld (i.e., the “good” conditions).  If the weld does not 
meet these conditions, the weld fails validation and you can tell Weld Sequencer what to do next (e.g., 
display an alert or require a Quality Manager’s approval).  You do all this using the Weld Validations in the 
top toolbar (which is unique to each weld sequence) and selecting the appropriate entry from the Weld 
Validation tab of the welding function.  See page 5.22 for details on the sequence’s library of Weld 
Validations. 

In order to validate a welding function, you use both the Weld Validation tab on the function and the 
function connectors.  On the Weld Validation tab (Figure 6.31), simply select which validation you want to 
use for the welds in this function.  Remember:  The validation parameters indicate what properties must be 
met in order for the function to pass and move the sequence forward (i.e., the “good” condition).  The 
function connectors tell Weld Sequencer which function to run when the validation passes and which 
function to run when the validation fails.  See page 6.36 for details on connecting functions. 

 

Figure 6.31 Weld Validation Tab 

For example, John at Advanced Manufacturing has a Weld function in his Tack Welds step.  He created a 
validation rule for the Tack weld where he set the following parameters:  Duration > = 1 AND Duration <= 2.  
Now he is ready to use that rule for a weld.  He simply selects the Tack entry from the Weld Validation Rule 
drop-down on the Weld Validation tab of the Weld function (Figure 6.31). 

 

Figure 6.32 Weld Validations and the Weld Validation Tab of Welding Function 
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Using Weld Profiles to Validate Welds 

Weld Profiles can help you validate welds and make sure that any welds you want the operator to perform 
are consistent across multiple parts.  Profiles can cause alerts to occur when welding goes outside any limits 
you set in the profile.  The availability of these alerts provides you with a great way to validate any welds in 
the sequence.  If the welding operation causes an alert based on the Weld Profile being used, Weld 
Sequencer can perform any number of actions for you, including preventing the operation from moving 
forward. 

TIP | The Power Wave® Manager User Manual (IM8002) explains 
Weld Profiles in great detail. 

 

Figure 6.33 Using Weld Profiles to Validate Welds 

For example, John at Advanced Manufacturing wants to use Weld Profiles for the welds in his sequence.  In 
his Weld Profiles, the WeldScore® is set a little differently depending on the needs of the welds that will use 
that profile.  No matter what the WeldScore® limit is for each profile, they each create an alert in the power 
source if welding goes below the limit.  John is going to use the existence of that alert to validate the 
welding functions. 

He created a welding validation on the sequence that indicated that the “good condition” is no WeldScore® 
alert when the Weld Operator completes the operation.  Once he has this validation created, he can now 
use this validation on any of the welds that use any Weld Profile.  

If the WeldScore® on any of the welding functions goes below whatever limit is chosen for whatever Weld 
Profile is listed on the welding function, John can use the connectors to direct the path of the sequence 
(e.g., to an Alert function if there is a WeldScore® alert issued or on to the next function if there is no alert 
issued). 

TIP | See page B.7 for a helpful way to use a Weld Profile to ignore 
short welds in your welding operation. 
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Connecting a Welding Function 

When you add validations to a welding function, you need to connect that function to the next sequence 
function you want the sequence to run if the validation you set fails (e.g., an Approval function) AND to the 
function you want the sequence to run if the validation passes (e.g., the next welding function).   You must 
add a connector to address all possible values for the Property Name you select.  See Figure 6.23 on page 
6.23. 

TIP | The connector turns green if there are validation options 
available for the function. 

 

Figure 6.34 Connector Properties 

The validations on the connector are simple.  You have a choice between Arc Starts, Maximum Deposition 
Exceeded or Validation Passed. 

 Arc Starts:  The Arc Starts (i.e., number of welds) property allows you to move to another 
function based on a comparison to the number of arc starts that occurred in the welding 
function (e.g., Arc Starts >= 2). 

 Maximum Deposition Exceeded:  Available only with the Weld Accumulator function, this 
property allows you to indicate which path Weld Sequencer should take if the total amount of 
material used by the Weld Operator went over the amount you specified as the top limit on the 
Properties tab within the accumulator function. 

 Validation Passed:  This property tells the weld sequence which path to take from the welding 
function based on the parameters on the Weld Validation tab. 

- Validation Passed = True means that if the validation you set on the Weld Validation tab 
within the welding function passes, this is the route the sequence should take. 

- Validation Passed = False means that if the validation you set on the Weld Validation 
tab within the welding function fails, this is the route the sequence should take. 

In our example on page 6.34, John at Advanced Manufacturing set his validations for the Weld function in 
the Weld Sequence Editor based on the WeldScore® being above 90%.  He added an Approval function next 
to the Weld function.  He dragged a connector from the Weld function to the Approval function and 
double-clicked the connector.  This is the path John wants Weld Sequencer to take if the WeldScore® is 90% 
or lower.  So, he selects Validation Passed from the Property Name drop-down and selected False from the 
Value drop-down.  He did the same with the connector he dragged from the Weld function to the next 
Weld function in his sequence, but he selected True from the Value drop-down instead so the weld 
sequence would take this path if the WeldScore® was above 90%. 
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Resuming a Welding Function 

If a weld fails validation in one of the welding functions (i.e., Weld, Weld Accumulator and Weld Open), a 
Weld Engineer typically takes the weld sequence to an Alert function or an Approval function or handles it 
some other way.  If a connector comes back to the welding function, Weld Sequencer picks up where the 
operator left off, ready for the next weld. 

 

Figure 6.35 Best Practices with an Alert Function 

For example, John at Advanced Manufacturing created a step in his weld sequence that contains a Display 
Picture function, a Weld function (with four welds) and an Alert function (to handle failed welds).  He then 
drew a connector from the Alert function back to the Weld function (NOT to the next function of the next 
step). 

When Ron down on the floor reached this part of the welding operation, his third weld failed validation.  
The weld sequence exited the welding function after the failed weld and displayed the alert for Ron (Figure 
5.6).  He acknowledged the message with two quick trigger pulls on his torch.  The sequence went back to 
the welding function and picked up where Ron left off.  However, Ron needed to make a correction in the 
failed weld.  So, he switched into Manual mode with four quick trigger pulls and corrected the failed weld.  
He switched back into Automatic mode with four quick trigger pulls and continued the sequence with the 
final weld in the function. 

Weld Function Icons 

The welding function, ignore weld (optional), and spot timer (optional) icons are displayed on the top status 
bar to help the Weld Operator understand the requirements and conditions for the welding activity.  The 
welding function icon lets the Weld Operator know if this is a Weld function, Weld Accumulator function, or 
a Weld Open function. 

To the right of the welding function icon, an optional icon for the ignore weld time will be shown if the 
active Weld Profile is using this capability.  Welds with a duration less than this value (in seconds) will be 
completely ignored.  This is typically used to allow small tack welds, or to ignore accidental arc starts, 
without counting the weld against the requirements of the welding function.  

If any of the Weld Procedures defined by the welding function are using Spot Timer functionality, another 
optional icon will be displayed along with the spot time (in seconds).  This informs the Weld Operator that 
welding will stop automatically at the end of the spot time period.  
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Figure 6.36 Weld Function Icons 

Weldset Software 
Use the Weldset Software function when you need to verify whether the connected Welding Power 
Source contains a special Weld Set (i.e., a specific library of Weld Modes on the machine).  If you 
require a special weld set, you want to make sure the Welding Power Source that runs your weld 

sequence contains the appropriate welding software revision before the Weld Operator begins welding.  
When Weld Sequencer encounters this function, it checks the Welding Power Source for you and verifies 
the weld set. 

 

Figure 6.37 Weld Set Software Function Properties 

If the Welding Power Source does not contain the weld set software revision you indicate in the function, 
Weld Sequencer displays an error and stops the weld sequence.  This prevents a Weld Operator from 
attempting to execute a sequence on a power source with “wrong” or “unverified” welding software. 

TIP | To read the values from the power source you have currently 
connected to the Weld Sequence Editor, simply click the Read 
Power Source Values button. 
 
You can also find the weld set information for a Welding 
Power Source using Power Wave® Manager.  Connect to the 
power source (page2.11) and select System Status > Module 
Information.  In the Basic Information section, you’ll see the 
Weld Set Version in the format:  name (checksum). 

Table 6.17 Properties Available for the Weld Set Software Function 

Attribute Description 
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Attribute Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Weldset 
Name 

Enter the name of the weld set that must be on the Welding Power Source for this weld 
sequence.  When the weld sequence finds the weld set’s name, it then verifies the 
checksum. 

Checksum Enter the required checksum value for the weld set.  If the checksum you list here does not 
match the checksum on the Welding Power Source for this weld set, Weld Sequencer 
displays an error and stops the sequence. 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 

Database Functions 
The Database functions allow you to create and/or interact with the Work Item table in the Weld 
Sequencer database. 

STOP | These functions make changes to a table in the Microsoft® SQL 
Server database.  Only those users who are familiar with 
maintaining a SQL Server database should use these functions. 

There are two sets of functions that work with this table: 

 Create Record functions allow you to add records to the Work Item table in the Weld Sequencer 
database and help you increase the traceability of assemblies and subassemblies. 
 
For example, John at Advanced Manufacturing needs to track the welds that go into making a 
vehicle.  The vehicle has a serial number and each of the sub-assemblies has a serial number.  
John needs to be able to put those together.  So, he has a weld sequence with the Create Record 
and Save Field functions to create a “work order”. 

 Verify Field functions allow you to look up data from a table and use it in your weld sequence 
(even if the data was not created with the Create Record functions). 
 
For example, John at Advanced Manufacturing has assemblies that require the Weld Operator to 
use specific materials for the welds.  He wants the operator to verify the material on the 
Welding Power Source and if what the operator enters does not match what John has in the 
table, John can make the weld sequence stop and inform the operator that the material is not 
correct.  This helps him prevent unacceptable welds before the Weld Operator gets too far.  

NOTE | Work Items are up to you.  You can use them for tracking 
assemblies and sub-assemblies.  You can also use them to 
create material lists for an assembly.  Contact Lincoln Electric 
Weld Sequencer support for additional assistance:  
softwaresupport@lincolnelectric.com. 

mailto:softwaresupport@lincolnelectric.com
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Work Item Create Functions 

The Create Record and Save Field functions work together to build the records in the Work Item table.  
These functions allow you to prompt the Weld Operator (or other personnel) for data that Weld Sequencer 
saves into the database table. 

 Create Record function:  Use this function to prompt the Weld Operator for a unique identifier 
for the record.  Weld Sequencer creates the row in the Work Item table and identifies the row 
by whatever text the operator enters (e.g., vehicle serial number or work order number).  See 
page 6.41 for more details on this function. 

 Save Field function:  This function prompts the Weld Operator for data to add to the columns of 
the active record (e.g., columns for the cab, frame, bucket and other sub-assemblies of a loader 
vehicle).  See page 6.42 for more details on this function. 

TIP | When the operator creates a new record, that record remains 
active until the sequence changes it or the application closes. 
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Figure 6.38 Create Record Functions 

Create Record 

The Create Record function displays an entry field in Weld Sequencer (Figure 6.39).  When the 
Weld Operator (or other personnel) enters the data, the function verifies if that entry already 
exists in the table and, if it doesn’t exist, the system creates a new row in the database and 

uses that data as the unique identifier for the record and keeps the record as the currently active 
record.  Table 6.18 on page 6.42 explains the fields on the Properties window in more detail. 

 

Figure 6.39 Create Record Function 

The validation on the connector from this sequence function is simple:  Item is New = True or False.  
Since we want to create a new entry for a new record and we don’t want to recreate a record when 
it already exists, this validation is important to maintain the integrity of the database.   You need to tell 
Weld Sequencer what sequence function to run next if the entry is new and which one to run when it 
is not.  (See page 6.5 for more details on connecting and validating functions.) 

 

Figure 6.40 Validation on Create Record Function 
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Table 6.18 Properties Available for the Create Record Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Title The text that you enter in the Title field displays in the Weld Sequencer first on the screen 
when the Weld Operator reaches this function (e.g., “Create Work Order” in Figure 6.39). 

Description The text you enter in the Description field displays in the Weld Sequencer after the text 
from the Title field (e.g., “Enter the Vehicle Serial Number:” text in Figure 6.39). 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it  will still be shown 
in the Review Function list. 

Save Field  

Now that you have a record created in the Work Item table, you need to add data to the 
columns in that table so the Weld Operator can enter data into that column (Figure 6.41).  To 
add to a column for the record, you need to add the Save Field function to a new step in the 

sequence and tell the sequence which column in the table you want to use for this bit of data, using 
the Type drop-down.  Table 6.19 on page 6.44 explains the fields on the Properties window in more 
detail. 
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Figure 6.41 Save Field Functions 

NOTE | You need to add the Save Field  function for each column you 
want in the record. 
 
For example, if you want the vehicle’s record to contain the 
serial number for the cab, the frame and the bucket, you 
would have three Save Field functions in your weld sequence 
(Figure 6.38 on page 6.41). 

The validation on this function is simple, too:  Field is Valid = True or False.  When the Weld Operator 
enters data for this function, the system checks if the indicated column is empty for this record.  

 

Figure 6.42 Validation on Save Field Function in Weld Sequence Editor 

If the column is empty, the system considers this a valid entry and adds the serial number to the 
column.  With a valid entry, the weld sequence continues to the function you have connected with the 
validation Field is Valid = True. 
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If the column is not empty, Weld Sequencer follows the path you established with the validation Field 
is Valid = False.  Typically, this is an Alert function communicating with the Weld Operator. 

Table 6.19 Properties Available for the Save Field Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Title The text that you enter in the Title field displays in the Weld Sequencer first on the screen 
when the Weld Operator reaches this function (e.g., “Create Work Order” in Figure 6.41). 

Description The text you enter in the Description field displays in the Weld Sequencer after the text 
from the Title field (e.g., “Enter the Bucket Serial Number:” text in Figure 6.41). 

Type The Type field is how you identify in which column of the active work item record you 
want to store the data entered by the Weld Operator.  Simply select the appropriate 
column from the drop-down.  Here’s an example of the table in the database: 

 

NOTE | Be sure the Type drop-down on each of the Save Field functions in your 
sequence is a different selection (e.g., Field 1, Field 2, Field 3,  etc.). 

TIP | Weld Sequencer automatically records the Computer Name, User name and IP 
address of the Welding Power Source that creates the record in the Work Item table. 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 

Example 

John at Advanced Manufacturing has a weld sequence file created that will help his personnel create 
the work order needed to build a vehicle from its sub-assemblies.  In Figure 6.38 on page 6.41, he used 
the Create Record function and multiple Save Field functions. 

When the Weld Operator runs this weld sequence file in the Weld Sequencer, they will enter the 
vehicle’s serial number (Create Record function labeled Vehicle SN Entry in Figure 6.38).  If that number 
is not yet in the database, John makes Weld Sequencer display an alert that a new record was created 
and then move to the next step.  If it is already in the database, the system automatically displays the 
next step, with the entered serial number as the active record. 

The next step is to enter the serial number of the first sub-assembly (Save Field function labeled Cab 
SN Entry in Figure 6.38).  When the operator enters the serial number for the cab, the system checks if 
that column is empty for this vehicle’s record.  If it is empty, this is considered a valid entry and the 
system adds the serial number to the column and moves to the next step.  If that column is not empty, 
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John has Weld Sequencer display an alert that the entry was not valid and allows the operator to enter 
the information again. 

This continues for the frame and the bucket. 

Work Item Lookup Functions 

If your IT team has imported data into the Work Item table for you or if you have created records in this 
table using the Work Item Create functions, you can look up data from the table and use them to make 
decisions in your weld sequence.  The Select Records functions help you do this. 

 Select Record function:  This function prompts the Weld Operator for the unique identifier on 
the record they want to look up and, if found, keeps that record active for the remainder of the 
sequence.  See page 6.46 for more details on this function. 

 Verify Field function:  This function prompts the Weld Operator for information in the active 
record (found using the Select Record function).  This function allows you to verify information in 
the table and act on it.  See page 6.47 for more details on this function. 

 

 

Figure 6.43 Select Record Functions 

For example, John at Advanced Manufacturing has assemblies that require the Weld Operator to use 
specific materials for the welds.  He wants the operator to verify the material on the Welding Power Source 
and if the material entered does not match what is in the table, he can stop the weld sequence and inform 
the operator that the material is not correct.  This helps him prevent unacceptable welds before the Weld 
Operator gets too far. 



Chapter 6. Sequence Functions Database Functions 

6.46 Weld Sequencer User Manual IM8003 

Select Record 

The Select Record function displays an entry field in Weld Sequencer (Figure 6.42) and 
prompts the Weld Operator (or other personnel) for the information needed to look up the 
record in the Work Item table (e.g., the vehicle serial number or work order number).  When 

the operator enters that data in Weld Sequencer, the function looks for that record in the Work Item 
table and reacts based on the validation you establish on the connector.  (Table 6.20 explains the fields 
on the Properties window in more detail.) 

 

Figure 6.44 Select Record Function 

The validation for the Select Record function is simple:  Item was Found = True or False (Figure 6.45).  If 
the system finds a record matching the text entered by the Weld Operator (or other personnel) in 
Weld Sequencer, the sequence follows the path you’ve laid out for it based on the validation Item was 
Found = True and maintains the record as the currently active record.  If it doesn’t find a matching 
entry, Weld Sequencer takes the path you have indicated with the validation Item was Found = False. 

 

Figure 6.45 Validation on the Select Record Function 
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Table 6.20 Properties Available for Select Record Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Title  The text that you enter in the Title field displays in the Weld Sequencer first on the screen 
when the Weld Operator reaches this function (e.g., “Work Order” in Figure 6.44). 

Description The text you enter in the Description field displays in the Weld Sequencer after the text 
from the Title field (e.g., “Enter the Work Order:” text in Figure 6.44). 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 

Verify Field  

The Verify Field function allows you to verify information that appears in the columns of the 
record found when the Weld Operator entered data in the Select Record function (e.g., various 
materials listed for the record).  When the function runs in Weld Sequencer, the system 

displays a prompt for the Weld Operator (or other personnel) to enter text in a field.  Table 6.21 
explains the fields on the Properties window in more detail. 

 

Figure 6.46 Verify Field Function 
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The validation on this function is simple:  Field Matches = True or False.  When the Weld Operator 
enters data for this function, the system checks if the text entered matches the text in the appropriate 
column of this record in the Work Item table. 

 

Figure 6.47 Validation on Verify Field Function 

If the text matches the data in the indicated column of the record, the system considers this a valid 
entry, and the weld sequence continues to the function you have connected with the validation Field 
Matches = True. 

If the text entered does not match the data in the column indicated in the function, Weld Sequencer 
follows the path you established with the validation Field Matches = False.  Typically, this is an Alert 
function communicating with the Weld Operator. 

Table 6.21 Properties Available for the Verify Field Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Title The text that you enter in the Title field displays in the Weld Sequencer first on the screen 
when the Weld Operator reaches this function (e.g., “Material One” in Figure 6.46). 

Description The text you enter in the Description field displays in the Weld Sequencer after the text 
from the Title field (e.g., “Enter Material One:” text in Figure 6.46). 

Type The Type field is how you identify in which column of the active work item record you 
want to search for the data entered by the Weld Operator.  Simply select the appropriate 
column from the drop-down.  Here’s an example of the table in the database: 

 

You can use the Verify Field function to verify computer name, Welding Power Source IP 
address and/or user name in the work item record.  When you choose one of these types, 
however, the system simply checks the data and goes to the function you have selected 
for each validation.  There is no prompt or display for the Weld Operator in Weld 
Sequencer. 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 
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Example 

John at Advanced Manufacturing wants to make sure that specific materials are loaded for the 
Welding Power Source before the Weld Operator can begin welding.  His IT team imported a materials 
list into the Work Item table for him with the columns containing Work Order, Material One, Material 
Two and Filler Material.  In Figure 6.43 on page 6.45, he used the Select Record function and multiple 
Verify Field functions to work with the data. 

When the Weld Operator runs this weld sequence file in Weld Sequencer, they will enter the work 
order number (Select Record function labeled Order Lookup in Figure 6.43 on page 6.45).  If Weld 
Sequencer finds this record in the table, John has the sequence move to the next step, with the 
entered work order as the active record.  If Weld Sequencer could not find the work order number, 
John has the sequence display an Alert function. 

The next step is to enter the first material for the work order (Verify Field function labeled Material 
One Lookup in Figure 6.43 on page 6.45).  When the operator enters the material, the system checks if 
that text is a match for the data in Material One’s column of the work order record.  If it is a match, 
this is considered a valid entry, and John has the sequence move to the next step.  If the text does not 
match the data in the column, John has the sequence display an Alert function. 

This continues for Material Two and the Filler Material.  Once all the lookup fields pass validation, John 
allows the Weld Operator to begin the welding steps of the sequence. 

Programmable Logic Controller (PLC) Functions 
The Programmable Logic Controller (PLC) functions allow you to incorporate the use of PLC-controlled 
automation, sensors and actuators into the weld sequence.  You can read information from your PLC-
controlled equipment and bring it into Weld Sequencer, and you can send information out from Weld 
Sequencer to the PLC.  See Page 6.56 for a detailed example for using PLC Tag Read and PLC Tag Write 
functions. 

Weld Sequencer establishes a point-to-point connection to the PLC using TCP/IP protocol, and each request 
sent to the PLC is a self-contained transaction.  The Guideline for Using the Weld Sequencer PLC Interface  
document provides in-depth details and discussions on the PLC interface. 

For example, Weld Sequencer can read PLC tag values to determine: 

 Preheat and interpass temperature 

 Assembly position from automatic positioners 

 Clamp position (open or closed) 

 Part presence 

Weld Sequencer can write tag values to PLCs such as those that run the following: 

 Turn on a stack light or other type of status indicator 

 Signify the end of a welding cycle 

 Enable fixture motion 

STOP | When referencing PLC tags in the Weld Sequence editor, you 
must enter the precise name of the PLC I/O or memory tag.  
Typically, you can export the tags to a comma-separated value 
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(CSV) file using software provided by the manufacturer of your 
PLC.  Refer to the manufacturer’s documentation for details.  

PLC Field Entry 

Similar to the standard Field Entry function (page 6.16), the PLC Field Entry function allows Weld 
Sequencer to retrieve a specific tag from the PLC and use that string as the part serial number or 
consumable lot code.  This helps streamline the weld sequence. 

 

Figure 6.48 PLC Field Entry Function 

NOTE | Weld Sequencer clears the part serial number at the end of 
the sequence to ensure the software does not use an old or 
“left over” serial number for new sequences (new parts). 

Table 6.22 Properties Available for the PLC Field Entry Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Tag Name The tag’s name is dependent on the PLC to which the sequence needs to connect and 
identifies the information to read.  Be sure the name you type matches the format and 
syntax required by the manufacturer of the PLC. 

Tag Type From the Tag Type drop-down, select the kind of data the tag contains.  For example, if the 
data is a string, you would select String from the drop-down.  Generally, you can set this 
drop-down to Auto and allow Weld Sequencer to select the best method for reading the tag 
value specified in the Tag Name field. 

In some cases, however, it may be necessary to select the precise data type of the element 
specified in the Tag Name field (e.g., when accessing user-defined data type (UDT) element). 

NOTE | When referencing PLC tags in the Weld Sequence Editor, refer to the 
manufacturer’s documentation if you need to determine the correct data type for the tag. 

Type Weld Sequencer needs to know which number you are retrieving from the PLC in order to 
save the number properly.  From the Type drop-down, select which ID number this function 
represents:  Consumable Lot or the Serial Number.  You will see this number in reports in 
CheckPoint™. 
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Field Description 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown in 
the Review Function list. 

Estimated 
Time 

The Estimated Time field is how long you think it should take for the operation represented 
by this function.  Weld Sequencer uses this time in the Cycle Status (Table 7.1 on page 7.4) 
so be sure to provide ample time to complete the operation. 

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld Operator 
reaches 85% of the time you enter here.  This alerts the operator that time is running out.  

PLC Tag Read 

The PLC Tag Read function allows you to pull data from your PLC into Weld Sequencer and 
determine what to do next in the sequence.  For example, if the PLC for a fixture clamp returns the 
correct value indicating it is closed, you can tell Weld Sequencer to move to the next function.  If 

the value returned is different from the closed tag, you can tell the sequencer to follow a different path. 

In the PLC Read Properties window, you tell Weld Sequencer which tag you want it to read and the optional 
value you expect that tag to contain.  You can also set the amount of time the system waits for the 
Expected Value.  Your PLC manufacturer’s documentation should provide you with information for creating 
and configuring tags.  Table 6.23 explains each field in detail. 

 

Figure 6.49 PLC Tag Read Function 

Table 6.23 Properties Available for the PLC Tag Read Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Tag Name The tag’s name is dependent on the PLC to which the sequence needs to connect and 
identifies the information to read.  Be sure the name you type matches the format and 
syntax required by the manufacturer of the PLC. 

Tag Type From the Tag Type drop-down, select the kind of data the tag contains.  For example, if the 
data is a string, you would select String from the drop-down.  Generally, you can set this 
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Field Description 

drop-down to Auto and allow Weld Sequencer to select the best method for reading the tag 
value specified in the Tag Name field. 

In some cases, however, it may be necessary to select the precise data type of the element 
specified in the Tag Name field (e.g., when accessing user-defined data type (UDT) element). 

NOTE | When referencing PLC tags in the Weld Sequence Editor, refer to the 
manufacturer’s documentation if you need to determine the correct data type for the tag.  

Expected 
Value 

Enter the value you expect to appear in the tag’s data when Weld Sequencer retrieves it.  
You have the option on the conditional connector from the PLC Tag Read function to specify 
how Weld Sequencer behaves based on this value.  You can read the value one time and exit 
this function (set Timeout to zero) or you can periodically read the value and watch for a 
specific value over a period of time (the Timeout time). 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown in 
the Review Function list. 

Estimated 
Time 

The Estimated Time field is how long you think it should take for the operation represented 
by this function.  Weld Sequencer uses this time in the Cycle Status (Table 7.1 on page 7.4) 
so be sure to provide ample time to complete the operation. 

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld Operator 
reaches 85% of the time you enter here.  This alerts the operator that time is running out.  

Timeout In the Timeout field, enter the number of seconds Weld Sequencer should monitor the tag 
value with periodic read operations and then process one of the conditional connectors.  
The periodic read timing is set with the PLC Settings in Weld Sequencer (page 7.10). 

If the Timeout period expires, the function will end and the exit connectors for the function 
will be processed.  In this case, a default connector (with no rules) or a conditional 
connector with Timeout Occurred = True would be taken. 

If you enter a value of 0 in the Timeout field, the PLC Tag Read function performs a single 
read and then compares the value it receives to the Expected Value and processes the exit 
connectors for the function.  At least two exit connectors should always be used in this case: 

 one for the Matches Expected Value (True or False) result or for the Compare 
Acquired Value 

 and second default connector (with no rules) to handle all other results.  In the case 
of a PLC communication problem that does not allow the single read operation to 
complete successfully, another connector can be added to handle this condition. 

When you add a PLC Tag Read function, you need to connect that function to the next one.  The connector 
for a PLC Tag Read function is conditional.  It’s based on either the value you entered in the Expected Value 
field, a comparison to conditional connector values, or whether the number of seconds in the Timeout field 
have elapsed.  Table 6.24 explains the properties in more detail. 
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Figure 6.50 Connector Properties 

Table 6.24 Available Properties for the PLC Tag Read Connector 

Field Description 

Compare 
Acquired 
Value 

This property tells the weld sequence which path to take from the PLC Tag Read function 
based on a comparison of values.  Weld Sequencer can compare the value it receives from 
the PLC to the value you enter in the Value field here on the connector.  If you use this 
property, the function reads the acquired value, compares it to the value you enter here 
and determines if the connector route should be taken. 

Matches 
Expected 
Value 

This property tells the weld sequence which path to take from the PLC Tag Read function 
based on whether Weld Sequencer received the text you entered in the Expected Value 
field on the PLC Tag Read function. 

 Matches Expected Value = True means if the text received from the PLC message 
matches the text you entered in the Expected Value field, this is the route the 
sequence should take. 

 Matches Expected Value = False means if the text received from the PLC message 
DOES NOT match the text you entered in the Expected Value field, this is the route 
the sequence should take. 

Timeout 
Occurred 

Rather than matching the Expected Value, you can define the path of the sequence based 
on whether the number of seconds you defined in the Timeout field have passed. 

 Timeout Occurred = True means that the time elapsed before the Expected Value 
or a valid Conditional Connector executes. 

Value Read 
Failure 

The path of the sequence can be determined based on the read Quality from the PLC.  The 
PLC read values are GOOD, INACTIVE UNCERTAIN and BAD. 

PLC Tag Write 

The PLC Tag Write function allows you to send information to the PLC-controlled device from Weld 
Sequencer.  For example, when the sequence begins, you can activate a stack light to inform 
passers-by that welding is in progress and then turn it off again afterward.  Table 6.25 explains the 

properties for the PLC Tag Write function in more detail. 
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Figure 6.51 PLC Tag Write Function 

NOTE | You cannot configure the connector coming from a PLC Tag 
Write function.  If the tag write fails, a sequence error occurs. 

Table 6.25 Properties Available for the PLC Tag Write Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the Weld 
Sequence Editor.  This helps you easily identify the function within the step. 

Tag Name The tag’s name is dependent on the PLC to which the sequence needs to connect and 
identifies where the information will be written.  Be sure the name you type matches the 
format and syntax required by the manufacturer of the PLC. 

Tag Type From the Tag Type drop-down, select the kind of data the tag contains.  For example, if the 
data is a string, you would select String from the drop-down.  Generally, you can set this 
drop-down to Auto and allow Weld Sequencer to select the best method for sending the tag 
value specified in the Tag Name field. 

In some cases, however, it may be necessary to select the precise data type of the element 
specified in the Tag Name field (e.g., when accessing user-defined data type (UDT) element). 

NOTE | When referencing PLC tags in the Weld Sequence Editor, refer to the 
manufacturer’s documentation if you need to determine the correct data type for the tag. 

Value Enter the value you want Weld Sequencer to send to the PLC. 

Load From You use the Load From field in conjunction with the Create Record or the Select Record 
functions (page 6.39).  The Load From field allows you to pull data from the Work Item table 
in the Weld Sequencer database that was created with the Database functions.  You can 
then pass this information to the PLC.  Simply select the column from which you would like 
to pull data. 

Hide in 
Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown in 
the Review Function list. 

Estimated 
Time 

The Estimated Time field is how long you think it should take for the operation represented 
by this function.  Weld Sequencer uses this time in the Cycle Status (Table 7.1 on page 7.4) 
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Field Description 

so be sure to provide ample time to complete the operation. 

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld Operator 
reaches 85% of the time you enter here.  This alerts the operator that time is running out.  

Power Lift HZA Function 

This function enables PLC control of the Power Lift HZA Positioner; it provides all the required PLC 
interactions for positioning to a new height and rotation angle.  You can preprogram the positioner 
height and rotation angle in order to automatically move the part into the optimal position for 

welding.  In addition, the height can automatically adjust to the height of the Weld Operator providing an 
ergonomic position for making quality welds.  Table 6.26 explains the properties for the Power Lift HZA 
function in more detail. 

 

Figure 6.52 Power Lift HZA Function 

Table 6.26 Properties Available for the Power Lift HZA Function 

Field Description 

Name You can add a description for this function that appears on the function’s icon in the 
Weld Sequence Editor.  This helps you easily identify the function within the step. 

Height Enter the desired height of the Power Lift HZA positioner.  Once motion is enabled on the 
positioner, it will move the part/fixture to this height. 

Rotate Enter the desired rotation angle of the Power Lift HZA positioner.  Once motion is 
enabled on the positioner, it will rotate the part/fixture to this angle.  

Timeout In the Timeout field, enter the number of seconds Weld Sequencer should wait for the 
positioner to move to the new height and rotation angle.  Motion will not begin until the 
Weld Operator enables motion with safety switches.  A conditional connector using the 
Position Completed property can be used to recognize when this function completes 
successfully. 

If the Timeout period expires (minimum value is 60 seconds), the function will end and 
the exit connectors for the function will be processed.  In this case, a default connector 
(with no rules) or a conditional connector with Timeout Occurred = True would be taken. 
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Field Description 

At least two exit connectors should always be used with this function: 

 one for the Position Completed condition 

 and a second Timeout Occurred condition or a default connector (with no rules) 
to handle all other results. 

Automatically 
Offset Height 

Using 5 foot 10 inches as the default height of an operator, when this option is used, the 
positioner will automatically offset the desired height by comparing this to the height of 
the Weld Operator who is running the Weld Sequencer.  For example, if the Weld 
Operator is 6 foot tall, the desired height would be automatically increased by 2 inches.  
See page 3.1 for details on entering the height of each user. 

Hide in Review 
Function 

You can select this option to hide information about this function and not show it in the 
Review Function list.  If a sequence error occurs during this function, it will still be shown 
in the Review Function list. 

Estimated 
Time 

The Estimated Time field is how long you think it should take for the operation 
represented by this function.  Weld Sequencer uses this time in the Cycle Status (Table 
7.1 on page 7.4) so be sure to provide ample time to complete the operation. 

TIP | The Cycle Status  bar in Weld Sequencer turns yellow when the Weld 
Operator reaches 85% of the time you enter here.  This alerts the operator that time is 
running out. 

Connecting Weld Sequencer to the PLC 

If you have a sequence that contains PLC Tag Read and PLC Tag Write functions, you need to remember to 
configure the Weld Sequencer computer on the production floor to connect to the PLC.  See page 7.10 for 
details. 

Weld Sequencer to PLC Interface Example 

The following example shows how you can use the PLC Tag Read and PLC Tag Write functions on a welding 
fixture that has part present sensing and clamps controlled by a PLC.   For more in-depth information about 
using PLCs with Weld Sequencer, refer to the Guideline for Using the Weld Sequencer PLC Interface 
document. 

 

Figure 6.53 PLC Example 
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In the Load Parts step, Weld Sequencer displays a picture indicating the part locations that the operator 
needs to load.  The PLC Tag Read function labeled Parts Loaded? executes.  This function simply reads the 
“part present” sensor input from the PLC.  The function waits for the part present sensor to send the 
Expected Value of True.  Once it does, the sequence continues. 

In the Close Clamps step, John created an enable and confirmation control pattern.  The Weld Sequencer 
sends a tag to the PLC with the PLC Tag Write function labeled EN Clamp Act.  This tag enables the clamp 
close operation from the Weld Sequencer point of view.  The PLC itself specifies other conditions that have 
to be met before the clamps will move.  As soon as the EN Clamp Act. function sends the memory tag; Weld 
Sequencer displays a picture indicating to the operator that it is time to close the clamps.  The operator 
moves clear of the fixture and initiates closing the clamps by using standard operator controls.  The PLC 
energizes the clamping actuators only if all conditions for safe operation have been met.  

Once Weld Sequencer displays the picture to the operator, the next function is a PLC Read Tag labeled 
Clamps Closed?.  This function provides you with a way to get confirmation that the clamps are closed as 
expected.  The Clamps Closed? function waits for the Expected Value for the “clamps closed” tag to return 
as True (based on the Group Update Rate in the PLC Settings).  Once it does, the sequence continues. 

Next, the Weld Sequencer executes a PLC Tag Write function labeled DS Clamp Act.  This function clears the 
PLC memory tag that was set by the EN Clamp Act. function.  In the PLC, this disables clamp operation from 
the Weld Sequencer point of view in preparation for opening the clamps at the end of the sequence.  The 
PLC logic, of course, maintains the current clamp position with the appropriate clamping pressure, etc. as 
needed as long as conditions require it.  The step completes as soon as the PLC memory tag is clear. 

Next are the welding functions and a final Review step, which performs another set of PLC Tag Read and 
PLC Tag Write functions to open the clamps. 
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Chapter 7 

Weld Sequencer 

Overview 
Once the Weld Engineer(s) create a weld sequence file to help when performing semi-automatic welding 
operations, Weld Operators can run those files on the Weld Sequencer computer.  These weld sequence 
files help Weld Operators perform weld operations in a consistent and repeatable way.  Once the Weld 
Operator loads the weld sequence file, they simply begin welding.  The weld sequence file takes care of the 
settings on the Welding Power Source for each weld. 

STOP | Once you connect to the Welding Power Source, Weld 
Sequencer disables the power source anytime the application 
starts.  The Weld Operator must log in to the application to 
enable the power source.  From that point, the sequence can 
determine if the User Interface is locked or unlocked.  See 
page 5.1 for information on Global Properties. 

 

NOTE | If your company uses bar code scanners to enter data into 
Weld Sequencer (e.g., logging in or entering part numbers), 
you need to make sure that you configure the scanner 
properly (page 3.4). 

Load and Run a Weld Sequence File 
When you are ready to begin using weld sequence files to weld, you can simply log in and launch the weld 
sequence file.  Various settings are available for each instance of the Weld Sequencer application to reflect 
the needs of the operators (page 7.7). 

TIP | You can also set up the application shortcut to launch a 
specific weld sequence file automatically (page B.6). 

The general workflow for running a weld sequence file: 

Procedure Details 

1. Launch Weld Sequencer. Weld Sequencer automatically connects to the last Welding 
Power Source connected and displays the Login window. 

2. Enter your user name and password. Weld Sequencer uses these credentials as the Operator ID for 
each weld performed. 

3. Select File > Load Sequence from the 
main menu. 

The Please select a file window opens. 
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Procedure Details 

4. Double-click the appropriate weld 
sequence file from the list to launch 
it or click Browse to find the file. 

TIP | If you have the Auto Start preference for this instance 

of the Weld Sequencer enabled, the weld sequence begins 
automatically. 

5. Click the Start button . The Cycle Time  starts. 

6. Follow the steps in the sequence. If you execute the sequence properly, it ends automatically, 

and the Cycle Time  stops. 

TIP | If you have the Auto Restart preference for this 
instance of the Weld Sequencer enabled, the weld sequence 
file resets itself, begins again automatically and resets the 
Cycle Time. 

Part Lookup 
The Part Lookup table provides an easy way to load the appropriate weld sequence file based on a part 
number.  The Part Lookup table uses the part number database.  In the part number database is a simple 
association between your part numbers and the file name of the weld sequence file that goes along with 
each one.  Once the Weld Operator enters the part number, Weld Sequencer looks it up in the part number 
database and then, if it’s a valid part number, automatically loads the correct weld sequence file for the 
operator. 

NOTE | Weld Engineers create the Part Lookup table in the Weld 
Sequence Editor (page 4.8). 

 

TIP | Weld Sequencer can monitor a PLC tag and automatically 
perform a Part Lookup based on the value of that tag.  Please 
see page 7.12 for details. 

 

Figure 7.1 Part Lookup 
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TIP | Under File > Preferences, users have the option to 
automatically display a prompt for the Part Lookup as soon as 
they log in.  See page 7.7 for more details on workstation 
preferences. 

The Weld Operator also has the option to run the same sequence a specified number of times.  When 
running a sequence based on Part Lookup, the Weld Operator can enter a number in the Number of Parts 
to Run field (Figure 7.1). 

When the quantity is more than one, the status panel on the right side of the screen will show Part X of Y, 
where X is the number of the part you are actively running and Y is the total number of parts to run.  If the 
Automatically Request New Part Number option is enabled under File > Preferences, Weld Sequencer only 
displays the Part Lookup window again after all parts (Y) have been completed. 

To load a weld sequence file in Weld Sequencer with this Part Lookup functionality: 

Procedure Details 

1. Launch the Weld Sequencer. The Login window displays. 

2. Enter your user name and password.  

3. Select File > Part Lookup from the main 
menu. 

 

4. Enter the part number (and quantity if 
applicable) and click Lookup. 

Weld Sequencer locates the part number in the database 
and loads the file associated with that part number. 

Weld Sequencer 
The Weld Sequencer runs the weld sequence file created by the Weld Engineer.  Each step can contain a 
variety of displays, weld procedures and/or audio files to guide the Weld Operator through complex 
welding operations, from simple tack welds to critical welds.  These helps ensure consistency when welding 
the same assembly over and over. 
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Figure 7.2 Weld Sequencer 

The right side of the Weld Sequencer displays the status of the sequence/steps and the details of the 

welding currently in progress.  When the Weld Operator starts the sequence, the Cycle Time  begins and 

the Cycle Status bar  begins to track the Weld Operator’s progress through the timeline of the sequence.  
The rest of the fields in this information panel reflect the weld currently in progress.  Table 7.1 explains 
each of these fields and the buttons in more detail. 

TIP | The Cycle Status  and Step Status  bars turn yellow 
when you reach 85% of the time estimated for completion of 
the cycle or step. 

Table 7.1 Fields Displayed on the Weld Sequencer 

Field Description 

Cycle Status 

 

The Cycle Status bar displays the Weld Operator’s progress in the current weld 
sequence.  Each step in a weld sequence has an estimated time for completion.  As 
the weld sequence progresses, each new step adds a new time target to the Cycle 
Status progress bar.  The middle point of the progress bar is always the next time 
target for the weld sequence and is the aggregated totals from each step’s estimate. 

For example, Ron at Advanced Manufacturing clicked Start for his weld sequence.  
Several things occurred at once: 

 The Step progress at the top of the panel showed Step 1 of 28. 

 The Cycle Time  began, which is a timer for the entire sequence. 

 The Cycle Status bar  began inching toward the first-time target for the 

weld sequence, which is 30 seconds in our example. 
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Field Description 

 The Step Status bar  began inching toward the time target for this step, 

which is 30 seconds in our example. 

As Ron begins welding for his first step, the Cycle Status bar is the same as the Step 
Status bar.  As he closes in on that tick mark in the middle, he completes the current 
step and advances to the next step.  Several things occur: 

 The Cycle Status bar  adds the next time target, adjusts the progress bar, 
and begins inching toward the new target for the sequence, which is 1:30 in 
our example. 

 The Step Status bar  resets and begins inching toward the time target 
for the new step, which is 1:00 in our example. 

TIP | A great rule of thumb is:  Progress displayed on the left of the tick mark on 
the progress bar is within the time estimate.  Progress displayed on the right side 
of the tick mark on the progress bar means the timing has exceeded the time 
estimate. 

Step Status 

 

The Step Status bar displays the Weld Operator’s progress in the current step of the 
weld sequence.  Each step in a weld sequence has an estimated time for completion 
and is represented by the target in the middle of the progress bar.  If the time spent 
on the step exceeds the estimated time, the progress bar passes the target and 
turns red. 

TIP | A great rule of thumb:  Progress displayed on the left of the tick mark is 
within the time estimate.  Progress displayed on the right side of the tick mark 
means the timing has exceeded the time estimate. 

Power Source 

 

The Power Source field displays the current status of the Welding Power Source. 

 Disabled :  This means that the power source is disabled, the Weld 
Operator cannot weld, and the torch trigger does not do anything when 
pulled. 

 Enabled :  This means that the power source is enabled and the Weld 
Operator can perform welds established in the welding function(s) of a 
sequence. 

Volts, Amps, WFS, 
and WeldScore® 

, , , 

 

Mainly for a Quality Manager walking by, these fields display a live update of the 
volts, amps, wire feed speed and WeldScore® occurring with the weld currently in 
progress.  Once the Weld Operator stops welding, the display resets to zero.   This is 
the same information displayed on the wire feeder. 

Cycle Time 

 

The Cycle Time field is the actual time for the weld sequence currently in progress 

and begins when the Weld Operator clicks the Start button .  It stops when 

the user reaches the end of the sequence, they click the Abort button , or if 
the weld sequence aborts for any reason.  The time disappears when the sequence 
stops. 
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Field Description 

TIP | If you need to keep the Cycle Time on the screen after the sequence ends, 
place a check mark next to the Display Summary checkbox on the End function 
(page 6.7). 

NOTE | If the user logs out of the sequence the Cycle Timer will not advance 
until a user logs back in. 

Arc Time 

 

This is the amount of arc time spent on the welds performed in the weld sequence 
so far.  This field resets to zero when the weld sequence ends. 

Weld Count 

 

This is the number of welds completed so far in the weld sequence, and the Wire 
Deposited field reflects the deposition for those welds.  This field resets to zero 
when the weld sequence ends. 

Wire Deposited 

 

The Wire Deposited field displays the amount of wire that has been deposited on 
the welds performed in the weld sequence so far.  This field resets to zero when the 
weld sequence ends. 

Login/Logout 

 /  

Click the Login button  to enter your user name and password.  The user 
name entered becomes the Operator ID associated with the welds performed 
during the weld sequence. 

Start/Abort 

 /  

The Start/Abort button controls the weld sequence.  Once the Weld Operator is 
ready to begin welding with the sequence, they click the Start button.  The Cycle 
Time for the sequence begins and doesn’t stop until the sequence ends. 

TIP | If you have the Auto Start preference enabled for this instance of the Weld 
Sequencer, the weld sequence begins automatically when you load the weld 
sequence file.  It can also start automatically if you have Auto Restart enabled. 

Previous/Next 

 /  

Click the Next button  to move the sequence forward to the following step in the 

weld sequence.  Use the Previous button  to reverse the sequence and go back 
to the preceding step. 

STOP | If you click Next  and skip a required function in the current step, 

Weld Sequencer turns the border of the weld sequence to red and flags the 
sequence with errors. 

NOTE | If you click the Manual button  to put the weld sequence into 
Manual mode, Weld Sequencer disables the Previous and Next buttons until you 

click Automatic . 

Manual/Automatic 

 /  

If the Weld Operator needs to release the lock on the Welding Power Source and 
free the machine from the sequence to make welds that are not defined in the weld 

sequence, they can click the Manual button .  This allows the Weld Operator 
to change the settings on the Welding Power Source if necessary.   Click Automatic 

 to pick up the sequence again and allow the weld sequence to control the 
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Field Description 

machine. 

NOTE | When the Weld Operator clicks the Manual button  and makes a 
weld, Weld Sequencer turns the border of the weld sequence to red and flags the 
sequence with errors. 

NOTE | A Global Property for each sequence file provides the ability to set a 
timeout value for Manual Mode.  Setting this timeout value (in seconds) limits the 
use of Manual Mode to this period of time when the sequence is running.  After 
the timeout expires, the Weld Sequencer will return to Automatic Mode. 

NOTE | A Preference for Manual Mode Timeout allows anyone with a User Role 
of Weld Sequencer Administrator or Engineer to change this value.  This timeout 
value is used when the Weld Sequencer is idle or during execution of all sequences 
that don’t have their own timeout value. 

NOTE | Any welds made during Manual mode still count toward your sequence 
totals, but they count as errors. 

Goto Step 
If your weld sequence unexpectedly aborted or you suffered any other type of “restart” on the sequence 
while you were working it, the Goto Step feature allows you to jump directly to (or near to) the step you 
were on when you’re back up and running. 

 

Figure 7.3 Goto Step 

Simply select File > Goto Step from the main menu in the Weld Sequencer Engine.  Enter the number of the 
step you want to execute and click Go. 

NOTE | When you use the Goto Step feature, Weld Sequencer flags 
the sequence as containing errors since the weld sequence 
was not performed intact from start to finish. 

Preferences 
Each computer that runs the Weld Sequencer has workstation preferences that a Weld Sequencer 
Administrator can set. They include the location of weld sequence files to the style and size of the text for 
the application.  You can also choose to have the weld sequence start or restart automatically for you. 

Table 7.2 explains each preference in more detail. 
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Figure 7.4 Weld Sequencer Preferences 

NOTE | If you have multiple instances of Weld Sequencer (see page 
2.14) on the same computer, each instance can have its own 
preferences. 

 

NOTE | Login is possible only with a database connection. 

Table 7.2 Preferences Available in Weld Sequencer 

Field Description 

Location of 
Configuration Files 

The Location of Configuration Files field displays the directory where the Weld 
Sequencer can find the files necessary to run the application, from program files to 
the default location for retrieving weld sequence files. 

Location of 
Sequence Files 

This is the location where the Weld Sequencer should look for weld sequence files, 
along with any accompanying files like images and sounds.  By default, the location 
is the C:\Weld Sequencer Files\Sequences folder. 

Location of 
Sequence Report 
Files 

This location is where Weld Sequencer finds the Sequence Reports generated by 
Welding Power Source on the production floor that use the weld sequences.  This is 
especially helpful if all reports are saved to a common location (e.g., a network 
drive). 

Stand-Alone 
Installation 

This option allows you to choose a default Stand-Alone Installation where the 
required database is installed on the same computer.  Refer to 
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Field Description 

Installing/Configuring Microsoft SQL Server on page 2.6 for more information on the 
installation options.  Uncheck this option and enter the Database Connection string 
(below) if you are using the Enterprise Configuration. 

NOTE | You must log in as an administrator user in order to modify this setting. 

Database 
Connection 

This is the Database Connection string for Enterprise Configurations.  See Appendix 
A for detailed Enterprise Configuration instructions.  You must restart the Weld 
Sequencer to utilize changes to the connection string. 

NOTE | You must log in as an administrator user in order to modify this setting. 

Default Font The Default Font field sets the style and size of the text for the main menu and the 
text on other pop-up windows.  This is especially useful when you need to increase 
the readability on a distant monitor. 

Function 
Information Font 

This field sets the style and size of the text on each of the steps in the display area of 
the weld sequences run on this computer.  This is especially useful when you need 
to increase the readability on a distant monitor. 

Status Panel Font The Status Panel Font field controls the style and size of the text for the panel on 
the right of the main display area of the Weld Sequencer (Figure 7.2 on page 7.4).  
This is especially useful when you need to increase the readability on a distant 
monitor. 

Automatically 
Request New Part 
Number 

If you want Weld Sequencer to automatically prompt users of this machine for a 
part number when they log in and after they complete a sequence, you can place a 
check mark next to this preference.  As soon as the user logs in and after they 
complete a sequence, Weld Sequencer displays the Part Lookup window (Figure 7.1 
on page 7.2). 

Automatically 
Request New Part 
Number from PLC 

If you want Weld Sequencer to automatically monitor for a specific tag from the 
connected PLC, place a check mark next to this preference.  This tag provides the 
part number to Weld Sequencer. 

Automatically Close 
Sequence File after 
Cycle Stop/Abort 

If you want the Weld Sequencer to automatically close the sequence file after the 
end of a weld sequence (so it is no longer available to start another weld sequence), 
place a check mark next to this preference.  The user (or PLC) will be required to 
load a new sequence file before starting another weld sequence. 

Automatic Start If you want Weld Sequencer to start running the weld sequence and start the Cycle 
Time automatically when you load the weld sequence file, place a check mark next 
to Automatic Start.  This preference is typically unchecked. 

Automatic Restart If you want Weld Sequencer to start the loaded weld sequence file again 
automatically once you complete it, place a check mark next to the Automatic 
Restart option. 

Automatic User 
Logout 

If Weld Sequencer has no activity for the amount of time entered (in minutes), the 
system automatically logs the user out. 
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Field Description 

System Units You can choose to display the units within the Weld Sequencer as Imperial or Metric 
units. 

Language Click on the dropdown arrow to select from the available languages.  You must 
restart the Weld Sequencer if a different language is selected. 

Manual Mode 
Timeout 

Anyone with a User Role of Weld Sequencer Administrator or Engineer can change 
this value.  This timeout value is used when the Weld Sequencer is not actively 
running a sequence file or when a sequence file is executing but it doesn’t have a 
timeout value of its own.  The timeout value limits the use of Manual Mode; after 
this amount of time, the Weld Sequencer will automatically exit Manual Mode. If a 
weld is in progress when the timeout occurs, Weld Sequencer will exit Manual 
Mode after the trigger is released. 

Locking a Welding Power Source 
You can now lock (or disable) a Welding Power Source when the Weld Sequencer is not connected.  This 
prevents operators from using the Welding Power Source unless the Weld Sequencer is running and 
communicating with the power source. 

NOTE | Only user accounts with the role of Administrator or Engineer 
can enable or disable this feature. 

To enable (or disable) the Welding Power Source unless connected to Weld Sequencer: 

Procedure Details 

1. On the computer connected to the 
Welding Power Source, open Weld 
Sequencer and log in. 

Remember:  Only user accounts with the role of 
Administrator or Engineer can enable or disable this 
feature. 

2. Connect to the Welding Power Source.  

3. Select File > Power Supply Auto Lockout 
Enable from the main menu. 

The system remembers this setting, and the Welding 
Power Source will only function if the Weld Sequencer 
software is communicating with the machine. 

To turn the feature off, select Power Supply Auto 
Lockout Disable from the menu. 

Weld Sequencer and PLCs 
If you have a weld sequence file that contains PLC Tag Read and PLC Tag Write functions, you need to 
physically connect the PLC and the Weld Sequencer computer on the production floor.  Then you need to 
establish the appropriate settings in Weld Sequencer and connect the software to the PLC.  Once 
connected, Weld Sequencer monitors the Ethernet/IP connection and the PLC controller mode 
continuously.  You can see the status of the connection in the status bar of the Weld Sequencer.  
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Figure 7.5 Status Bar Showing PLC Connection Status 

NOTE | You must be a user with the Administrator role associated 
with your account.  See page 3.2 for details on user roles. 

Connecting to the PLC 

After you connect the PLC to the Weld Sequencer computer, you need to establish the connection between 
the PLC and the Weld Sequencer software. 

 

Figure 7.6 PLC Settings 

To connect to the PLC: 

Procedure Details 

1. Select All Programs > Lincoln Electric > Weld 
Sequencer Toolkit > Weld Sequencer from the 
computer’s Windows menu. 

 

2. Click the Login button  and enter your 
administrator credentials. 

 

3. Select File > PLC Connect from the main menu. The PLC Settings window opens (Figure 7.6). 

4. Complete the fields for the PLC to which you 
want to connect. 

See Table 7.3 for in-depth details on each of these 
fields. 

5. Click the OK button.  

6. Click the Logout button.  

Disconnecting the PLC 

To disconnect the PLC from the Weld Sequencer, simply select File > PLC Disconnect from the main menu. 
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PLC Connection Properties 

For details on the actual data that you need to include in each of these fields, refer to the manufacturer’s 
documentation for your PLC and consult your IT department if necessary.  

Table 7.3 Fields on the PLC Settings Window 

Field Description 

Connection Type Select the appropriate type of PLC from the drop-down. 

IP Address This is the IP address assigned to the Ethernet bridge module in the PLC 
backplane. 

Backplane This is the port number in the Ethernet bridge module of the backplane 
connection.  It is almost always “1”. 

CPU Slot This is the slot number of the target PLC in the PLC backplane.  This is typically 
“0” (the leftmost slot). 

Connection Timeout This is the amount of time you want Weld Sequencer to wait (in milliseconds) 
before dropping the Ethernet/IP connection. 

Transaction Timeout This is the amount of time you want to pass (in milliseconds) before Weld 
Sequencer should consider a communication from a PLC Tag Read or PLC Tag 
Write to have failed due to a bad connection. 

Group Update Rate This is the polling rate you want Weld Sequencer to use when a PLC Tag Read 
function is waiting for the data in the Expected Value field (page 6.52) to be 
received from the PLC. 

New Part Number Tag 
Name 

This is the tag that you want Weld Sequencer to monitor from the PLC.  The tag 
from the PLC contains the part number used to automatically look up the weld 
sequence (page 4.8). 

Automatically Launch a Weld Sequence Based on a PLC Tag 

Weld Sequencer provides you with the ability to monitor a tag sent from the PLC that contains the part 
number.  When the system detects the tag name you enter in the PLC Settings window, it attempts to find a 
part number match in the database.  If the system finds a match with a valid part number, Weld Sequencer 
launches the associated weld sequence file, just like with a part lookup. 

TIP | If there is a check mark in the Automatic Start checkbox, the 
sequence automatically begins as soon as it launches. 

To establish this functionality: 

 Set up your PLC with a tag using a string value that sends the part number to Weld Sequencer. 

 Create the part in the part database (page 4.8). 

 On the workstation preferences, place a check mark in the Automatically Request New Part 
Number from PLC option (Figure 7.4 on page 7.8). 
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 In the New Part Number Tag Name field on the PLC Settings window (Figure 7.6 on page 7.11), 
add the PLC tag that you want to monitor for a part number.  This tag must be a string. 

When the Weld Operator (or other user) opens Weld Sequencer and saves the tag name in the PLC 
Settings, Weld Sequencer begins to monitor the PLC for tag changes, loads the next sequence accordingly, 
and clears the value in the tag (to prevent recycling of the same part number).  After the weld sequence 
completes, the Weld Sequencer will again start monitoring the PLC for tag changes and continue loading 
the next sequence to execute. 
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Appendix A 

Enterprise Configuration 

Microsoft SQL Server Installation Details 
For a situation where you already have SQL Server installed for an Enterprise Configuration, you may want 
to customize the installation to meet your unique requirements.  This section walks you through the various 
installation settings and SQL scripts that are necessary to create an Enterprise Configuration of the Weld 
Sequencer Database. 

STOP | Do not attempt an Enterprise Configuration unless you are 
experienced with Microsoft SQL Server or you can contact 
your IT department for assistance. 

 

STOP | This section of the manual refers only to Enterprise 
Configuration.  For a stand-alone installation, please see page 
2.1. 

 

TIP | If you need assistance with the Enterprise Configuration, 

please contact Lincoln Electronic Weld Sequencer support at 
softwaresupport@lincolnelectric.com. 

This section assumes you have familiarity with the following Microsoft SQL Utilities and bases any 
instructions on SQL Server 2019.  Use these instructions as a guide for any other version of SQL Server you 
may have installed. 

 SQL Server Installation Center 

 SQL Server Configuration Manager 

 SQL Server Management Studio 

All of these utilities were installed when you installed SQL Server.  

NOTE | This section does not cover the details of the initial installation 
of Microsoft SQL Server and presumes you are working with 
an existing default server instance and that you have 
experience with Microsoft SQL Server. 

With the default SQL Server installation, you only need to create a named SQL Server Instance for the Weld 
Sequencer and add the Weld Sequencer database to it.  You can perform both of these steps manually 
using the SQL Server tools (listed above) distributed with Microsoft SQL Server. 

Weld Sequencer Toolkit components used in this process: 

 SQL script to create Weld Sequencer database:  WeldSequencer_Install.sql 

 Connection String:  local.connectionString.config 

mailto:softwaresupport@lincolnelectric.com
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Creating a Named Instance 
You create a Weld Sequencer SQL Server instance like any other SQL Server named instance through the 
SQL Server Installation Center.  For an Enterprise Configuration, you create this instance manually on a 
database server. 

STOP | You can add the database to an existing instance if you prefer.  
Be sure you know the name of the instance and whether it 
supports Mixed Mode or Windows Authentication.  Skip to 
page A.5 for detailed instructions. 

To create a new instance: 

Procedure Details 

1. Launch the SQL Server Installation 
Center. 

 

2. In the SQL Server Installation Center 
window, click the Installation link 
on the left. 

 

3. On the right side, click the New SQL 
Server stand-alone installation or 
add features to an existing 
installation link. 

 

4. If prompted, insert the SQL Server 
2019 installation media or navigate 
to the setup file on your computer 
system. 

 

5. On the first Setup Support Rules 
screen, click OK. 

If necessary, address any issues that appear and begin again. 

6. If prompted with an Installation 
Type step, choose Perform a new 
installation of SQL Server 2019 and 
click Next. 
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Procedure Details 

7. On the Product Key screen, enter 
the product key if not defaulted 
and click Next. 

 

8. You must read & accept the license 
agreement and click Next. 

 

9. On the Product Updates screen, 
click Next. 

 

10. On the Install Setup Files screen, 
click Install. 

 

11. On the Install Rules screen, solve 
any issues displayed and click Next. 

 

12. On the second Setup Support Rules 
screen, click Next. 

 

13. On the Setup Roles screen, choose 
SQL Server Feature Installation. 

This is a recommendation.  Make the choice appropriate for 
your setup. 

14. On the Feature Selection screen, be 
sure to select Database Engine 
Services and Management Tools. 

 

Add any other features you require for your system. 

15. Click Next.  

16. On the Feature Rules screen, solve 
any issues and click Next. 

 



Appendix A. Enterprise Configuration Creating a Named Instance 

A.4 Weld Sequencer User Manual IM8003 

Procedure Details 

17. On the Instance Configuration 
screen, choose Named instance. 

 

18. Enter the standard LEWS100 in the 
Named instance and Instance ID 
fields. 

NOTE | If you choose not to use LEWS100 as the instance 
name, make note of the instance name you choose.  You will 
need this information later. 

19. Leave the Instance root directory 
field at its default value. 

Typically, this value is C:\Program Files\Microsoft SQL Server.  
Other pre-existing installed instances are allowed.  You can 
change the Instance root directory field without affecting Weld 
Sequencer operation. 

20. Click Next.  

21. On the Disk Space Requirements 
screen, click Next. 

 

22. On the Server Configuration screen, 
provide a specific Account Name, 
Password, and Startup type as 
required for your system. 

 

No settings specific to Weld Sequencer are necessary for any of 
the other settings on this screen. 

23. Click Next.  

24. On the Database Engine 
Configuration screen, choose either 
Windows authentication mode or 
Mixed Mode. 

 

25. If you chose Windows 
authentication mode, skip to step 
27.  If you chose Mixed Mode, 
continue with step 26. 

 

26. In the Enter password field, enter a 
strong password and confirm it 
with the next field. 

 



Adding the Database to the Instance Appendix A. Enterprise Configuration 

IM8003 Weld Sequencer User Manual A.5 

Procedure Details 

This is your system administrator (“sa”) password and must be 
a strong password.  Type one that contains both letters and 
numbers. 

27. In the Specify SQL Server 
Administrators section, click the 
Add button and add any 
administrators if necessary for your 
organization. 

 

28. Click Next.  

29. On the Error and Usage Report 
Reporting screen, leave the boxes 
unchecked and click Next. 

 

30. On the Installation Rules screen, 
address any errors and click Next. 

 

31. On the Ready to Install screen, click 
Install. 

 

32. When the installation finishes, click 
Next. 

 

33. On the Complete screen, click Close. Your instance name and passwords for future reference: 

Named Instance:  _________________________________ 

SA Password:  ____________________________________ 

  Windows Authentication Mode 

  Mixed Mode: 

SQL Server Authentication Login 
_______________________________________________ 

SQL Server Authentication Password 
_______________________________________________ 

34. Open the SQL Server Management 
Studio and verify the new SQL 
Server instance was created and 
that it is running. 

 

Adding the Database to the Instance 
Now that you have the Weld Sequencer instance created on the server machine, you need to add the Weld 
Sequencer database to that instance.   
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Procedure Details 

1. Using SQL Server Management Studio, 
connect to the server instance. 

 

2. In the SQL Server Management Studio 
window, select File > Open > File from the 
main menu. 

 

3. Navigate to C:\Program Files (x86)\ 
Lincoln Electric\Weld Sequencer Tool Kit\ 
Weld Sequencer Set-up Tools\ 
WeldSequencer_Install.sql. 

TIP | If you need to remove the Weld Sequencer 
database, you can use the WeldSequencer_ 
Uninstall.sql file (instructions provided in the file). 

4. Click Open. The SQL script file opens.  The block of comment text at 
the beginning of the file also provides instructions. 

 

5. Uncomment the four :Setvar lines of code. STOP | Do not modify any lines of code below the 
block of commented text. 

 

6. Select Query > SQLCMD Mode from the 
main menu. 

With the :Setvar statements uncommented, you must 
set the query to run in SQLCMD mode.  This will change 
the background color of the :Setvar lines. 

7. Leave the default paths for the two 
databases (:Setvar 
My_DefaultDataPathName and :Setvar 
My_DefaultLogPathName). 

NOTE | The installation uses the default C:\Weld 
Sequencer Files\Database\MSSQL\Data\ path as a 
convenient location for the WeldSequencer.mdf and 
WeldSequencer.ldf files, but this path is not referenced 
by the Weld Sequencer applications themselves.  If you 
need to create the databases in another folder, replace 
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Procedure Details 

C:\Weld Sequencer Files\Database\MSSQL\Data\ with 
the path you want to use. 

8. If you chose Mixed Mode for your 
Authentication Mode, enter the default 
LincolnWeldSequencer between the 
quotes for :Setvar My_UserId and 
WeldCap1t@l between the quotes for 
:Setvar My_Password  

 

For Mixed Mode, if you created a new user name and 
password for the database, enter those credentials. 

Leave the default text if using Windows authentication 
mode. 

9. Click Execute after making changes. The script creates the necessary files for you in the 
locations you specified. 

10. Review the Messages tab and verify the 
script executed correctly  

 

11. Right-click Databases in the folder tree 
and select Refresh from the pop-up 
menu. 

 

12. Verify the WeldSequencer database entry 
now exists. 

 

13. Verify the LincolnWeldSequencer user was 
created within that database. 

 



Appendix A. Enterprise Configuration Connecting Computers to the Database 

A.8 Weld Sequencer User Manual IM8003 

Procedure Details 

TIP | If the SQL server instance uses Windows 
authentication mode only, you can delete this user. 

14. Verify the LincolnWeldSequencer login 
was created (or the user name you 
created if different from the default). 

 

TIP | If the SQL Server instance uses Windows 
authentication mode only, you can delete this login. 

You have successfully added the database to the 
instance.  Now you need to configure each client 
computer so it can connect to the database. 

Connecting Computers to the Database 
Each client computer that needs to use the Enterprise Configuration must be set up to connect to the 
database.  To reference the SQL Server database, you need to modify the connection string application files 
on the client computers to reference the SQL Server instance and to specify a SQL Server Authentication 
login and password that the applications can use to access the database.  

A Weld Sequencer Administrator can edit the database connection method and connection string 
(separately for the Editor and the Engine) with the Preferences menu. 

STOP | This section of the manual refers only to Enterprise 
Configuration.  For a stand-alone installation, please see page 
2.1. 

 

NOTE | Only users with administrative privileges can make changes 
within the C:\Program Files directory.  Contact your IT 
department if you do not have administrator privileges. 

 

NOTE | If the database is not connected, anyone can change the 
connection method and strings settings in the Preferences 
menu (without login because login is not possible without a 
database connection). 

Weld Sequencer Toolkit installs two configuration files with the Weld Sequencer applications.  These 
configuration files identify the SQL Server that the applications should use and what access credentials they 
should use (i.e., user name and password) for the Weld Sequencer database. 

The two files have the same file name local.ConnectionStrings.config, and you can find them on each 
workstation in the following default folders: 
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On a 32-bit computer: 

 C:\Program Files\Lincoln Electric\Weld Sequencer Tool Kit\Weld Sequence Editor\ 

 C:\Program Files\Lincoln Electric\Weld Sequencer Tool Kit\Weld Sequencer 

On a 64-bit computer: 

 C:\Program Files (x86)\Lincoln Electric\Weld Sequencer Tool Kit\Weld Sequence Editor\ 

 C:\Program Files (x86)\Lincoln Electric\Weld Sequencer Tool Kit\Weld Sequencer 

NOTE | If you chose a different directory during installation, you can 
find the configuration files in that location.  See Figure 7.4. 

Modifying the Connection File 

To configure the files: 

Procedure Details 

1. Open a simple text-editing program 
(such as Notepad or Notepad++). 

 

2. In Notepad, select File > Open from the 
main menu. 

 

3. Select All files in the drop-down next to 
the File name field. 

 

4. Navigate to C:\Program Files\Lincoln 
Electric\Weld Sequencer Tool Kit\Weld 
Sequence Editor\ (or the appropriate 
path as discussed on page A.9). 

 

5. Select local.ConnectionStrings.config and 
click Open. 

The file also contains instructions in the comment text.  
Those comments contain the following text for Mixed 
Mode authentication: 

<add name="LincolnConnection" 

connectionString="Server=MySQLServer; Initial 

Catalog=WeldSequencer; User 

Id=LincolnWeldSequencer; Password=MyPassword;" 

providerName="System.Data.SqlClient"/> 

and the following for Windows Authentication mode: 

<add name="LincolnConnection" 

connectionString="Server=MySQLServer; Initial 

Catalog=WeldSequencer; 

Trusted_Connection=True;" 

providerName="System.Data.SqlClient"/> 

6. Copy the appropriate text and paste it 
between <connectionStrings> and 
</connectionStrings>. 

So, the text should look like this for Mixed Mode: 

<connectionStrings> 

<add name="LincolnConnection" 

connectionString="Server=MySQLServer; Initial 

Catalog=WeldSequencer; User 
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Procedure Details 
Id=LincolnWeldSequencer; Password=MyPassword;" 

providerName="System.Data.SqlClient"/> 

</connectionStrings> 

and like this for Windows Authentication Mode: 

<connectionStrings> 

<add name="LincolnConnection" 

connectionString="Server=MySQLServer; Initial 

Catalog=WeldSequencer; 

Trusted_Connection=True;" 

providerName="System.Data.SqlClient"/> 

</connectionStrings> 

7. Replace MySQLServer with the name of 
the SQL Server and, if necessary, the 
instance name. 

Examples: 

AdvMfg001\LEWS100 

ADVSQLV03 

TIP | Refer to page D.1 for some more information on 
this connection string. 

8. If you chose Mixed Mode authentication, 
continue with step 9.  If you chose 
Windows authentication mode, skip to 
step 11. 

 

9. Replace LincolnWeldSequencer with 
the user name for the SQL Server 
database. 

For example:  WeldSeqUser 

NOTE | A “Trusted Connection” SQL login user must 
have the “db_owner” SQL security rights. 

10. Replace MyPassword with the password 
for the SQL Server database. 

For example:  WeldCap1t@l 

11. Save the file. Aside from the block of comment text, the contents of our 
example would look like this for Mixed Mode: 

<connectionStrings> 

<add name="LincolnConnection" 

connectionString="Server= AdvMfg001\LEWS100; 

Initial Catalog=WeldSequencer; User Id= 

WeldSeqUser; Password= WeldCap1t@l;" 

providerName="System.Data.SqlClient"/> 

</connectionStrings> 

or like this for Windows authentication mode: 

<connectionStrings> 

<add name="LincolnConnection" 

connectionString="Server= AdvMfg001\LEWS100; 

Initial Catalog=WeldSequencer; 

Trusted_Connection=True;" 

providerName="System.Data.SqlClient"/> 

</connectionStrings> 
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Install the Connection File on Client Computers 

In the following steps, you copy your modified local.connectionString.config file and replace the existing file 
that is distributed with the Weld Sequencer Editor and Weld Sequencer applications. 

TIP | Alternatively, you can rename the original installed 
local.connectionString.config file to local.connection 
Strings_asInstalled.config instead of replacing the file.  
This would allow you to keep the original file for future 
reference. 

 

TIP | If you will add new computers to the system in the future, you 

could create a common configuration file for your Enterprise 
Configuration and possibly package it up (e.g., with 
InstallShield or a self-extracting ZIP file) to distribute to those 
new users in the future after installing the Weld Sequencer 
Toolkit. 

 

Procedure Details 

1. Copy the local.connectionString.config file 
that you edited. 

 

2. Paste and replace the file into C:\Program 
Files\Lincoln Electric\Weld Sequencer Tool 
Kit\Weld Sequence Editor (or the 
appropriate path as discussed on page A.9). 

 

3. Paste and replace the file into C:\Program 
Files\Lincoln Electric\Weld Sequencer Tool 
Kit\Weld Sequencer (or the appropriate 
path as discussed on page A.9). 

 

4. Test the database connections by launching 
the Weld Sequence Editor and Weld 
Sequencer applications. 

A green indicator next to the name of the database in 
the status bar (at the bottom) of each application 
indicates that the database connection was successful.  

 

5. Repeat steps 1 through 4 for each 
workstation or client computer. 

This includes all computers that will build weld 
sequence files and all computers that will run weld 
sequence files. 
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Appendix B 

Tips and Helpful Hints 

Two-Step Process for Creating a Weld Sequence 
Creating a weld sequence is quite simple with the Weld Sequence Editor.  If you break up your process into 
a couple of steps, you can avoid being overwhelmed by all the little details that go into creating a great 
sequence. 

 Step 1:  Get the basics down first. 
When you begin creating a sequence, your first step is to create most of the steps you will need 
and provide a basic connection between the functions.  This helps you make sure you have all 
the welds in place.  Run the weld sequence file in Weld Sequencer to make sure the order of 
your sequence is correct and the flow of your sequence is correct.  You want to make sure you 
have the correct pictures displaying when they are supposed to and the welding functions are in 
the correct order. 

 Step 2:  Refine the functions and incorporate your validations. 
Once you are confident you have all the functions in the correct order, you can begin refining 
and adding parameters and conditions to the sequence functions. 

- Run the weld sequence file, make any adjustments needed, and start collecting production 
data.  Use the Sequence Reports feature to create a file after welding with the weld sequence 
file.  You can analyze these reports manually, or you can use the Report Analysis tool (page 
5.28) to add parameters and weld validations automatically.  

- Use the production data to "finalize" the sequence:  enter estimated times for each function, 
add weld validations for each welding operation to improve the sequencer control and 
quality. 

- Ask the Weld Operator for feedback and ways to improve the weld sequence.  Possibly re-
order some of the steps to improve cycle time or to make it easier for the operator.  

TIP | You can use the Report Analysis Wizard to help you with Step 
2.  See page 5.28 for in-depth details. 

Create a Sequence File from Excel 
You can automatically create a new weld sequence file based on the contents of an Excel spreadsheet.  The 
new weld sequence is made from a Microsoft Excel spreadsheet with a predefined layout.  An example 
Excel file with this predefined layout is provided with the software installation; the file can be found in the 
Weld Sequencer Files folder. 

NOTE | Each row in the Excel file will be converted to a Weld 
Sequencer Step using the Weld Accumulator function. 
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Figure B.1 Example Microsoft Excel Spreadsheet 

 

Excel Rows Details 

1 Column B contains the size of the wire used for the weld sequence. 

2 These are the column headers to help explain the required information in the 
following rows.  Do not modify these column headers; use the example Excel 
file found in the Weld Sequencer Files folder. 

3, 4, 5, … Each additional row defines a Step to create with a Weld Accumulator 
function.  Do not include any additional data or additional rows of 
information beyond the Steps you expect to create in the new Weld 
Sequencer file. 

 

Column Details 

A weld_number This number is the step number of the weld in the weld sequence. 

B weld_procedureA This is the name of the first weld procedure associated with the weld.   This 
weld procedure will be loaded from the database; make sure you have the 
specified weld procedure saved in the database. 

C weld_procedureB This is the name of the second weld procedure associated with the weld.  This 
weld procedure will be loaded from the database; make sure you have the 
specified weld procedure saved in the database. 

D weld_profile The weld profile to use during welding. 

E current_lock Enter a “Y” for yes and “N” for no to control if a weld current validation is 
used for this step.  The minimum and maximum values can be zero if this 
option is not used. 

F current_min Enter the low current alarm limit for this step. 

G current_max Enter the high current alarm limit for this step. 

H voltage_lock Enter a “Y” for yes and “N” for no to control if a weld voltage validation is 
used for this step.  The minimum and maximum values can be zero if this 
option is not used. 

I voltage_min Enter the low voltage alarm limit for this step. 
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Column Details 

J voltage_max Enter the high voltage alarm limit for this step. 

K deposition_lock Enter a “Y” for yes and “N” for no to control if a weld deposition validation is 
used for this step.  The minimum and maximum values can be zero if this 
option is not used. 

L deposition_min Enter the low deposition alarm limit for this step. 

M deposition_max Enter the high deposition alarm limit for this step. 

N duration_lock Enter a “Y” for yes and “N” for no to control if a weld duration validation is 
used for this step.  The minimum and maximum values can be zero if this 
option is not used. 

O duration_min Enter the low duration alarm limit for this step. 

P duration_max Enter the high duration alarm limit for this step. 

Q image_file Enter the file name and extension for the image to display during this step. 

R    approval Enter a “Y” for yes and “N” for no to control if an Approval function is used for 
this step.   

  

Figure B.2 Example Weld Sequence Created from an Excel Spreadsheet 

To create a new weld sequence file based on the contents of an Excel spreadsheet: 

Procedure Details 

1. Open the Weld Sequence Editor If the Weld Sequence Editor is already open, save any open 
weld sequences. Opening the Excel file will overwrite the 
open file. 
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Procedure Details 

2. Search for and select the Excel file Set the file search filter on the browser to All Files or files 
with an .xlsx extension. 

3. Click OPEN on the Browser. The information from the Excel file is automatically converted 
to a sequence file and shown in the Editor workspace. 

4. Verify the weld sequence file. Follow the tips from the Two-Step Process for Creating a 
Weld Sequence. 

5. Save the weld sequence file.  

Using PowerPoint to Create Images 
You’ve taken great pictures of the welds you want to display in Weld Sequencer.  You want to add text to 
the photos and circle different parts of the pictures for different parts of the sequence, but you do not have 
an image-editing software.  Good news.  You can use Microsoft® PowerPoint to create images. 

 

Figure B.3 Example Image While in PowerPoint 

Simply make slides with your pictures and add some bullets.  You can highlight where the operator should 
make the welds.  The possibilities are endless.  Once you finish, you can save the presentation as image files 
and load them into the Display Picture function. 

To create an image using Microsoft® PowerPoint: 

Procedure Details 

1. Open Microsoft® PowerPoint.  

2. Create one slide for each Display Picture 
function you want the Weld Operator to 
see. 

Refer to Figure B.3. 

TIP | Save your PowerPoint presentation as you 
normally would.  This allows you to make changes 
easily in the future. 

3. To save as an image, select File > Save As  
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Procedure Details 

from the main menu in PowerPoint. 

4. Navigate to the location where you want 
to save the images for this sequence. 

TIP | To make it easy on yourself, save the image files 
in the weld sequence file’s location so you do not have 
to move them later. 

5. From the Save as type field, select the 
image file format you prefer (e.g., JPG or 
PNG) and click Save. 

 

6. If you have multiple slides, PowerPoint 
will ask you if you want to export all of 
them or just the current slide.  Click the 
appropriate button. 

 

Microsoft® PowerPoint saves each slide as an individual 
image, and you can now add them to your Display 
Picture functions. 

Keyboard Shortcuts 
Weld Sequencer includes keyboard shortcuts to help you quickly perform certain tasks.  You can access the 
File menu using the Alt F key combination.  You can then press the following key on the keyboard to access 
the indicated menu item: 

 s for Load Sequence 

 n for Part Number Lookup 

 t for Consumable Lot 

 g for Goto Step 

 c for Power Supply Connect 

 L for PLC Connect 

 p for Preferences 

 x for Exit 
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Loading a Weld Sequence File by Command Line 
To load a specific weld sequence file automatically when the Weld Operator launches the application, you 
can add the following text to the command line of the application shortcut.  You need to know the location 
and file name for the weld sequence file.  You can add either of the following commands to the shortcut: 

 -l [filename] 

 -load [filename] 

TIP | If Automatic Start is enabled under File > Preferences, the 
sequence will also start automatically. 

 

Figure B.4 Loading a Sequence by Command Line 

To load a weld sequence file by command line: 

Procedure Details 

1. Right-click the Weld Sequencer shortcut and 
select Properties from the pop-up menu. 

The Properties window opens (Figure B.4). 

2. Click on the Target field and place your cursor 
at the end of the existing text in the field. 

 

3. Type a space after the existing text.  

4. Type either -l or -load, followed by the 
filename you want to load automatically. 

For example: 

 

TIP | If your filename contains spaces, be sure to 
enclose the filename with quotes.  For example, 
you would type Frame Weld Sequence.wsf as 
“Frame Weld Sequence.wsf”. 

5. Click OK to save your changes.  
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Ignoring Short Welds in a Weld Sequence 
There may be times when you want to allow the Weld Operator to create short welds during a welding 
operation, but you do not want to define functions in the weld sequence for them.  These are short welds 
that you do not need to have recorded and tracked with the CheckPoint™ software nor do you need to 
specify detailed welding information for the operator in the sequence.  You also do not want these welds to 
produce an alert or error in the sequence. 

If you are not already using a specific Weld Profile for the welding function, you can use the Weld Profile 
feature to ignore these short welds without recognizing them and without creating individual functions for 
them. 

NOTE | This is a special configuration and requires the use of the Weld 
Profile in Power Wave® Manager. 

 

NOTE | Not all short welds need to be ignored.  If you have short 
welds that need to be validated, simply create a function for 
the welds and do not use this special Weld Profile. 

To create a special Weld Profile to ignore short welds: 

Procedure Details 

1. Decide on the maximum length of 
arc time that defines the short 
weld. 

For example, you could say a short weld is less than two 
seconds of arc time, and you want to ignore all small welds like 
this. 

You need to configure a Weld Profile to ignore these short 
welds. 

Configure Special Weld Profile 

2. Launch the Power Wave® Manager 
software. 

 

3. Connect to the Welding Power 
Source. 

 

4. Select Production Monitoring > 
Configuration from the navigation 
tree. 
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Procedure Details 

5. Click the Profile Limits tab. 

 

6. Click the Weld Profile you want to 
configure. 

STOP | Profile 1 is the default profile for all welding 

functions in the Weld Sequencer.  You need to pick a different 
Weld Profile for this special configuration. 

NOTE | You will need to configure each Welding Power 
Source that will run the weld sequence file.  Power Wave® 
Manager saves the configuration to the power source.  The 
Backup and Restore feature in Power Wave® Manager can 
help you easily copy this configuration to a different Welding 
Power Source.  See the Power Wave® Manager User Manual 
(IM8002) for details. 

7. Adjust the Start delay and the End 
delay fields to equal the maximum 
length of arc time you determined 
in step 1. 

In our example: 

Start Delay =  1 

End Delay =  1 

Total  2 

8. Place a check mark next to the 
Discard welds shorter than X sec 
option. 

Where x should match your maximum length of arc time. 

9. Click Apply Settings. In our example, when you use Weld Profile 2, the Welding 
Power Source ignores any welds less than two seconds. 

10. Repeat steps 3 through 9 for each 
Welding Power Source that will use 
the weld sequence file. 

You can use the Backup and Restore feature in Power Wave® 
Manager to simply copy your configuration if you have 
multiple machines to set up.  See the Power Wave® Manager 
User Manual (IM8002) for details. 

Now you need to configure the welding function in the Weld 
Sequence Editor to use your new Weld Profile. 

Configure Welding Function 

11. Launch Weld Sequence Editor.  

12. Open your weld sequence file.  



Ignoring Short Welds in a Weld Sequence Appendix B. Tips and Helpful Hints 

IM8003 Weld Sequencer User Manual B.9 

Procedure Details 

13. Double-click on the welding 
function(s) where the short welds 
normally occur. 

 

14. Enter the profile number in the 
Weld Profile field. 

 

15. Click OK. Since you configured the Weld Profile to discard any welds 
shorter than the time you specified, the Welding Power Source 
does not create a weld record for these short welds.  
Therefore, there is no data to send to Weld Sequencer and no 
welds to recognize. 
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Appendix C 

Troubleshooting 

Sometimes, when working with a software program or installing software, you need a little extra 
information to help troubleshoot and solve the problem.  There are some common minor issues you might 
be able to fix without a call to support. 

NOTE | If you continue to have trouble, please contact your local IT 
department or Lincoln Electric Weld Sequencer support:  
softwaresupport@lincolnelectric.com. 

Cannot Connect to a Power Source 
There are multiple reasons you may not be able to access the connection window, connect to the IP 
address of a power source or why the IP address may not show up in the list of addresses.  Here are some 
possibilities. 

User Has Incorrect User Role 

Only users with the Administrator role associated with their account can change the Welding Power Source 
connected to an instance of the Weld Sequencer software.  See page 3.1 for details on user accounts. 

IP Address or Other Ethernet Settings on the Welding Power Source Are Invalid 

To correct this issue, you need to connect directly to the Welding Power Source through a temporary 
connection and change the permanent Ethernet settings. 

Procedure Details 

1. Contact your local IT department for the 
correct Ethernet settings for the Welding 
Power Source. 

 

2. Temporarily disconnect the Welding Power 
Source from the network. 

 

3. Plug an Ethernet cable into the computer 
running Power Wave® Manager. 

 

4. Plug the other end of the Ethernet cable into 
the Welding Power Source. 

Microsoft Windows assigns a temporary IP address 
to the computer and the Welding Power Source so 
they can communicate. 

5. Launch Power Wave® Manager.  

6. On the Connect tab, choose I do not know the 
IP address of the welder. 

 

7. Click the Refresh List button. Only one IP address should appear. 

mailto:softwaresupport@lincolnelectric.com
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Procedure Details 

8. Select the welder and click Connect. When you select the power source, the green status 
light on the machine should begin to blink. 

The system automatically takes you to the System 
status section in Power Wave® Manager. 

9. Click Ethernet in the navigation tree.  

10. Edit the Ethernet settings to those provided 
by your IT department. 

Refer to the Power Wave® Manager User Manual 
(IM8002) for more details on Ethernet settings. 

11. Click Apply Settings. The Welding Power Source resets and accepts its new 
network settings. 

12. Unplug the Ethernet cable from the Welding 
Power Source. 

 

13. Reconnect the Welding Power Source to the 
plant network again. 

The new settings should take effect. 

Ethernet Settings Seem Valid but Still Cannot Connect 

If you have checked the Ethernet settings, and they are valid, use the following information to verify 
communications and physical connections: 

 Check the physical network connections to the computer and the power source.  Check for a 
solid green or yellow light near each Ethernet jack.  If you see a light, the physical connections 
are probably not the issue. 

 Cycle the power to the Welding Power Source (off then back on).  The power source could still 
have a residual network connection in its memory under some circumstances.  

If you continue to have trouble connecting, verify the following: 

 Do you have multiple Ethernet adapters enabled?  This could cause issues.  Verify that the 
Ethernet communications are going through a single adapter.  To do this, temporarily disable 
any additional adapters. 

 If you are using an Ethernet cable connection, try to temporarily disable any wireless 
communication on the computer.  This could help the computer to directly connect to the 
Welding Power Source through the cable without interference. 

 If the computer is running some type of security software or firewall, this may block the IP 
address of the Welding Power Source.  Check with your local IT department. 
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Weld Sequencer Cannot Create a Database 
If you receive a message that Weld Sequencer cannot create a database, the culprit could be that the 
directories involved in the installation are compressed.  If this happens, the folder names appear blue in the 
file explorer (Figure C.1).  If they are compressed, you just need to fix it and try the installation again.  

 

Figure C.1 Compressed Files/Folders 

To decompress a file or a folder: 

Procedure Details 

1. Right-click the file or folder and select 
Properties from the pop-up menu. 

 

2. On the General tab, click the 
Advanced button. 
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Procedure Details 

3. Remove the check mark from the 
Compress contents to save disk space 
checkbox. 

 

4. Click OK. This decompresses the file or folder.  Try your installation 
again. 
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Appendix D 

Frequently Asked Questions 

The Frequently Asked Questions list is a compilation of questions posed by users of the software and the 
answers generally provided.  Over time, the list will continue to grow and provide useful information 
requested often by our users. 

Installation 

How big will the Weld Sequencer database get? 

There is minimal growth once you install and create the Weld Sequencer database.  Weld Sequencer saves 
only a small amount of data to the database.  The initial size of the database is approximately 334 MB.  
Enabling Weld Record Logging in a weld sequence file increases the size of the database.  Each weld record 
is approximately 1600 bytes. 

Do I have to name the Microsoft SQL Server instance “LEWS100”? 

No.  You can name the Microsoft SQL Server instance whatever you need to name it.  We provide 
“LEWS100” in these instructions and elsewhere as a suggestion for those who need a basic installation, as 
well as for illustration purposes.  Just be sure to record and keep track of the name you use if it is different.  

Enterprise Configuration 

Can I use an existing named instance? 

Yes.  If you have an existing Microsoft SQL Server installation with an existing instance you would like to 
use, you can simply add the Weld Sequencer database to that instance.  Appendix A provides Enterprise 
Configuration information.  Please refer to page A.5 for more detailed information on adding to an 
existing instance. 

Do I need to include the instance name in the connection string? 

Whether or not to include the instance name in the connection string depends on your needs and how the 
server is set up to resolve the connection.  The format of the ConnectionString property in the 
local.ConnectionStrings.config files follows the standard format for SQL Server connection strings and the 
standard rules for parsing connection strings.  If you have unique needs, you have the flexibility to use 
advanced connection string syntax if you choose.  The Weld Sequence Editor and Weld Sequencer 
applications simply use the unmodified string when making the connection.  

Why won’t the computer connect to my network resources? 

If you have a connection issue but the connection string files have been edited correctly, try using the fully 
qualified domain names when referencing the network resource.  In our example in step 7 on page A.10, 
John at Advanced Manufacturing would change ADVSQLV03 to ADVSQLV03.us.corp.am in the 
connection string file to fully resolve the name for his network.  This made it easier for Weld Sequencer to 
find the resource.  How you resolve the name depends on the domain set up on your company’s network. 
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READ AND UNDERSTAND THE MANUFACTURER’S INSTRUCTION FOR THIS EQUIPMENT AND THE CONSUMABLES TO BE
USED AND FOLLOW YOUR EMPLOYER’S SAFETY PRACTICES.

SE RECOMIENDA LEER Y ENTENDER LAS INSTRUCCIONES DEL FABRICANTE PARA EL USO DE ESTE EQUIPO Y LOS
CONSUMIBLES QUE VA A UTILIZAR, SIGA LAS MEDIDAS DE SEGURIDAD DE SU SUPERVISOR.

LISEZ ET COMPRENEZ LES INSTRUCTIONS DU FABRICANT EN CE QUI REGARDE CET EQUIPMENT ET LES PRODUITS A
ETRE EMPLOYES ET SUIVEZ LES PROCEDURES DE SECURITE DE VOTRE EMPLOYEUR.

LESEN SIE UND BEFOLGEN SIE DIE BETRIEBSANLEITUNG DER ANLAGE UND DEN ELEKTRODENEINSATZ DES HER-
STELLERS. DIE UNFALLVERHÜTUNGSVORSCHRIFTEN DES ARBEITGEBERS SIND EBENFALLS ZU BEACHTEN.

l  Do not touch electrically live parts or
electrode with skin or wet clothing.

l  Insulate yourself from work and
ground.

l  No toque las partes o los electrodos
bajo carga con la piel o ropa moja-
da.

l  Aislese del trabajo y de la tierra.

l  Ne laissez ni la peau ni des vête-
ments mouillés entrer en contact
avec des pièces sous tension.

l  Isolez-vous du travail et de la terre.

l  Berühren Sie keine stromführenden
Teile oder Elektroden mit Ihrem
Körper oder feuchter Kleidung!

l  Isolieren Sie sich von den
Elektroden und dem Erdboden!

l  Não toque partes elétricas e elec-
trodos com a pele ou roupa molha-
da.

l  Isole-se da peça e terra.

l  Keep flammable materials away.

l  Mantenga el material combustible
fuera del área de trabajo.

l  Gardez à l’écart de tout matériel
inflammable.

l  Entfernen Sie brennbarres Material!

l  Mantenha inflamáveis bem guarda-
dos.

l  Wear eye, ear and body protection.

l  Protéjase los ojos, los oídos y el
cuerpo.

l  Protégez vos yeux, vos oreilles et
votre corps.

l  Tragen Sie Augen-, Ohren- und Kör-
perschutz!

l  Use proteção para a vista, ouvido e
corpo.
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LEIA E COMPREENDA AS INSTRUÇÕES DO FABRICANTE PARA ESTE EQUIPAMENTO E AS PARTES DE USO, E SIGA AS
PRÁTICAS DE SEGURANÇA DO EMPREGADOR.

l  Keep your head out of fumes.
l  Use ventilation or exhaust to

remove fumes from breathing zone.

l  Los humos fuera de la zona de res-
piración.

l  Mantenga la cabeza fuera de los
humos. Utilice ventilación o
aspiración para gases.

l  Gardez la tête à l’écart des fumées.
l  Utilisez un ventilateur ou un aspira-

teur pour ôter les fumées des zones
de travail.

l  Vermeiden Sie das Einatmen von
Schweibrauch!

l  Sorgen Sie für gute Be- und
Entlüftung des Arbeitsplatzes!

l  Mantenha seu rosto da fumaça.
l  Use ventilação e exhaustão para

remover fumo da zona respiratória.

l  Turn power off before servicing.

l  Desconectar el cable de ali-
mentación de poder de la máquina
antes de iniciar cualquier servicio.

l  Débranchez le courant avant l’entre-
tien.

l  Strom vor Wartungsarbeiten
abschalten! (Netzstrom völlig öff-
nen; Maschine anhalten!)

l  Não opere com as tampas removidas.
l  Desligue a corrente antes de fazer

serviço.
l  Não toque as partes elétricas nuas.

l  Do not operate with panel open or
guards off.

l  No operar con panel abierto o
guardas quitadas.

l  N’opérez pas avec les panneaux
ouverts ou avec les dispositifs de
protection enlevés.

l  Anlage nie ohne Schutzgehäuse
oder Innenschutzverkleidung in
Betrieb setzen!

l  Mantenha-se afastado das partes
moventes.

l  Não opere com os paineis abertos
ou guardas removidas.



CUSTOMER ASSISTANCE POLICY

The business of Lincoln Electric is manufacturing and selling
high quality welding equipment, automated welding systems,
consumables, and cutting equipment. Our challenge is to meet
the needs of our customers, who are experts in their �elds, and to
exceed their expectations. On occasion, purchasers may ask
Lincoln Electric for information or technical information about their
use of our products. Our employees respond to inquiries to the
best of their ability based on information and speci�cations
provided to them by the customers and the knowledge they may
have concerning the application. Our employees, however, are not
in a position to verify the information provided or to evaluate the
engineering requirements for the particular weldment, or to
provide engineering advice in relation to a speci�c situation or
application. Accordingly, Lincoln Electric does not warrant or
guarantee or assume any liability with respect to such information
or communications. Moreover, the provision of such information or
technical information does not create, expand, or alter any
warranty on our products. Any express or implied warranty that
might arise from the information or technical information,
including any implied warranty of merchantability or any warranty
of �tness for any customers’ particular purpose or any other
equivalent or similar warranty is speci�cally disclaimed.

Lincoln Electric is a responsive manufacturer, but the de�nition of
speci�cations, and the selection and use of speci�c products sold
by Lincoln Electric is solely within the control of, and remains the
sole responsibility of the customer. Many variables beyond the
control of Lincoln Electric affect the results obtained in applying
these types of fabrication methods and service requirements.

WELD FUME CONTROL EQUIPMENT

The operation of welding fume control equipment is affected by
various factors including proper use and positioning of the
equipment, maintenance of the equipment and the specific
welding procedure and application involved. Worker exposure
level should be checked upon installation and periodically
thereafter to be certain it is within applicable OSHA PEL and ACGIH
TLV limits.
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